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Welcome to XSLfast 5.0

In order to grant customers complete, easy, and simple access to their products and eventually
seize the chance to make use of the publicity potential of a beautifully designed document
including images, most suppliers and vendors present their range of products in the form of a
printed document. Or think of the vast number of forms that you encounter every day, and the
speed in which these are modified and adapted to the changed requirements. Even in the age
of electronic commerce, printed documents still have their place. But how do you bring
voluminous digital product data into the shape of a printed document without external help?
XSLfast helps you to combine layout and content easily and quickly, to produce PDF or print

documents as a result.

XSLfast

XSLfast is a style sheet creator/editor, which helps you to create style sheets or layouts
without the knowledge of any programming language. Basically, XSLfast combines the XML data

with the layouts and produces a professionally look document.

XSLfast assigns content of an XML file to placeholders on the sheet and uses formatting styles
to give the document a professional look. It creates a single page layout, brings content and

form together and generates a multipage document.

It follows the principle of “Write Once - Use Many”. XSLfast enables to render the same

content in different media or format, by using different layouts.
The usability and the result of XSLfast are divided into two phases:
1. Creating the Layout (Generating Style Sheet).

2. Applying the layout to the actual data and produce a professional look document.
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Benefits of XSLfast

XSLfast has a tremendous time-saving technology and correspondingly has high savings

potentials. Following are the benefits of XSLfast:

Design templates for database publishing or print-on-demand.

o Create forms, catalogs, product sheets, invoices, price lists...

e Page oriented layout for XML documents.

¢ No programming skills necessary.

e Easy to use, What you see is What you get (WYSIWYG), drag and drop.

e XPath and XSL support for advanced users.

¢ Create layout templates in minutes instead of hours.

e XML documents neutral of formatting.

e Neutral XML documents used with different layouts to produce documents for different

media.
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Technologies Used in XSLfast

XSLfast uses the following technologies to generate style sheet and convert the XML data to a

desired output format:

Extensible Style sheet Language (XSL)

e Extensible Style sheet Language Transformation (XSLT)

e Extensible Style sheet Language Formatting Object (XSL-FO)
e Rendering

e XPath

XSL

The Extensible Style sheet Language (XSL) is a W3C standard programming language. It
describes how to process input XML file and convert it into specific documents like XSL-FO or

HTML. XSLfast generates XSL file (stylesheet), while creating layout.

XSLT

The Extensible Style sheet Language Transformation (XSLT) is a W3C standard programming
language. XSLfast generates XSL file, while creating layout and applies to XML document. This

application of XSL to XML document using XSLfast is known as XSL transformation or XSLT
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XSL-FO

The Extensible Style sheet Language Formatting Object (XSL-FO) is a W3C standard
programming language used for printable documents. It describes the arrangement of text,
images, and other elements on a page, in turn; it describes the flow of the document. XSL-FO
is created as an alternative to proprietary Portable Document File (PDF) and Post Script (PS)
files. It is the actual output of XSLfast, later it is converted to PDF or other formats, using

render engines.

Rendering

The process of converting the XSL-FO file to other formats like PDF, HTML, and so on using
render engines is known as Rendering. Render engines are the conversion tools, which converts

XSL-FO to PDF and other formats. XSLfast supports the following render engines:

e FOP (xml.apache.org) - XSLfast has both old version 0.20.5 and new version 0.95. There
are open source projects so it has this version naming. XSLfast ships the FOP along with

the application.
e XEP - RenderX commercial product should be installed separately.

o XSLFormatter - AntennaHouse commercial product should be installed separately.

XPath

XPath is an expression standard, which describes how to operate with XML contents. For

example, /Report/Productgroup/Product describes the nodes of an XML file.
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XSLfast Installation

XSLfast can be installed as a Windows version or as a platform independent Java version. To
start XSLfast on the different platforms (Windows, UNIX, LINUX, and so on) different starting
files need to be executed:

Windows : xslfast.exe

Unix/Linux : xslfast.sh

MacOS X : XSLfast

Other : The startup script like file xslfast.sh is required.
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Style Creation

— Printing

The functionality of XSLfast is divided into two phases:

e Design Phase - Style Creation

e Run Phase - Printing
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Design Phase

The process of creating style sheet happens in Design phase. The content/data is loaded into
XSLfast in XML, XSD, or DTD formats. Create layout(s) for the loaded data. XSLfast starts
creating XSL file, while creating layout. XSLfast helps you to create styles, describes how to

print the document, but does not produce any output directly.

Once you create layout, apply it to the loaded data and see how the formatting goes on. You

can see the formatting of the document using XSLfast’s preview option or use tools like XSLfast

Print Server.
Document Structure | > XSifast ‘ XSL for further
(XML, XSD, DTD) appliance
J
Run Phase

The process of combining XML and XSL and generating PDF from XSL-FO file happens in Run
phase. The styles created are applied on the XML data through XSLT and generates XSL-FO file.
The XSL-FO document can be used directly or converted to other formats like PDF, HTML, and

so on, using render engines.

XHL +XSL | IR XSLT like 5 XSL-FO Document
Saxon
J
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Intended Audience

XSLfast is used in different sectors like banks, insurance companies, service and manufacturing

industries to produce documents like:
¢ Quotation Forms
e lllustrated Price List
e Technical Documentation
e Client-Specific price list
e Product Manuals
e Delivery Notes and

e Invoices
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XSLfast Interface

The XSLfast interface is the area to create layout. It is a place holder of different elements like

text, image, table, and so on.
The XSLfast interface is divided into the following options:
¢ Menu Bar
e ToolBar
e Worksheet
e XML Window
e Inspector Window
¢ Element List Box

e Status Bar
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Menu Bar

Here, the menus of the elements and all other menus, with their submenus can be found. The
menus change or expand depending on the currently selected element on the sheet, and are

described later with their corresponding element.

The standard menu bar of XSLfast is show below:

‘File Edit View Insert Arrange  Page Run  Tools ‘Window Help I

Note: A new menu is added in the menu bar when you select an element on the worksheet or
select an element from the Element Listbox. Depending on the element selected, the menu
varies. For example, if you select Text element on the worksheet the Text menu is added in

the menu list, as show below:
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File Edit ¥iew Insert Arrange Page‘TextlLayout Team Extras Window Help

Added Menu

The menus Text, Barcode, Image, Internet link, Date/Time, Square, Page number, Index,
Citation, Table, Pivot table, List, Chart, Choose, Line, and Call Template are added to the

menu list, depending on the element selected.
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File Menu

The File menu consists of options to create, open, save, and close layouts. Also, contain
options to load data to XSLfast and export templates. The File menu options are show in the

below figure:

T:Filel Edit Wiew Insert Arrange Page Run

|
} [ Mew Ctrl-N
[ Open... Ctrl-0
Save... Ctrl-S
Save as... Ctrli+Shift-S

Save as template. ..
Save all
€3 Close Ctrl-F4
Close all
Load structure from XML/DTD file Ctil-&

Load structure from CSV file...

B Import ¥SL templates...

&5 Export...

Recently used files 13

Exit
Option Functionality
New Opens/Creates new layout.
Open Opens existing layout.
Save Saves already saved layout.
Save as Saves the unsaved layout.
Save all Saves all the opened layouts.
Close Closes the current layout.
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Option

Functionality

Close all

Closes all the open layouts.

Load structure from XML/DTD file

Loads XML/DTD structure into XSLfast.

Load structure from CSV file

Loads CSV structure into XSLfast.

Import XSL templates

Imports XSL template into the layout.

Export

Exports file as .xsl, .pdf, .java, .fo, and .html files.

Recently used files

Lists all the files that were recently used.

Exit

Exits from XSLfast.

Edit Menu

The Edit menu consists of basic editing options like copy, paste, undo, and so on. The Edit

menu options are shown in the below figure:

Edit |
™ Undo: Cti-Z !
¥ cut Cirl-X

B copy Ctrl-C
B Paste R
8 oelete Delete

Select all  Ctd-A

Oy Find...  ctiF
Replace...
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Symbol Options Functionality

[ o Undo Undo last step.

) 4 Cut Cut selected items out.

Copy Copy selected items to buffer.

I% Paste Paste buffer content.

% Delete Delete selected items.
Select all Select all items on the sheet.

O‘ Find Find strings on your sheet and template.
Replace Replace strings in the layout and template.
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View Menu

The View menu consists of different view options. Refer Customizing Interface section for more

details.

The View menu options are shown in the below figure:

'Viewl Insert Arrange Page Run  Tools  Wir

Grid preferences
Look and feel

Q Zoom in

% Zoom ouk
\% Reset zoom

Filter by type

Show XML in alphabetical order
Highlight to tree selection

4
»

Ctrl-NumPad +
Ctrl-NumPad -
Ctrl-NumPad *

Symbol Options

Sub-Options

Functionality

Grid preferences

Show grid Shows grid on worksheet.
Snap grid Aligns elements to grid points.

. Determines the distance between the
Grid Size

grids.

Grid point of origin

Change the start position of grids.

Look and Feel

PlasticXPLookAndFeel

Metal

Windows

Windows Classic

Pago

Liquid

Offers different interface styles.
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Symbol Options Sub-Options Functionality

Substance
Show XML in Sorts the nodes and their contents
. alphabetically without changing the
alphabetical order structure.
Highlight to tree Illuminates element from XML tree
section structure.
Zoom in Zooms in the layout.
Zoom out Zooms out the layout.
Reset zoom Resets the layout to its default size.

Hides and Displays certain level of

Levels elements.

Displays and hides similar element

Filter by type types

28|Page



Insert Menu

The Insert menu consists of options to insert different elements on the worksheet. Refer

Elements chapter for more details.

The Insert menu options are shown in the below figure:

- B cTable_t
Property | Yalue
~ Objectname cTable_1
Locked |
4 Table
4 Grouping Product
4 Use alternatec...
Alternate c..,
Sort
Use custorm rep.., [
Background image
Backaround color
Omit header page b..: []
Omit footer page br.., []
Logitai style '| Mormal w |
Row properties Hormal
4 Column properties %ummary lene
Auta-width |
Column width 67 pt
If
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_Iﬁgé—ri-‘l Arrange  Page Run To

Aa Text

12 Numeric field

xsL ¥5L Code Alt+Shift-T

Barcode

1= List

el Chart

[&] 1mage Ctrl-1

() Internet ik Ct+ShiftL

| L) DatefTime  Ctd+Shift-D

Square

@ Pagination  Ctri+Shift-P
| [ Index

Citation

i1 Choose

Call template

/ Lline Ctrl-L

EH Table Chil+Alt+Shift- T

B8 Pivot table

Symbol Options Functionality

Aa Text Inserts text element to enter text.

1= Numeric Field Inserts numeric field element to enter numbers.
XSL XSL Code Inserts XSL Code element to enter XSL code.
Barcode Inserts Barcode element to generate barcode.
= List Inserts List element to generate list.

ol Chart Inserts Chart element to generate chart.

= Image Inserts Image element to insert an image.
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Options

Functionality

Internet Link

Inserts Internet Link element to enter web address.

"y
A

& Date/Time Inserts Date/Time element to enter the date and time.

Square Inserts Square element to decorate worksheet.

@ Pagination Inserts Pagination element to insert page number.

D Index Inserts Index element to generate index.

Citation Inserts Citation element to generate citation.

if Choose Insert Choose element to select single value of an XML node.

E] Call Template Inserts Call Template element to call internal or external template.
ey Line Inserts Line element to insert different styles of line.

= Table Inserts Table element to insert different tables.

B Pivot Table Inserts Pivot Table element to insert a pivot table.
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Arrange Menu

The menu Arrange offers you the command to align the frames on the sheet. Refer

Arrangement of Elements chapter for more details. The Arrange menu options are shown in the

below figure:

Note: Unlike, other options under Arrange menu, the options Forward, Backward, and Move
out from page is enabled when you select a single frame. But, other options are only enabled

only, if you select more than one frame.

i.nfi.rrangtﬂ Page Run Tools

®, Bring forward

& Send backward

i Add horizontal guide
| add vertical quide

! 3¢ Clear guides

F1 align Left

I align center horizontal
I'® align right

B align top

I8l align center vertical
i align bottom

&l same width

18l Same height

¥" Same space horizontal
*8 Same space vertical
@@ Tile objects

£ Mirror vertically

& Mirror harizontally

®h Move out from page

@ Compact relative elements
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Symbol Options Functionality

Arranges the selected frame in front, in case the frame is
Forward

overlapped.

Arranges the selected frame back, in case the frame is
Backward

overlapped.
Align Left Aligns the selected frames towards left.

Align Center

Aligns the selected frame horizontally.

afll E ]

Horizontal
Align Right Aligns the selected frames towards right.
Align Top Aligns the selected frames towards top.

]

Align Center Vertical

Aligns the selected frame vertically.

gl

Align Bottom

Aligns the selected frames towards bottom.

(]

Same width

Ensures all the selected frames have same width.

Same height

Ensures all the selected frames have same height.

Same space
horizontal

Ensures all the selected frames have same space horizontally.

Same space vertical

Ensures all the selected frames have same space vertically.

Tile objects

Tiles selected elements in line.

Mirror Vertically

Displays the mirror image of the selected elements, vertically.

Mirror Horizontally

Displays the mirror image of the selected elements,
horizontally.

Move out from page

Moves selected element from page to non-workspace.
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Page Menu

The properties for the page are found in the menu Page. Refer Page chapter for more details.

The Page menu options are shown in the below figure:

‘Page | Run  Tools Window

|

Insert page »
. Delete page
Groupings »

[} Page properties... Alt-P

Options Functionality

Insert page Inserts different types of pages like main, title, tail, first page region, odd, even, and so on.
Delete page Deletes the selected page.

Grouping Establish a connection between XML file and the page.

Page properties Set the properties of page like size, width, height, type, and so on.

34|Page



Run Menu

The Run menu consists of options to process, check quality, change settings of a layout. Refer

Layout Settings section for more details. The Layout menu options are shown in the below

figure:

Runl Tools ‘Window Help -

 Process layout Cti-P
Check layout quality...
Process multilayout...  Cti+Shift-i
&) Combine layouts...
3 Layout settings... Cri+Shift-A
Layout preview
Options Functionality

Process layout

Starts generation of XSL, XSL-FO, and PDF files.

Check layout quality

Checks the quality of the layout and finds errors.

Process multilayout

Processes multilayout documents and generates XSL, XSL-FO, and PDF.

Combine layouts

Combine layouts from independent XSLfast files and forms a new file.

Layout settings

Option to modify the layout settings.
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Tools Menu

The Tools menu consists of extra options of XSLfast. Refer Preferences and Other Features of

XSLfast chapters for more details. The Tools menu options are shown in the below figure:

[Toolsl Window  Help

-

| Compare layouts...
L =) View XSLT output...
' [52) xPath-Monitar...

]‘ Generate font metrics...

' @ Transformation...

| Convert XSL-FO to layout...
Convert HTML to layout...

Merge XML files. ..
Paste special...
Styles...

&7 Preferences...

R Registration. ..

Ctri+Shift-yf
Ctrl-Q

Alt-O

Options

Functionality

View XSLT output

Opens a window with the XSLT file, generated during layout processing.

Xpath-Monitor

Evaluates the XML data using Xpath expression.

Generate font metrics

Select the fonts that XSLfast has to support with respect to the renderer.

Transformation

Option to convert HTML tags placed in CDATA blocks into XSL-FO.

Convert XSL-FO to
layout

Converts XSL-FO files to XSLfast layouts.

Convert HTML to
layout

Converts HTML files to XSLfast layouts.

Merge XML files

Option to merge many XML files.

Preferences

Enables to do various settings of XSLfast like Input, output, external tool
settings, and so on.
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Options Functionality

Registration Register XSLfast license version.

Paste Special

The Paste special option provides the ability to paste the copied elements from the clipboard,

multiple times, with an alignment order.
Follow the steps below to use Paste special:
1. Select Copy from Edit menu or pres Ctrl-C to copy an element from the worksheet.

2. Select Paste special from Edit menu. The Paste special window appears.

Paste special 2

Please, enter number of copies

5 |

Please, select copies orientation

(e} Horizontal
) Vertical

(") Diagonal

| Ok ]| Cancel I

3. Enter number of copies in Please, enter number of copies field.
4. Select the orientation from Please, select copies orientation field.
5. Click “Ok” to paste the copied element.

Element Pasted Horizontally:

Five elements pasted horizontally, along with the copied element.
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(e{efef{e{e{enpty)

Element Pasted Vertically:

Five elements pasted vertically, along with the copied element.

[enmtel
[enmtel
[enmtel
[enmtv)
[enmtel
enpty)

Element Pasted Diagonally:

Five elements pasted diagonally, along with the copied element.

5
<

(enpty)

o
13
<

-

T
1

PO SRRy

Styles

The feature Styles is useful when you need to apply fixed text styles to whole table, table

rows, table cells, or text elements available in a layout. To apply style for an element, select
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the element to which you need to apply a style. Choose style from logical styles in Inspector
window, offered by XSLfast, or create your own style and apply.

To apply a style to a table, select the table and use the function Table 2 Logical style in the
inspector window:

| EH cTable_1 :
Property | Value
; norbject' name . cTable_l -
Locked [
4 Table
4 Grouping Product

4 Use slternate ...
Alternate c...
Sork
Use custom rep.., []
Backaground image
Background color
Omit header page b..:. []
Omit footer page br.., []
Logical style Mormal > |

Row properties Hormal
Summary Table

4 Column properties
Auto-width [
Column width 67 pt
If

To apply a logical style to a text element located in a table cell or in a worksheet, select it

and use the function Text - Logical style in the inspector window:
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i Aa cTextFlow_2

Property
'al;jhec.thname
Locked
4 Text
Background color

Line height

Logical style
Last line alignment
4 Frame properties
4 Bounds
4 Absolute position
Left
Top
Width
Height

o Wale
cTextFlow_2
|
Edit...

14 pt

Line-stacking-strateqy | Select line-stackin... v |

Header

1
-

Header
Footer
Heading 1
Heading 2
Heading 3
Heading 4
Normal
Strong

o

il

ZoF T
181 pt

To apply logical style to a table cell, select a table cell in a table and select Parent Table =

Cell properties = Logical style in the inspector window:

| Aa cTextFlow_6

Property
MOE]ect name
Locked
a Text
Background color
Expand to right
Line height
Line-stacking-strategy
Logical style
Last line alignment
4 Parent table
a Cell properties
Cell border
Background color
Background image
Logical style
Column span
Row span
» Row properties

» Column properties

ke
cTextFlow_6&
_

Edit...

O

21.6 pt

| Select line-stackin...

=]

|_Select style

-
|

| Auto

=)

cTable_1

Border...

Mormal

Normal

Strong Cell

Emphasis Cell
T

E
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To apply a logical style to a table row, select a row in the table and select Table > Row
properties - Logical style in the inspector window:

| EH cTable_1
Property | Yalue
—Ob]ect name ETaiJIe_I—
Locked [
4 Table
4 Grouping ProductGroup
4 Use alternate c...
Alternate c...
Sork

Use custom rep... []
Background image
Backaround color
Orit header page b... []
Omit footer page br... []

Logical skyle Mormal pry
4 Row properties Normal
Fixed row height SommariTabie

Minimum row h... 89 pt

XSLfast allows you to create new styles, edit existing styles, and remove styles. Select Styles
from Edit menu. The Logical styles editor window appears.
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Logical styles editor 3

Styles:

Headear = ~—
Footer '_f_d_'t_J
Heading 1
Heading 2
Heading 3
Heading 4
Normal
Strong
Emphasis .
Title
Normal
Surnmary Table STt
Normal | New Text.
Eonpas ¢ _NewTable ]
Emphasis Cell ' : New Table
Normal l New Table row l
Table Header Row M e s
|_Table Footer Row - | New Table qoll_]
Preview
Selactad style
I Remove |
[ ok || cancel |

There are four different types of style available in XSLfast:

e Text

e Table

e Table row

e Table cell

XSLfast offers predefined styles that can be modified according to your needs. You can save the

modifications with a new name, as well as, overwrite existing styles.

Logical styles editor window lists the existing styles under Styles area. Scroll to find the style

you want to edit or to remove.

To create style, click any of these buttons:
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1. “New Text” - to create text style. Refer Create Text Style section for more details.

2. “New Table” - to create table style. Refer Create Table Style section for more details.

3. “New Table row” - to create table row style. Refer Create Table Row Style section for

more details.

4. “New Table cell” - to create table cell style. Refer Create Table Cell Style section for

more details.

To edit a style, select the style from the list and then click “Edit” button. The Style editor

window appears. Depending on the styles you select, the style editor window appears, like:
1. Text logical style editor - for text
2. Table logical style editor - for table
3. Table cell logical style editor - for table cell
4. Table row logical style editor - for table row

To remove a style, select the style from the list and then click “Remove” button. The

Confirmation window appears. Click “Yes” to remove, else click “No*“.
Confirmation X3

e  Remove style?

| tes || to |

Registration

If you want to install license version XSLfast, after the trial period is over, use Registration

menu. jCatalog provides the registration information.

Follow the steps below to register the license version:
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1. Select Registration from Tools menu. The Registration window appears.

Registration @

Mame:

| |

Company:

| |

Serial number:
[ - |

[ oK ” Cancel I

2. Enter the Name and Company information into the corresponding fields.
3. Enter the license key in Serial number field.

4. Click “OK” to proceed or “Cancel” to abort the registration.

Note: Make sure that all entries are spelled correctly including upper and lower case;
otherwise the license key will not work. If you experience any problems with respect to the

license key, please contact jCatalog at support@xslfast.com.
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Window Menu

The Window menu consists of different window view options. Refer Multiple Window Interface

section for more details. The Window menu options are shown in the below figure:

B Tile vertical

B Tile Horizontal

® Cascade

€ Close Ctrl-F4
Close all

 Table,xsf

Symbol Options

Functionality

Tile Horizontal

Arrange multiple windows horizontally.

Tile Vertical

Arrange multiple windows vertically.

D
8
Cascade

Arrange multiple windows diagonally.

(%] Close

Closes the active layout

Close all

Closes all the open layouts.
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Help Menu

The menu Help shows help files and additional information about the application. The Help

menu options are shown in the below figure:

reb |
@) ¥SLfast Help...

@ System information. ..

) ¥SLfast Online...

i) About...

Symbol Options

Functionality

@ XSLfast Help Opens XSLfast online help.
[ﬁ System Offers information on XSLfast and the system that XSLfast is
Information currently running on.

é) About

Shows information on version, build of XSLfast, and date when it
was built.

XSLfast Help

Click XSLfast Help, the XSLfast online help opens the help documentation from XSLfast

doc/sub-folder. To view the help files you need a HTML browser.
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System Information

The System information offers you information on XSLfast and the system that XSLfast is

currently running on.

System information 3

System information

Cwirent settings:

Output format:  Portable Document
Selected renderer: FOP

XSLfast build:  12/01/2012

FOP version: 5
Memory properties:

Metnory currently used: 27Nb
Iaximum memory pool being used: 259Nb

JVM properties:

java.runtitne. name Jawa( TW) SE Runtime Environtment

java.wm.version 20.2-b06

java.wm.vendor Sun Microsystemns Inc.

java.wendor.url http:/fava. sun. com/

java.vin.name Java HotSpot( TV Client VIV

dmvre vvane man e Fimodiman anemane o Tovwm T liatssmd Blaatiiinm Clanmmi Fmmdiman 2
4 [ i | »

_ Force memory cleanup J| Refresh ]| Close ]
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The “Force memory cleanup” button clears the memory of cached items and improves the
performance. The “Refresh” button updates the information in the window. Click “Close”

button to close the window.

About

About XSLfast window displays information on version, build of XSLfast, and the date when it

was built. This information is helpful to support if any problem exist. Click “OK” or >

“Close” button to close the window.

About XSLfast X3

t Version 5.0
' Date: 12/01/2012
& jCatalog Software AG

Info: http:f v, xslFast.com

© iCatalog Software AG 2011 ook
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ToolBar

The tools in the toolbar reflect some of the commands described in menu bar. Many of these

tools also have matching commands in the context menus of the elements.

Main Toolbar

These are the tools in the fixed toolbar:

Ilcon Function lcon Function

Create new file Aa  Text
Open file 12 Number
Save file XSL Text field (XSL code)

Export Template Barcode

=

Undo last step Image

Internet Link

@

Process Layout

| A, vy & @IOD

Find E:' Date/Time
Combine layouts. Square
it Choose Ij Pagination
Citation Index

49|Page



E| Chart E Table

/ Line E Pivot Table
= Call template = List

=

Frame Dependent Toolbars

The dynamic toolbar changes according to the element, which is currently selected on the

sheet. If no element is currently selected, it shows the icons for the working sheet:

Icon Function Icon Function
. .

@ Export = Add title page regions.
EE_@ Grouping % Add tail page regions.

= Load grouping structure from =3th - .
Q XML/DTD file. = Add first page regions.
E Check layout quality. % Add last page regions.
%} Add odd page regions. @' Add rest pages regions.
% Add even page regions. % Add any page regions.
= . = Add any page regions (odd or
D Add Main page. =t even).

The following tables show the tools, which appear in the dynamic toolbar according to the

selected element on the sheet:
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Text element/XSLcode element/Bar code element:

Icon Function Icon Function

Arial VJ Font = Right

11 vjpt Font size C] Top

B Bold &) Center

I Italics | Ej Bottom

u Underlined . Background color
=S Left O Border
= Center 7] Paddings

* The Style function does not apply to XSLcode or Bar code elements.

** The Justify function does not apply to Bar code elements.

*** The Text color function does not apply to Bar code elements generated using SVG graphics.

It is applicable only for barcodes generated using barcode fonts.

Number element/Internet link/Date/Time element/Pagination element/Index

element/Citation element:

Icon Function €0  Function
n
Arial v Font d Top
11 v]pt Font size & Center
B Bold { _:;] Bottom
I Italics J Text color
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Underlined .

u Background color
=S Left O Border
= Center Paddings

= Right

Image element (static/dynamic data)

Icon Function Icon Function
m' Image Type E Image Base Path
= Left = Center

f== Center = Bottom

= Right O Border

= Top Paddings

The Square element only possesses the two functions Background color . and Border .

Table/Slave Table:

Icon Function Icon Function

Custom ¥ Style Add header
E‘ﬂ Add row after Remove header
D Add row before Add footer
E Remove row Remove footer
% Add column after Table grouping

ﬂ Add column before Remove table grouping
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g8 Remove column & Add Slave Table
Pivot Table:
Icon Function Icon Function
Custom z] Style B Add column after
3 ) Add row after ;) Add column before
B Add row before m Remove column
E Remove row
List:
Icon Function Icon Function
Arial t] Font _?3 Center
11 v pt Font size E Bottom
B Bold J Text color
I Italics . Background color
U Underlined [ Border
= Left Paddings
= Justify Add grouping
E) Top "% Remove grouping
Line:
Icon Function Icon Function
_E] Line Style -  Line Color
1.0 B Line size
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Icon Function

lcon Function

bar v Type

@ Set Chart Values
%

3D Ch.. v Chart Type Set Chart Description
r_ﬂﬁ Set Chart Legend (Only for Bar Chart) :E):c Set Chart Caption
O Border Ee Paddings

. Chart Background Color

The icons for the horizontal and vertical alignment are only displayed if more than one element

on the sheet is selected:

Icon Function Icon Function

E>E Same space vertical [T Align bottom

E Same width :%: Same space horizontal
i Same height T Alignteft

Align top

Align center horizontal

BEEC
|
UHE' Align center vertical IE

Align right

The toolbar can be separated into three smaller bars (General, Insert, and Properties) by

dragging them from their original place to another place in the application window and outside

the window. To place the toolbar back into its place, close them with the cross in the upper

right corner.
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XML Window

The window, which displays structure of an XML file, is called XML window. Selected an XML
file, the file’s structure is displayed in this window. The nodes can be opened, closed, and

dragged and dropped into the worksheet using mouse.

Data lFormat ! &8

4 Publication
LayoutType
PublicationID
Description
PublicationCurrencyID
PublicationLanguagelD
CreatedBy
CreationDate
CreationTime
ChangedBy
ChangeDate
ChangeTime
4 Text
TextType
TextContent
» ProductGroup
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Inspector Window

The window, which displays the attributes/properties of an element selected on the worksheet
is called Inspector window. Here, you can also change the properties of a selected element, as
required. If no elements are selected the inspector window displays the properties of a page.

The Properties are displayed category wise, or in alphabetical order.

To view the properties category wise, click Categorized tab.

[[E‘ Farmat I 1 &

- Aa cTextFlow_3 v
Property | Yalue ]
Oblactnaims Tetfows A
Locked ] l
4 Text Edit...
Backaround color
Line height 36 pt
Line-stacking-strateay | Select line-stackin... « |
Logical style | Select style v
Last line alignment Auto v

4 Frame properties

4 Bounds [Absolute position: tru...
4 Absolute position
Left 98 pt
Top 37 pt
width 472 pt
Height 82 pt
4 Paddings [Left padding: 0.0 pt; ...

Left padding  Opt
Top padding  Opt
Right padding 0 pt
Bottom pad... Opt

]
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Element properties are also available in the context menu. To view the context menu select

the element and right-click.

Note: A double click on an element offers to modify what should be displayed in the frame (the
content) and the right mouse click offers to modify how it should be displayed (the properties).
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The Worksheet

200 250 300 250 400 450 500 550

[=1-1-7 DO =1-12] =15 NN ooa L=15 1) L=1-12] DO [=1=12)
1l

SRS

oo

oo

-

)

This is the document page, where you create layout. All needed elements are placed onto this
sheet and can be arranged as preferred. The horizontal and vertical rulers support the easy
arrangement of the elements. The hint “/” indicates that the page is not related with any XML

file yet.
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The Node tab context menu offers you the options to change the properties of the page. Here

you can group the page to a node, insert different pages, change the page type, change the

background color and image of the page.

I cu

B copy

B Paste
Groupings
Insert ﬁége

B Delete page

Portrait/Landscape

Background image

Background color...

| B Undo: xml file ..\input\Demo.xml Ctrl-Z

Ctrl-X
Ctrl-C
Ctrl-V
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Element ListBox

The listbox between XML window and Inspector window is called Element Listbox. All elements
on the sheet are listed with either their default name or the name you give them. The
element, which is currently selected, is displayed in the list box. It works both ways, if you
select an element from the list box; it is selected on the sheet. This function is very helpful if
you have many different items on your sheet, or if you placed elements outside the sheet,
because they depend on a condition and are only needed if the condition is fulfilled. If you

select an element in the list box, it is selected, disregarding its place.

IE Format | 4 F
Pick Element v |
| [&] 1mage_3 N
Image_4 |
/ Line_1
Square_1
Square_2
Square_3
Aa TextFlow_2
As cTextFlow_2 -

i
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Status Bar

The Status bar represents the X and Y co-ordinates and file name. It also displays the layout
option and some message about the layout if the Show layout options in status bar and Show

log in status bar option is checked in Preferences window, under View option.

e R
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Customizing Interface

This section explains how to customize the XSLfast Interface.

Grid Preferences

The grids help to place the elements in a proper alignment, on the worksheet. They are mainly

helpful in positioning.

The Grid preferences in View menu have the following sub-options:

Show grid

Snap to grid

Grid size

Grid point of origin

Show Grid

The Show grid option enables the grid lines on the worksheet.

To enable gridlines, click View = Grid preferences and check Show grid menu.
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Grids enabled
on worksheet

The grid settings can also be done in Preferences menu. Click Tools = Preferences, select

View options tab, check Show grid check box, and click “Ok” button.

XSLfast preferences x4
[ )General options [ Grid properties ‘
[)view options Show grid
[Tadditional options [} snap on grid
DPerformance options ;
[)compatibility options Grid size 8
Pics o Gib 3

To disable gridlines, uncheck Show grid option through View menu or Preferences window.

Snap to Grid

Snap to grid arranges elements to grid points. In other words, when this option is turned on,
and the grid size is specified as 10x10, you can place (move) elements only to positions 10, 20,

30, and so on, but not to 25, 17, 6, and so on.

To arrange elements to grid points, click View = Grid preferences and check Snap to grid

menu.
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Grid preferences 4 v Show grid
Look and feel » B4 5”'5" ta grid
A
vl
Element placed exactly Element palced in
on the grid points. between grid points.

The snap settings can also be done in Preferences menu. Click Tools - Preferences, select

View options tab, check Snap on grid check box, and click “Ok” button.

XSLfast preferences 2
[)General options -Grid properties
D\p‘iew options Show grid
DAddltlonal options Shag ocigiid
DPerformance options
[compatibility options Grid size 13
P2 b e

To disable snaps, uncheck Snap to grid option through View menu or Snap on grid option

through Preferences window.

Grid Size

The grid size determines the distance between each grid points. To change the grid size, click

View - Grid preferences and select the size from Grid size menu.
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The grid size settings can also be done in Preferences menu. Click Tools = Preferences,

select View options tab, enter size in Grid size field, and click “Ok” button.

XSLfast preferences 2 ‘
[ JGeneral options Grid properties
[Cview options Shaw grid
DAddltlonaI options Snap b
DPerformance options
[compatibility options Grid size 8 |
P2 g oS

Look and Feel

The Look and Feel menu offers different Interface style. It changes the interface views as per

the style selected. Following are the styles available in XSLfast:
o PlastixXPLookandFeel

¢ Metal
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e Windows

e  Windows Classic

e Pago

e Liquid

e Substance

e System specific (like native MacOS X look and feel for MacOS X)

To change the interface style, click View 2 Look and Feel and the select the interface style

required.

Look and feei 3

Show XML in alphabetical order
Highlight to tree selection

., Zoom in Cti-NumPad +

Q Zoom out Ctrl-NumPad -

% Reset zoom Ctrl-NumPad *
Filter by type »

1

Yiew [ Insert  Arrange Page Run Tools ‘Window Help _
Grk preferences L. [l €3 P

 Tiny (Default)
Metal
MimROD
Substance
Squareness
Substance Mebula
Substance Emerald
Substance Graphite
Substance Blue Steel
Substance Office2007

Once you select the interface style, a dialog window appears:

Message

‘I Please restart XSLFast for the look and feel changes to have effect

o]

X4
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Click “OK” button and restart XSLfast to use the selected interface style.

Show XML in Alphabetical Order

Show XML in alphabetical order sorts the xml nodes alphabetically, in XML window, without

changing their structure. To sort the xml nodes, check Show XML in alphabetical order from

View menu, or in XSLfast preferences window, under View option.

Grid preferences

Look and feel

Shows XML in alphabetizal order

(=79 Report
-9 Productgroup
‘ Name
------ & Img
=112 Product
o Name
------ # Description

=) Report
=279 Productgroup

oo Data
- Description

Before Sorting

After Sorting

Highlight to Tree Selection

Highlight to tree selection option highlights or illuminates the elements from XML tree. To

highlight the XML tree element, select View menu and check Highlight to tree selection

option.
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If you uncheck Highlight to tree selection option, the XML tree element is not highlighted.

Filter by Type

The Filter by type option shows or hides the elements, with respect to element type like, text,

numeric field, XSL code, and so on.

The Filter by type menu consists of two sub-menus:

¢ Show all types
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¢ Hide all types

It also has filter options to display certain type of elements.

Show All Types

To show all types of element, click View = Filter by type = Show all types option. The

View [ Insert  Arrange Page

Window  Help

Run Tools

Grid preferences
Look and feel
Show XML in alphabetical order
Highlight to tree selection
Q Zoom in
% Zoom out
% Reset zoom

4

Ctrl-NumPad +
Ctrl-NumPad -
Ctrl-NumPad *

100

Y EEIEEEIED
0

50

1150
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Multiple Window Interface

XSLfast offers multiple window interfaces, where you can arrange multiple windows
horizontally, vertically, and cascaded. The Window menu enables you to arrange multiple
windows in different styles. By default, the MDI interface is disabled; you need to follow

Properties menu to enable it first.

Horizontal Arrangement

To arrange the windows horizontally, select Window - Tile Horizontal.
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Vertical Arrangement

To arrange the windows vertically, select Window - Tile Vertical.
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Cascaded Arrangement

To cascade multiple window, select Window - Cascade.
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Layout

The arrangement of elements on a worksheet is called layout. By arranging frames on the
worksheet, you determine the look of your document. In order to achieve a satisfying result, it
is advisable to plan the look and layout, before beginning the creation and then referring to it.
The elements or pages of the layout are connected to the XML nodes, in order to display the

content, as per the created layout. An example of layout is shown in the below figure.
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~ Example 17

" This is a static text with differsrt color, assn teXt size, different texfé :

>

é-You can specily superscript and subscript using Font dialog

and XML text B
| {ProductGroup/DescShorty |

|| with top and left pacing

. . FftpTNniew X ast com

Here, each element is connected to the nodes of XML. For example, the page is connected to

Report/ProductGroup node, the table is connected to Product node, and so on.
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Create Layout

To create a layout, follow the steps below:

1. Open XSLfast tool. The Open window appears.

Open... b4

thy | W/ \

1. Create/Open layout 2. Attach XML/DTD data file 3. Modify layout 4. Render layout
) Open existing layout... [ | Create new layout...
Open recently used layout... Open from template...

D C:/Documents and Settings/. .. /Footnotes.xsf D Business report

D C:/Documents and Settings/nasgor/.../Table.xsf D Text document

D C:/Documents and Settings/nasgor/.../Text.xsf D Assessment

D C:/Documents and Settings/nasgor/.../1.xsf D Order

D D:fXSLFastfxslfast]. .. ftable background image, xsf D Brochure with columns

D C:J...Jtable background image.xsf D Brochure

D C:fDocuments and Settings/.../Pivot_Table.xsf D Master-Slave

D C:/Documents and Settings/nasgor/. .. /list.xsf D Chart

D ..JlibfTemplates/Layouts/Business report,xsf D Business card

Show this dialog at startup | Cancel I

2. Click Empty layout... option. A New layout and an Open window to load XML file

appears.
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Note: You can also open a new layout in any of the following ways:

3. Select File > New menu.

4. Click D - New icon from toolbar.

5. Press Ctrl+N.

Open... <3

Xhay.
>

T 't<\

1. Create/Open layout 2. Attach XML/DTD data file 3. Modify layout 4. Render layout
Look In: 1 input - @ '@ |a
= Tutorial
) Demo.xml

[ ) Demodata_de.xml
) Demodata_en.xml

File Mame: | |

Files of Type: DTD¥MLIXSD schema Files (*.xsd, *.xml, *.dtd) -

| € || open || continue without x|

Note: The new layout appears as New layout 1, New layout 2, and so on, if the layout is not

saved.

6. Select the XML file to load the XML into XSLfast and click “Open” button, else click

“Cancel” button (Refer Load Structure section for more details).
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7. Insert elements on the worksheet and save the file in .xsf format (Refer Insert

Elements and Save Layout sections for more details).

Open Layout

XSLfast offers you to open an empty layout, existing layouts, recently used layouts, and

templates, through Open window.

The Open Window

The Open window consists of the following options:
¢ Open existing layout
e Open recently used layout
e Empty layout

¢ Templates

78|Page



Open... 2
Xy L

T - \

\/ 3 % \/

1. Create/Open layout 2. Attach XML/DTD data file 3. Modify layout 4. Render layout
Open existing layout... [ Create new layout...
Open recently used layout... Open from template...

D C:JDocuments and Settings/.../Footnotes. xsf D Business report

D C:fDocuments and Settings/nasgory...jTable.xsf D Text document

D C:/Documents and Settingsfnasgor/.../Text.xsf D Assessment

D C:/Documents and Settings/nasgor.../1.xsf D Order

D D:/%SLFastfxslfast]. .. jtable background image. xsf D Brochure with columns

D C:/...Jtable background image. xsf D Brochure

D C:/Documents and Settings/.../Pivot_Table.xsf D Master-Slave

D C:/Documents and Settings{nasgor/. .. flist.xsf D Chart

D . JlibfTemplates/LayoutsBusiness report.xsf D Business card
Show this dialog at startup | Cancel l

Open Existing Layout

The Open existing layout... option opens the layouts available in the system. If you click this

option a window appears, which lists all the existing layouts.
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Open bXS

LookIn: =1 05_Footnotes

= | -y
) XML
|51 %5L_FO
Files. l [ ] Footnotes. xsF
i
. |
Default templates
TR Preview not found
File Mame: | I
Files of Type:  Layout files {*.xsf, *.lay) v

|_open || cancel |

Select the file and click “Open” button, else click “Cancel” button.

Note: While opening an existing file, recently used files, and templates the XML structure of

the selected file also loads into XSLfast.

Open Recently Used Layout

The Open recently used layout... option opens the recently used layout. It lists all recently

used layouts, along with its path. Select any layout, the selected file opens.
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Empty Layout

The Empty Layout... option opens an empty layout, where you can create a new layout. Refer

Create Layout section for more details.

Templates

The Templates option opens the existing template in XSLfast.

Show Dialog at Startup

The Show this dialog at startup checkbox is used to open the start wizard every time you open
a new layout, or open XSLfast. If you uncheck this checkbox, the start wizard does not appear

every time you open a new layout or XSLfast tool.
You can also do this setting in XSLfast preferences window.

Select Tools = Preferences menu. The XSLfast preferences window appears. Check Show

startup wizard checkbox, under General options tab.

Open File

To open an xsf file, select File > Open menu/click u - Open icon from toolbar/press

Ctrl+0. The Open window appears.
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Open 23

LookIn: (£ 0S_Footnotes v @

& cvs

= ¥ML

=1 %SL_FO

D Eﬁ;ﬁtﬁoﬁes.xsf

File Mame: [Footnotes. xsf ]

Files of Type:  Layout files {*.xsf, *.lay) v

| Open ]I Cancel ]

Select an .xsf file and click “Open” button, else click “Cancel” button.

Save Layout

The Save option saves the layout in .xsf format. Following are the save options available in
XSLfast:

e Save
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e Save as

e Save all

Save As

To save a new layout, follow the steps below:

1=
1. Select File >Save as menu/click - Save icon from toolbar/press Ctri+Shift+S.

The Save window appears.
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Save X4

SaveIn: =) 52_Documentation v @

=i cvs

=1 img

0 XML

&3 XsL_FO

D Documentation. xsf

File Mame: Documentation, xsf I

Files of Type:  Layout files (*,xsF) v

Save | | .Canc.el_]

2. Select the path from Save in: drop-down.
3. Enter the file name in File name: field.
4. Select Layout files (*.xsf) file type from Files of type: drop-down.

5. Click “Save” button to save the layout, else click “Cancel” button.
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Save

The Save option is used to save an existing layout, if you modify the layout.

To save an existing layout, select File > Save menu, or press Ctri(+S.

Save All

The Save All option saves all the open files. It works similar to Save as, if you need to save new

layouts and works similar to Save, if you need to save existing layouts.

To save all layouts, select File = Save all menu, or click - Save all icon from toolbar.

Close Layout

The Close option closes the active layout or all the open layouts. Following are the close
options available in XSLfast:

¢ Close
e Close all
Close

The Close option closes the active layout. To close a layout, select File = Close menu/click

- Close icon from toolbar/click m - “Close” button/press Ctrl+F4.

Close All

The Close all option closes all the open layouts. To close all the open layouts, select File =
Close all menu.
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Load Structure

XSLfast offers you to load the structure of two types of files:
o .xmlfile

e .csvfile

Load XML/DTD

The Load structure from XML/DTD file option loads the structure of XML file into XSLfast. This
helps to view the structure of the XML file and design the layout as per the structure. The

loaded structure is displayed in XML window.

To load the structure of an XML file, follow the steps below:

1. Select File > Load structure from XML/DTD file menu/click ' EE— - Load grouping
structure from XML/DTD file/press Ctrl+G. The Open window appears.

Note: The Open window pops up, only if you check Disable layouts without XML checkbox,
in XSLfast preference window. Select Tools > Preferences. The XSLfast preferences
window appears. Check Disable layouts without XML checkbox, under General options tab

and click “Ok” button.

If you uncheck this option, the Open window does not pop next time, when you open a new

layout.
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XSLfast preferences =R

[ )General options General options

DView options Show startup wizard
[additional options

2 Disable layouts without XML
[TJperformance options

[Jcompatibility options Track all changes as separate versions of layout
[ R R
Open 3
LookIn: = input - @ .! . EEE
= Tutorial
D Demo.xml

B Demodéta_de.xml
[ ) Demodata_en.xml

File Mame: Dema.xml

Files of Type:  DTD/XMLIXSD schema files (*.xsd, *.xml, *.dtd) v

[] Do not bind layout to top node

|_open | [ cancel |

2. Select the xml file and click “Open” button. The XML structure is loaded into XSLfast.

For example, in the above figure, the structure of Demo.xml is loaded into XSLfast.
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Data I Format &5

4 Report
4 Productgroup
Mame
Img
4 Product
MName
Description
Img
Data

Note: XSLfast allows you to load the structure of a single xml/csv file, into a layout.

Binding Layout to Top Node

The function Do not bind layout to top node allows to select the root node “/” in the layout.
This root node can be used as a general node to support the creation of layouts, with different
XML files, containing different root nodes. If you need to specify an alternative XML root,

XSLfast offers not to automatically bind the layout to the top node.

If you uncheck this option, the layout is bound to the top node, as shown in below figure:
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Data |Format I 1 F

4 Report
4 Productgroup
Mame
Img
4 Product
Mame
Description
Imng
Data

The page is bound to the top node of the XML file if Do not bind layout to top node option is
unchecked. For example, Report. Every element grouped to XML contents that is placed on the
sheet now shows the path to the node without Report, e.g. ProductGroup/Name.

Data | Format

4 Report
4 Productgroup
Mame
Img
4 Product
Name
Description
Img
Data

Product}

If you check this option, the layout is not bound to the top node, as shown in below figure:
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Data | Format I 15
4
4 Report
4 Productgroup
MName
Img
4 Product
Mame
Description
Img
Data

The page is bound to the root node (/) if Do not bind layout to top node is checked. Every
element grouped to XML contents that is placed on the sheet now shows the path to the node
with Report, e.g. /Report/ProductGroup/Name.

Data [Format VBB BB BR BRB B8 | 8

ad

4 Iigport |
4 Productgroup
MName
Img
4 Product
Mame
Description
Img
Data

Product}
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Note: This setting can also be done in Layout settings window. Select Layout > Layout
settings menu. The Layout settings window appears. Check Do not bind layout to top node

option, under Input/Output settings tab.

Layout settings: version1 23

| Additional templates | Layout description " Advanced options “ Security

| Input/Output settings l Generation options
-Input
 ®ML-File: |, finput/Dema. xml ]l ll Edit l

Do not bind layout to top node

Load CSV File

The Load structure from csv file option loads the structure of csv file into XSLfast. This helps
to view the structure of the csv file and design the layout as per the structure. The loaded

structure is displayed in XML window.
To load a CSV file, follow the steps below:

1. Select File > Load structure from csv file menu. The Open window appears.
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Open 2

LookIn: 4 input v @ ]Q @

=1 Tutorial

File Mame: |

Files of Type:  Comma Separated (*.csv) v
CSVencoding UTF-8 - CSY delimiter v

["] Do not bind layout to top node

|_open | [ cancel |

2. Select a csv file.

3. Select Comma Separated (".csv) file type from Files of type drop-down.
4. Select CSV encoding from the drop-down.

5. Select CSV delimiter from the drop-down.

6. Click “Open” button.

Note: The functioning of load csv is similar to loading xml.
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Grouping Layout

To create a document, where the contents of an XML file are supposed to be displayed, you
need to connect the nodes of the XML file with elements on your sheet used as placeholders.

This action is called "Grouping".

Grouping the page or elements to certain nodes of the XML establishes a connection to specify
the path to the elements or page. As the application reads the XML file always from the top,

this must be considered in the path to the correct node.

If the grouping is not correct or if there is no grouping at all, the contents will not be displayed

later or wrong contents will be displayed.

An example: By default, the page is automatically grouped to the top node of the XML file, e.g.
Report. Every element grouped to XML contents that is placed on the sheet now shows the path

to the node without Report, e.g. ProductGroup/Name.

If the page is grouped e.g. to the node Report/ProductGroup/ Product, the elements on the
sheet now already refer to those nodes contained in Product and show only the name of the

node itself because the first part of the path is already determined.

And if the element like a e.g. table is itself grouped to a node, the elements placed into the
table will only show the name of the node because the first part of the path is already

determined.

Of course, it is also possible to place nodes from all levels of the XML file on the sheet or in

tables. XSLfast will automatically add the necessary elements for the right path.
There are three types of grouping

e Group by Position

e Filtering

e Group by Content
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Group by Position

Groupings are used in different elements in XSLfast. Page groupings are used for an automatic
page break after a node (e.g. ProductGroup) or a node set (e.g.

/Publication/ProductGroup/ProductGroup) has been processed.
Behind a page grouping, there is a loop over the selected node or node set.

All elements in regions and in the body refer to the page grouping, which means the current
path is the selected node of the page grouping. This means that all frames have a path relative
to the page grouping. This is often the cause for problems, because the elements are in a
dependency on the page grouping. If the page grouping is changed, groupings of tables and
other elements must probably be changed, as well. That is the reason why page groupings

should be specified in an early stage of the layout design.
Example:

An XML file with 3 Product groups

Product group A (contains 3 products)

Product group B (contains 4 products)

Product group C (contains 2 products)

In XML shape:
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<Publication=
<ProductGroup=
<Name=Product group A=</Name:=
<Product=
<Name=Product 1=/Name=
</Product=
<Product=
<Name=Product 2=</Name=
</Product=
=Product=
<Name=Product 3=</Name=>
</Product=
</ProductGroup=>
<ProductGroup=
<Name> Product group B=</Name=
<Product=
=Name=Product 1</Name=>
</Product=
<Product=
<Name=Product 2</Name=
</Product=
<Product=
<Name=Product 3</Name=
</Product=
<Product=
<Name=Product 4</Name=
</Product=
</ProductGroup>
< ProductGroup=
<Name> Product group C</Name=>
<Product=
<Name=Product 1</Name=>
</Product=
<Product=
<Name=Product 2</Name=
</Product=
</ProductGroup=>
< /Publication=

Examples for page grouping via the node Publication:

The result is a list with all products. The page break only happens after the page end was

reached.
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Definition:

Result:

Product group A Product |
Product group A Product 2
Product group A Product 3
Product group B Product |
Product group B Product 2
Product group B  Product 3
Product group 8 Product 4
Product group C Product |
Product group C Praduct 2

Example for page grouping via the node ProductGroup:

With the start of a new product group there is an automatic page break. The new product

group starts on a new page.

Definition:
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Result

Page 1:

Product group A Product 1
Product group A Product 2
Product group A Product 3

Page 2:

Product group B Product 1
Product group B Product 2
Product group B Product 2
Product group B Product 4

Page 3:

Product group C Product 1
Product group C Product 2

Example for page grouping via the node Product:
For every product, there is a new page.

Definition:
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IName} Name}

Result:

Page 1:

Product group A FProduct 1

Page 2:

Product group A Product 2

Page 9:
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Product group C Product 2

Refer Page chapter for more details.
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Filtering

Filtering does not access all nodes of an XML file, but only a filtered amount of nodes. In

addition, filtering can contain especially specified node sets.

All limitations are written in brackets [] behind the node name. The content of a limitation is a
valid XPath expression, which returns TRUE or FALSE.

Examples:

All product groups, which are not empty and therefore contain products:
ProductGroup[count (Product) > 0]

All product groups whose product group id starts with 2204:
ProductGroup[starts-with (ProductGroup, '2204°)]

All product groups with a product group ID between 20 and 30:
ProductGroup[ProductGrouplD&gt;=20 and ProductGrouplD&lt;=30]

All products supposed to be for sales should be displayed:
Product[IsForSales="Y’]

In these filters, not only elements of the XML file can be used; in complex layouts very often,

variables are used.
Example:

Variable SMarkName is defined as “Audi” - This means that only products whose manufacturer
is “Audi” should be displayed:

Product [ManufacturerName=$MarkName]

As the XPath expressions for the filtering can be rather complex, it is important for the user to
know which elements of the XML file he can access from where (so he should use relative

paths) and which XPath functions he can use with what syntax.
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Special node sets address from one place inside the XML tree to another place. For the page,

grouping this is not very important.

Group by Content

The Group by content function supplements filtering, sorting, and grouping of table contents.
It allows you to quickly define a condition if contents should be displayed for example,

together or not at all. Refer Group Table section for more details.
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Insert Elements

There are two ways to insert an element on the worksheet:

¢ Manual Insertion

e Drag and Drop Insertion

Manual Insertion
You can insert elements manually using Insert menu or using icons from the toolbar.

LIRS e p RGO E I MM ek ¥
WR LGS 23882 288 B8
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Drag and Drop Insertion

To place element on the work sheet, use drag and drop from structure tree. It will assume

proper XPath expression according to your current groupings (filters). The typical example is

e [romet Oues il U vk Ry EEAR OO W ER
e . N _ , @ =

As you can see, the placed element is text. For such cases, you need other element type like
image, bar code, and so on. However, there is no need to place elements and type XPath

expressions manually. Select the element and right-click; select Convert option from context
menu as follows:
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_ .
Productgroup/f Bring forward

Send backward
™ Undo: object addition ... Ctrl-Z
s( Cut Ctrl-X
Copy Ctrl-C
) Paste Ctilv
Copy as text

Font Family
Font size
Font style

Alignment

Vertical alignment
Text color
Background color
Move texts to.one
Split texts

Conve(t tp... e
Generate template

Locked

v v v v v v w

b4

‘ 12 Numeric field 7

XsL %5L Code
Barcode

IE] Image

() mmternet link
(L] DateTime
B square

D Index
Citation

As a result, the text element is replaced with image element, by few simple clicks.

.@ Productgroup/Productimg

In case you need to change XPath expression, do not type it manually. Use Applicable XML

nodes option from the context menu. Select the element and right click, select Applicable

XML nodes and the node name.
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@ Productgroup/Productim

Bring Forward
Send backward
™ Undo: position/size changes 72,118,154,79 Ctrl-Z

- Applicable XML nodes 4 Productgroup
¢ cut Ctel-X hiare
Img
Co Ctrl-C
i ' 4 Product
Paste Ctl-v

5 MName
Alignment Description
Vertical alignment » Img
Select XML image. .. Data
Remove XML image
+ Fitinframe
« Keep aspect ratio

h 4

v

Select base path...

Remove base path

Convert to... 14
Generate template

Locked

The Xpath expression is changed as per the selection:

=) Productgroup/Product/D
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Layout Settings

Process Layout

The option Process Layout processes the layout and converts the layout into an output formats
like PDF, HTML, and so on. It allows you to view intermediate steps during the creation of your

layout, like:
¢ Generating XSL - Creating style sheet, combining XSL and XML, and generating XSL-FO.
¢ Invoking FOP - Invoking renderer program to convert XSL-FO into output formats.

XSLfast enables you to process a single layout or multiple layouts.

Process a Layout

To process a layout, select Layout = Process layout menu, or click b -> Process Layout icon

from toolbar, or press Ctri(+P.

Process Multilayout

Process Multilayout processes multilayout and produce an output. Process Multilayout makes
use of Multilayout manager window to combine layouts from different location and produce an

output file, without creating a new layout.

For example, see the below figure:
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Here, we have four layouts, from different location. These layouts are combined in Multilayout

manager to produce an output file

To process multiple layouts follow the steps below:

1. Select Run - Process multilayouts menu, or press Ctr(+Shift+M. The Multilayout

manager window appears.
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Multilayout manager 22

Layaut list: Files list

[~

= backup
1 bin

) docs
(- fonts
I Input
e

. hib

. log

I output
o tmp

Apply. E\ -~
v] Apply on selection by expression Adld Ramoye
Apply selection by expression
Selection
\ [ |

Expression

Sequence conditions
13rOUE s Page position Qdd or wysn
First - Odd - ‘
Lism body
| Use hwader, Footer, left; right

Generate I] Cluse l

Note: The Layout list region is used to add layouts from different paths.

The File list region is used to browse files.

2. Select the drive from the drop-down box -> P 'i. The

File list region lists all the folders contained in the drive selected.
3. Double-click the folders and select the layouts.

4. To add the layouts, select the layout and click “Add” button or drag and drop into
Layout list region.

Note: The added layouts should bound to the following constraints:

All layouts should use the same XML.
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The same page sizes.

The same region and margin sizes.

To remove layouts, select the layout from Layout list and click “Remove” button.

The “Apply” button is used to edit path of the files selected. Here, you can correct path
manually if it is wrong after copying layout from other computer.

In Layout list, you can specify the following:
e Page Sequence
¢ Regions
e Order

The entry fields Selection and Expression are used for XSL or XPath expressions. They are set
to the first node of the XML file and “1” by default.
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Create Page Sequence

Create page sequence name for each layout.
To do this, enter the values in Expression and Group name fields.
In the above figure, you see two page sequences:
¢ Empty group name (equal to Title page)
e “Shoes” group name (main page sequence)
Assign Regions
Regions are assigned only within one group.

For each region specify, one body and two or three region types

To assign a layout as body page, select the layout and check Use body checkbox.

Note: The layouts should have the same group name.

Expression

(™)

Sequence conditions

Group name:
Shoes
i/

Assign regions to the body page

You can define odd, even, left, or right page regions as header and footer.
To do this:

1. Select the layout
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2. Check Use header, footer, left, right check box.

3. Select odd or even page from Odd or even drop-down, or to select other regions select

options from Page position drop-down.

Group name:

=

[ Use body

| Use header, footer, left, right

(D Page position

R

Finally click “Generate” button to generate a pdf file. Here, all the layouts are combined to

produce an output file.
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Process Multilayout vs. Combine Layouts

The major difference between Process Multilayout and Combine layout is:
e Process Multilayout produces an output file, without creating a new layout.

¢ Combine layouts creates a new layout, using multiple layouts, and then produces

output.

Layout Quality

The option Check layout quality offers you an overview, over all general information on the

layout.
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Check layout quality X4

Layout statistics

General information:

Layout file: CADocuments and Settings\nasgor\Desktoph\TENMPA\Tutorial\03_Table\Table xsf

XML file: Ci\Documents and Settingstnasgor\Desktop\TENMPATutorial\03_Table\XIVILAexarnple. xml
XSL file: CiDocuments and Settingsinasgor\Desktoph\TENMPA\Tutorial\03_Table\XSL_FO\Table.xsl —
External templates file:

Not specified

Internal templates:

Not specified

Output file: CiDocuments and Settings\nasgor\Desktop\TENMPATutorial\03_Table\Table. pdf

Static image paths:
EMest\wslfastidistinput\ Tutorialitngi\box_xslfast.jpg
EMestwslfastidistinput\Tutorialitngiss] logo_new.jpg

Used fonts:
Arial

Total number of elements: 20
Number of templates: 0

Collisions: ~

Close I

This is just an overview over all your elements and document information.

At the bottom of the window, XSLfast shows warnings if it detects any invalid XSLcode in

elements:

Warnings:

cTextFlow 2 -- Contains invalid XPath.
cTextFlow 4 -- Contains inwvalid XPath.

It also indicates clearly, which elements should be reviewed and corrected.
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To check the quality of a layout, select Layout = Check layout quality menu. The Check

layout quality window appears. Click “Close” button to close this window.

Combine Layouts

The Combine layouts options enable to combine layouts, pages, and regions of multiple xsf

files and create a new layout.

To combine layouts, follow the steps mentioned in below sections:

Specify Source Folders

1. Select Layout ©>Combine layouts... menu, or click % - Combine layout icon from

toolbar. The Combine pages and layouts... window appears:

| Fls  Page

Combinw pages and laysuts

|

Comioae pages,

Ayalsie m_i{f?'m WWF whonaioa_T!

ol C1fUnaments and Setbngs mangonOaddon TENSY Tuborw T3 _Tatie Tatk o5t
_Jimanmain i)

1| Smarch n nbtclders

L2 [ o]

Previesy not found

| cose_|
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With this dialog, you can combine parts and regions from independent layouts and create a

new layout. The “main” page in the left frame is the currently open page.

2. Select the folder path, which contains the .xsf source files. The Available layouts:

field specifies the source files, along with its path.

To specify the source file:

3. Click “Browse” button. The Directory... window appears.

115|Page



Directory... 23
LookIn: 3 Tutorial - |§ @ |a EE
= =1 01_SimpleFlyer =1 15_Expand =1 31_Pagination
= =1 02_Pagination =1 16_Page_columns = 32_sv¥G_Graphic
=1 03_Table =1 17_Text =1 33_Business_Cards
=1 04_Columns =1 18_Mumeric_Field =1 34_Certificate

=1 05_Footnotes
=1 06_Template
= 07_Multilayout

=1 19_%s5L_Code
(=1 20_Barcode
=1 21_Images

=1 07_Multilayout_old_variant 1 22_Table

=1 08_Multilayout_Template &1 23_Filter =1 39_Choose
=1 08_Multilayout_Template_old =3 24_List =1 40_Chart
= 09_Multilayout_regions =1 25_call_Template = 41_XEP

=1 09_Multilayout_regions_old =1 26_ComplexTable

=1 10_Example_Manual
=1 11_DTD

=1 12_Group_by_content
=1 13_Namespace

=1 14_Suppress_redundant

=1 26_virtual_Page_Columns
=1 27_Borders

=1 28_InternetLink

=1 29_DateTime

=1 30_Square

ol

1]

1 35_Invitation_letter
= 36_Grant_application
=1 37_Saving_Plan

=1 38_Visa_Form

=1 42_Conversion

=1 43_Pivot_Table

= 44_Conditional_options
=1 45_Markers

=1 46_Scripts

=1 47_Business_trip_planne

>

Folder name: iC:\Program Filesh®SLFastixSLFast 5.0%input! Tutorial

Files of Type:

Al Files

Dirsctary... ||

Cancel |

4. Select the folder, which contains the source files.

5. Click “Directory...” button.

6. Check Search in subfolders checkbox to search the source file, in all the subfolders of

the selected folder (Here, Tutorial).

7. Click - button to display all the subfolders of the selected folder.
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Cambine pages and lagouts 2

e
@REA
|

Conbine pages.. . Avadable layouts: <rifx and Sehtop| TENFA Tuboniy
Fl Ci{Tocumants 303 Settngsinasgor Destop TOVP Tubonsila_Tabbe(Tabke. xof | | (001 _SeveaFteer gk bat <o B
) [ e 1) GH0L_Soleftyss /Scke e i st
W0t SerpleFper el tier vz oo .

G5 _FooknotesFoctnotes sl Previes not fourd
06 _TerpiateTevglate, xof

G0 Terglate/Tergiate . cof

S07_Mubdsyoutibyyout. xf

GR07 Mdiayout ol varrd Mot ool
oe_Moisyout_TevglsteMatbayout_Tenplate «s

W08 Mdiavout Terplatn_ckiiMabeyrd Yerglatn. ol

A0S Mtisyoutregons byt regons. et

07_Fedayout segens_okiMatieyout_regone s

| 2110 Exaracie MacuskExancle Maolcst =

] Search 1 subtoldess & | [ e |

8. Double-click the folders to view and add layouts.

Cambine pages and lagouts =

!Nems
P

|Imm.. Avadatie layouts: <i\Do and e top| TENF Tuboriy
| K CiiToauments 308 SettngsinamgonDeskton) TOVPTuborsi00_Tabbe(Table, xef | | (001 _SeveheFtyss i ot <o B
) (nan e 1) GA0L_Srplertyss SSockFhysr sl st
W01 _SergleFper fSreietvar 2 o |

G0 _CobswaCobarns xst Proview not found

A0S _Mianout_Tevplste_ckiMatisyodt_Tevplate.ast
qmmu JegenaMinag_regone. of
| S0 M regons oMAESOL regcns szt >

V] Search i sttoldess L‘_JEE)
i o ]

If you select the “[main]” page under Combines pages... header, the menu bar and the toolbar
are enabled.
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Menu Bar:

File Page
I File | Page Page I
&' Export layout i B Add page tothe end
k] Delete layout |
'_,,-A,L-._zf.-.,ut,%;.um._r‘.u-nk
@ Change page kind )]‘ Change kind to main
P e——— | Change kind to title
main.mair. 1
j Lot Change kind to tail
Change kind to First
Change kind to last
Change kind to rest
Change kind to position any
Change kind to only
Change kind to odd
Change kind to even
| Change kind to oddfeven any
Properties...
Toolbar:
Icon Description
]

Export layouts (as .xsf file)

Add selected page to the end of the list

5] &/

Change page kind

=
=1

Delete selected page from the list
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Combine Pages

The Combine pages... field on the left shows the pages and regions structure of your current
layout.

If the main page contains one or more regions, then this page is shown as parent node with its

regions as the child nodes. If there are several main pages, they are all on the same level of
the tree.

Combine pages...

..finputTutorial/09_Multilayout_regions/Multilayout_regions. xsf
=123 [main]
- e [odd]
: ‘g [even]
@ [tite]

Note: If there is text displayed after the title of the main page, this means that this page has

an expression to be checked before the generation of the PDF output:

(= 123.xsf

e[ [ritle]

@G

(23 [main] : contains(ProductGroupProductGroup/ProductGrouplD,'401010%
-3 [main] : starts-with{ProductGroup/ProductGroupProductGroupID, '4')
@ [main]

&3 [main]
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Import

To import a page/layout/region to the current layout:

Page:

1. Double-click the folder and select the page.

2. Drag and drop the page into Combine pages... header, or click - icon from the

toolbar, or select Page > Add page to the end menu.

Combine pages... Available layouts: [C:IProgram Files\XSLFast\XSLFast 4.0\input) Tutorial
o ) 01_SimpleFlyer/SimpleFlyer . xsf A
o ! <impleFlyer.main] ERE W raini]

g [main] ") 02_Pagination/Pagination.xsf
) 03_Table/Table.xsf
Layout:

1. Select all pages.

2. Drag and drop the page into Combine pages... header, or click [3 - icon from the

toolbar, or select Page - Add page to the end menu.

Combine pages...

Available layouts: IC:tProgram Files\%SLFastiXSLFast 4.0%input) Tutorial

2
@ [SimpleFlyer.main]

\_7) 06_Template/Template.xsf
) 07_Multilayout Multilayout. xsf
...... Y

7) 08_Multilayout_Template/Multilayout_Template.xsF

~

Regions:

1. Select the region.
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2. Drag and drop the page into Combine pages... header, or click [‘E - icon from the

toolbar, or select Page > Add page to the end menu.

I Combine pages...

Available layouts: !C:tProgram Files\%SLFastixSLFast 4.0\input1T|

‘ot [SimpleFlyer.main]

oot [Multilayout.main]

Y [Multilayout. tail]

““““ L W rultilayout_regions.odd]
Loogp [main]

[j 09_Multilayout_regions/Multilayout_regions.xsf ~
=) [main] i
. odd]

-4 [even]

o [title]

|) 10_Example_Manual/Example_Manual. xsF

Note: The changes you do in Combine pages and layouts window are reflected in the

worksheet only if you click.

Export

The Export option allows exporting the entire current layout or only the pages and/or regions

you need.

To export layout/page/region follows the steps below:

1. Select layout/page/region from Combine pages... or Available layouts columns.

2. Select File > Export layout menu or click ﬁj - Export icon from toolbar. The Save

window appears.
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Save

SaveIn: (1 03_Table

4

- AnEEmE

= | &3 cvs
— =1 XML
=3 XSL_FO

Files ‘ ] Table.xsl

MmRE

Defauit templates

File Name: | Table.xsl

|

Files of Type:  XSL (*.xsl)

3. Select the path and enter the file name.
4. Select file type as Layout files (*.xsf).

5. Click “Save” button.

Change Page Kind

A d

save || Cancel |

All added pages are placed as main page of the layout tree by default. They also lose the

status of a specific page or region, in the worksheet. In Combine pages and layouts window,

the title of the imported page or region the name of the file this element was imported from

and its original status in the parent file are visible.
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As you can see above, the element was imported from the file named “Multilayout”. In the
parent file, this element was a tail page. The Tail page is imported as Main page in the

worksheet.
You can change the page kind using Change page kind option.

1. Select the page, which you need to change.

2. Select Page > Change page kind menu and select the kind of page, or click >

Change page kind from toolbar.

Change kind to main
Change kind to title
(Change kind to tail

Change kind to First
Change kind to last
Change kind to rest
Change kind to position any

Change kind to odd
Change kind to even
Change kind to oddjeven any

3. Click and “Close” button.
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Example 7

Multilayout

| evdus () >

[Froaactitn) T Short) 1 sbirkco €

10ascLong]
s ratectumians)

Here, the Multilayout Tail page is changed to Title page.

.
R -

Change page kind is limited to the function range of the currently used Renderer. For example,

FOP does not support “last” pages.

The pages you combine appear on your working sheet as separate tabs and can now be

modified according to your requirements and saved as parts of a new layout.

Delete

Delete option deletes the page/layout/region from the current layout.

To delete page/layout/region, select Page - Delete layout menu, or click E - Delete icon

from toolbar.
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Settings

The Layout Settings windows allow you to do the following layout settings:

Input/Output Settings
e Generation Options
¢ Additional Templates
¢ Layout Description

e Security

Input/Output Settings

In Input area, under Input/Output settings tab, you see the XML file that you selected for your

layout. If you need to choose a different file, enter the complete path, or click E] button to

open a file browser window.

You can also edit the selected XML file using “Edit” button if you specified the path to a text

editor in Tools = Preferences = External tools = XSLFormatter Path.

The function Do not bind layout to top node allows to select the root node “/” in the layout.
This root node can be used as a general node to support the creation of layouts with different

XML files containing different root nodes. Refer Binding Layout to Top Node section for more

details.

In Output area, specify the type of output document.
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Dutput

Qutput typei Partable Document ~ [v] Open in viewer FO Processor:
Portable Document [— O FOP 0,20,5 (stable)
Output fle: Rich Text Format pout. pdf | | Tr- ] @) FOP 1,00
KSLFO e — X
¥SLT output! | ML Documant Diuilayout sl ||| view || e

#S5L-FO outpul: |Z: [Documents and Sottings/nasgor (Dasktop! TEMP/Tutarial/07 _Multilayout {251 _FOMultilayout, <slfo | |_\;Iow4| oAt orather

XSLfast offers you to generate documents in the PDF format, XSL-FO format, and so on, which
can be used with XSL-FO editing tools. If you activate the check box Open in Viewer, the result

file is automatically opened in the matching viewer after its generation.

Choose the FO processor (Renderer) with the radio button of the same name.

Note: The results from different rendering programs may look different, because not every

Renderer can process every function of XSL.

~FO Processor:-
() FOP 0,20.5 (stable)
(&) FOP 1.00
) XEP
() XSLFormatter

Specify the directory where the generated output file should be saved in Output file field. By

default, it is set to “../output”. But you can also select another directory. Use E] to
change the path. The browser window appears. Select the path. Enter file name, file type, and

click “Save” button.

Output file: l...finput,fTutorial,fO7_Mu!tilayout)’Multilayout.pdf “] v |
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XSLfast also creates a temporary XSLT output file every time, when the layout is processed.
This file contains the information to insert the data from the XML source and the preliminary

formatting structure. By default, this file is named as tmp.xsl and saved “in ..\tmp”. But you

can specify another name and directory for it. Use E] to change the path. You can also

view the XSLT file, using “View” button.

¥SLT output: |L..Iinput.fTutoriaI.t'0?_Mu!tiIayout!XSL_FOIMultilayout.st I[ ][ View ]

Specify the name and the target directory for the XSL-FO output. This file contains the
contents of the entire document, which are inserted from the XML source and the formatting
instructions. Open the file to read, in order to check the processes that have been performed
with a click on the “View” button. However, it cannot be edited here. Manual modifications of

this file are overwritten with every processing of the layout.

%5L-FO output: l..Iinput,fTutorial,fEl?_MuItilayout)’XSL_FO,fMultilayout.xsl.f‘o‘ | View I

Generation Option

This tab provides four options, which influence the output:

|Input10utput settings Generation options [Additional templates " Layout description ” Advanced options || Security l
Options

Suppress custom entity descriptions
Suppress custom namespaces

Do not generate system wide variables
Omit text formatting templates

The option Suppress custom entity descriptions is used to suppress the custom description of

XSL and XSL-FO file, in output file. The entity descriptions are not displayed in the output file.
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Suppress custom namespaces does the same with namespaces that you added. Both, custom

namespaces and custom entity descriptions perform in the similar way.

XSLfast offers two predefined variables: CurrentDate (which reads the system time) and
IMAGEEXT (which allows e.g. to use image names created by combining the productID with a
certain file extension like “.gif” to avoid time-consuming maintenance of image pools). If you
do not want to use these variables, in xsl code, check Do not generate system wide variables

checkbox that will suppress the use of these variables.

With the check box Omit text formatting templates, you suppress the use of the HTML tags for

text.

Additional Templates

The tab Additional templates allows you to edit templates used in this layout file, not matter
if they are external (other layout files) or internal and it allows you to edit internal variables.
External templates files are used during the processing of the layout and contain user defined
templates and global variables. Other than imported templates (via File 2 Import XSL
templates) they are not embedded into the layout but only linked. Nevertheless, can be edited
after clicking the “Edit” button and must be well-formed XML files containing XSL code. This
code is copied into and used in the generated XSL output but it is not checked for errors at that

time.
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Layout settings: version2 =

|Input10utput settings ||Generation options Additional templates Layout description " Advanced options || Security I
~External templates -

! | add

Edit

Remove

~Internal imports/includes -
! | addfie
Add URL

Edit
Delete

(&) Import
() Include

rInternal templates -

} Internal variables | Edit
i 2 .
| Internal templates | Edit
‘7 |_ese |

(o] o]

XSLfast offers you to use multiple external templates and multiple internal templates and

includes in your layouts.

You can add, edit or remove external templates. To add a template press the “Add” button in
the right area of the External templates section. Select the file you want to use as an external

template in the file dialog.

Note: Modifications you make in these external files are saved with the file.

The file you have chosen will appear in the left area of the External templates section. If you

add several external templates, they all will be shown in a list:
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-External templates
]E:!testfxslfastIdistﬂib}TempIates;‘ZofSi-svg.th add

[E:ftest/xsIFast{dist/libf Templates/2ofSi.tpl
E edt |

| Remove

If you want to remove or edit a template, select it in the list and click “Edit” or “Remove”.

Note: Only the contained templates from these files are used in the layout, not the entire file.

To use external templates in your layout place a Call template element on the sheet and

double click it. The Call template editor opens:

TemplateCall_1 - Call template B =

Call | Templates |

Template parameter{s)

| ok || cancel

In the Call template select box, you can choose one of the templates to be called:
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Templale,Call_J - Call,ten'gglate = B i

Example 7"

=

i

‘ :
L7V T oSS

Call | Templates i
Temai)sts@elit?mﬂitlg b‘ barcode-2of5i(value, string, print-text, addchecksum, module, wide-to-narrow, height, quict-horizontal, quict-vertical, Font-Family, Fort-height)
— convert-to-basic-units-2of5iflength)
convert-to-basic-units-3of9length)
draw-barcode-2of5Sifsequence, sting, print-text, module, wide-to-narrow, height, quict-horizontal, quict-vertical, Fort-Family, Font-height)
draw-barcode-30f9(sequence, string, print-text, module, wide-to-narrow, height, quict-horizontal, quict-vertical, Fornt-Family, Fort-height)
get-unit-scaling-factor-2of5i{unit)
get-unit-scaling-factor-3of9unit)
makeChecksum-2of5ifvalus, position, sum-odd, sum-even)
recursive-coder-2ofSifvalue)
recursive-draw-2of5i[sequence, narrow-real, wide-real, height-real, position)
recursive-draw-3of9(sequence, narrow-real, wideveal, height-real, position)

| 3 :
[E”Eﬂ

Note: In the select box of Call template element all templates used in the layout, both

external and internal will be displayed.

Through the Internal Import/Include function, it is possible to specify XSL files, which are then
used in the layout. Include is a reference to the entire external file, which is then imported at
runtime. An import is also a reference to an external file. You should use import rather than

include when you want to overwrite definitions (e.g. styles) inside your layout.

Press the “Edit” button and there will open Edit internal templates window:
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Edit internal imports/Zincludas £

Edit
Ll R ] - O[] Case sensitive [ ] Whole words only
Crxml version='1.0' esncoding='IS0-8859-1'7> - |

(=

Conveyrt XEL pFO (W 3 SR 00 d LO~45) LRI P )5

<IDOCTYPE mslistylesheet |
<IWHTITY anchox "<xel:apply-templates seleots' @id' xmlns:xels'http: ///yvww . wl

-

UL IR AU A NS B ST IPS ST rh RS e Tutom mamme ! alddomtorlmcat brdbhoanta! wmlowe:wel
4| L »

Columni 1, linel 1 |-Ol\ | |_cancel |
a2l (530500 |

To specify the XSL file you want to include, enter <xsl:include href="name.xsl"/>, or just
specify that file into Internal imports/includes. This will include the file with the name
“name.xsl”, which should be placed in the same folder as the current XSL file, but you can also

define the complete path to the XSL file that you want to include or import.

Note: The referenced files cannot be edited here.

The Internal variables function offers you to specify global variables for this layout, e.g. if
your XML images are located on another server and you need to specify the basic URL. After

the definition of the variables, it is possible to use them in your layout.

Example: You can call for a defined variable like this: <xsl:value-of select="Svar"/>

Note: You should specify the entire path if you want to use elements from the XML source in

the definition of variables.

To create templates that can be only applied in the current layout and cannot be reused in
other layouts, use the function internal templates. These can be called via XSL code

elements.
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Layout Description

The fourth tab Layout description offers you the option to add some Meta information to the

layout:

Layout settings: version2

InputfOutput settings "Generation options "Additional templates Layout description

XS

Advanced options " Security I

Title: Multilayout

|

Author: inasgor

|

Description:  Multilayout example.

|_ok || cancel |

The field Author is filled with your user name in Windows, but you can also edit this field.

This Meta information is saved with the layout file but is not contained in the output in any

way.
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Security

The last tab contains information on access rights for the layout:

Layout settings: version2

2

| InputjOutput settings
-Exlusive access-

" Generation options

[T Enable password protection
Old password ko exclusive access:
Password to exclusive access:

Re-type password to exclusive access:

Modification access

" Additional templates " Layout description

" Advanced options | Security

["] Enable password protection
Old password for madification:
Password For modification:

Re-type password For modification:

Reset

ok J[ cancel |

You have two possibilities to restrict the access to a layout. The first way is the Exclusive

access. If you use this option, a password is required to open the layout in the first place, but

then full access to the layout is granted to those users who have the password.

On the next start of this layout, the user will be asked to enter the password if you select to

use Exclusive access:
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/ .

‘."'

ps ” L
v

rassword

Password
Type password:

|
[ ik J[ Canicel J

The second way is the Modification access. This option allows you to restrict the access to the

layout in two ways:

x

Password
Type password, of skip password to kake read only access:

Read only J[ k. J[ Zancel J

If the user does not have the correct password, the access to the layout is Read only, meaning
that the user can view the layout, make some modifications, which last only during this session
and even generate PDF or XSL output, but he cannot save the modified layout. In this case, the
user should click the button “Read only”. If the user possesses the correct password, he has

access to all available functions after clicking the button “Ok”.
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Elements

The Insert menu and the tools enable the user to insert elements on the worksheet and create

a layout. Using elements, you can graphically represent the layout or format of a document.

The functionality of each element is explained in the below sections.

Text

The Text element is used to enter text. It can be a character, word, line, or paragraph. XSLfast

allows you to enter two types of text:
e Static text
¢ Dynamic text

You can also enter both types of text in a single text element.

Insert Text Frame

To insert text frame/element on worksheet, select Insert & Text menu, or click Aa - Text
icon form the toolbar. Click on worksheet and drag the cursor point. The text element is

inserted.

Tempty) E:
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The frame displays “(empty)” if it does not contain any content. Inside the frame, you can

enter static or dynamic text.

Edit Text Frame

To edit the text frame, double-click on the text frame or click Edit... option from the Inspector

window. The Text editor window appears.

ToxtFlow 1 -1 " . =
£t Vew Jeat  Fomst  Recent XPathe

PXEL®  uom > s >z~ BIUNKE EESR 28 .
“ Report A TestFiow 1 - tods Set
» PFrodxtiyoun Sty
Booksan
Nt
DateyfTime
‘ Math
Today
‘ Tenplytes
Marhess.
L Inseet fromtres
chw..,
\l‘h‘vulbﬂ
*
MY Peogerty Condticn ¥ B * i8S
ol 1, b £ on) | conet ]|
Static Text

The text, which the user enters in text editor, is called static text. Enter text and click “OK”.

The text is displayed in the frame on your sheet:
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This is my static text

s

Dynamic Text

The text, which is dragged and dropped from the XML tree structure, is called dynamic text.
The actual data is displayed in the output file. The worksheet displays the path of the text, as

shown below:

kProductgroup!ProducUDescript

l ion}

=4

As

The output file displays the content that the XML tag Productgroup/Product/Name contains:

- <Report>
- <Productgroupz
<Namex=Productgroup 1</Name:>
«Img>prod101051.gif</Img>
- «Product>
<MName=Product A</Name>

XML Content

Productgroup/ProductiName}

L10 ?‘

- [FroductA]

XSLfast Worksheet

Output File
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Menu and Toolbar

The Text editor window contains the Menu and Toolbar specific to text.

Menu Bar
Edit View Insert Format
Edit | View Insert For | Yiew | Insert Format RecentxF Insert | Fomat RecentiPath Fomat | RecentXPaths [
™ Undo ctl-z | ® zoomin  ctinumPad || B z:m:l st 2 Foet,
G ) 1y XPal | 1
x cut Chikk | 2, Zoomout  Ctd-NumPad- T : s { o Color...
Copy ShiE |, Resst zoom ctikNumPad” ‘ [ citation M Background color...
: L) Date/Ti i
I Paste Ctilv | G ceiTine Align >
| 12 Numeric field Eont N
8 remove ) Index A 1
1 one size
[ Selectal  ctoa I@Intemet lnk
q | 11 Choose Font style »
Find... Ctrl-F
= Insert 2
& Replace... ctiR Convert to... »
Add conditional attribute  »
Properties...
Toolbar
Tool Functionality
[ 5] Undo
Q] Redo
3( Cut
Copy
E Paste
% Delete

|cUstom [vJ Text Styles
iAriaI lj Font

11 v pt Font Size
B Bold
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Italics

Underline

Left

Center

Right

Justify

L =

Text Color

You can use either menu or toolbar to format the text.

To enter static or dynamic text use text editor field.

Toxtflow 1 - Toxt -
Bt Vew et Fomat  Recent Psthe

AXEL® <uzem

w ! A

iz - BIUNY ESSE BN

4 Report,

4 Produxtgonp

Narrn
P

# Produck

Nare
Dsicrption
I

Data

“

TentFiow 1

{ProduttougiProcucty

Hode Set
Srew
Booksan
Runbee
DatefTime
Math
Today

Tenplytes

=

L Tnseet from trem
. Corwert to
\ Properties

Apply styles from the text style drop-down. The text style drop-down consists of in-built system

styles. You can apply these available styles or create your own text styles. To create your own

text styles, refer Create Text Style section. To apply style to the text, select the text and

select any styles from Text Style drop-down.
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Custom m
~

Emphasis
Footer
Header

Heading 1
Heading 2
Heading 3

Heading 4
MNormal v

11}

To change the font, font size, and font style, use Font drop-down, Font size drop-down, and

Font styles.

Arial Bold Italic

Arial Italic

Arial Narrow

Arial Marrow Bold

Arial Marrow Bold Italic v

Font Drop-down

11 Iv
T~
12 '
14

16 -
18

20 =
22

24 v

Font Size Drop-down

(b)(7][v]

Font Styles

To change the alignment of text use alighment buttons.

To change the text color, select
click “OK” button.

. The Text color window appears. Select the color and
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Text color

b

2]

[

Hp |
Transparent o 5 FO—— o,
CMYK: 0| 0] 0] 100 o
o,
Red B lo—l %
CMYK: 0| 100 | 100 | 0 —_—
R g ]
Green e
CMYK: 100 | 0] 100 | 0 Glo |
Blue B {ra _]
CMYK: 100 | 100 |0 | O
Black G 1[65 %
CMYK: 65 | 53| 51 | 100 M(e3 %
white ¥ 5
cMvk:0|o(a]o LI
K 100 %
# ffo00000 |
-
oK [ cancel |
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Insert Symbol

You can also insert symbols in text frame, using Symbol option under Insert menu. Click Insert

- Symbol or press Ctri+insert. The Symbol window appears.

Symbol. .. 52
Fonts | Tehoma '~ Character cads (Unicode): C‘
Wlhlathematical | currency | Greece | -

I " #$ %& ! €D * | = / lé
01 2 3 4 5 6 7 8 9 Pl = R
@A B CDEFGHTI J KL MN O
P QRS TUV WX Y ZI[NTWK®
“a b cdef ghi j kIl mn o
p g r s t u v w x z L || i |~
i ¢ £ = ¥ | 8§ © a « - - ®  °
= S A A T | Lt 0y e 3o A
]AﬁﬁAﬁEgEE’EE‘II‘TID
NOBOBOx@BUUUOUY PB &l

The Symbol window consists of Mathematical, Currency, and Greece symbols. Select the

symbol and click “Insert” button, else, click “Cancel” button.

The Font drop-down changes the font style of symbols. The Character code (Unicode) field

displays the character code of the selected symbol.
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Functions

The functions in XSLfast provide a facility to operate on a part of content, not with the

complete content. It enables to modify or enhance elements, which have been inserted into

your text.

For example, if you need to operate not with full string but, with its length. You can use these

functions, instead of typing.

Drag and drop the XML content and click String = number string length () function. The

output file displays the string length of the content, available in selected node.

To use the functions, drag and drop an XML node and click any of the functions.

XSLfast contains the following functions:

Node Set:

number last()

number position{)
number count{node-set)
node-set id{object)

skring name{node-set?)

string local-name{node-set?)
skring namespace-uri{node-set?)

Function

Description

number last()

The last function returns a number equal to the context size from the
expression evaluation context.

number position()

Returns the position, or index number, of the node, relative to all the
selected nodes in the node list.

number count(node-
set)

Returns the number of nodes in the node-set argument.

node-set id(object)

Selects elements by their unique ID.
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-

string local-
name(node-set?)

Selects elements by their unique ID.

string namespace-
uri(node-set?)

Returns the namespace Uniform Resource Identifier (URI) of the expanded
name of the node in the node-set argument that is first in document order.

string name(node-
set?)

Returns a string containing a QName representing the expanded name
of the node in the node-set argument that is first in document order.

String:

String

skring string(object?)

string concat(string, string, string™)
boolean starts-withistring, string)

boolean contains(string, string)

string substring-before(string, string)
string substring-after{string, string)

string substring(string, number, number?)
number string-length(string?)

sting normalize-space(sting?)

skring translate(string, string, string)
node-set strreplace(string, object, object)

Functions

Description

string string(object?)

Converts an object to a string.

string concat(string,
string. string*)

Returns the concatenation of the arguments.

boolean starts-
with(string, string)

Returns true if the first argument string starts with the second argument
string; otherwise returns false.

string substring-
before(string, string)

Returns the substring of the first argument string that precedes the first
occurrence of the second argument string in the first argument string, or
the empty string if the first argument string does not contain the second
argument string.

string substring-
after(string, string)

Returns the substring of the first argument string that follows the first
occurrence of the second argument string in the first argument string, or
the empty string if the first argument string does not contain the second
argument string.

string substring(string,
number, number?)

Returns the substring of the first argument starting at the position
specified in the second argument and the length specified in the third
argument.

number string-

Returns the number of characters in the string.
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length(string?)

string normalize-
space(string?)

Returns the argument string with the white space stripped.

string translate(string,
string, string)

Returns the first argument string with occurrences of characters in the
second argument string replaced by the character at the corresponding
position in the third argument string.

node-set
str:replace(string,
object, object)

Replaces any occurrences of search strings within a string. With
replacement nodes to create a node set.

Boolean:

boolean boolean(object)
boolean not{boolean)
boolean truel)

boolean false()

boolean lang(string)

Functions

Description

boolean boolean(object)

Converts the argument to a Boolean.

boolean not(boolean)

Returns true if the argument is false; otherwise false.

boolean true()

Returns true.

boolean false()

Returns false.

boolean lang(string)

Returns true if the xml:lang attribute of the context node is the same
as a sublanguage of the language specified by the argument string.

Number:

number number{object?)
number suminode-sat)
number lloor{number)
number ceiling{rumber)
number round{number)
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Functions Description

number

number(object?) Converts the argument to a number.

number sum(node- Returns the sum of all nodes in the node-set. Each node is first converted to
set) a number value before summing.

number Returns the largest integer that is not greater than the argument.
floor(number)

number

cs Returns the smallest integer that is not less than the argument.
ceiling(number)

number

Returns an integer closest in value to the argument.
round(number)

Date/Time

skring date-timef()

number year(sting?)

boolean leap-year(string?)

number month-in-year(shing?)
number week-in-year(string?)
number day-in-month(string?)
number day-in-year|string?)
number day-of-week-in-month|string?}
number day-in-week(string?)
number minute-in-hour(string?)
number second-in-minute(string?)
skving add(stving, string)

skiing add-duration|string, string)
string difference(stiing, sting)

string duration(number?)
Functions Description
string date-time() Generates current date and time.
number year (string?) Extracts year from string.
boolean leap-year(string?) Indicates if year is leap.
number month-in-year(string?) Returns the month of a date as number.
number week-in-year(string?) Returns the week of the year in number.
number day-in-month(string?) Returns the day of the date in number.
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number day-in-year(string?) Returns the day of the date in a year as a number.

number day-of-week-in- Returns the day-of-the week in a month of a date as a number
month(string?) (e.g. 3 for 3rd Tuesday in May).
number day-in-week(string?) Returns the day of week, given in date as a number.

number minute-in-hour(string?) Returns the minute of the hour as a number.

number second-in-

. . Returns the second of the minute as a number.
minute(string?)

string add(string, string) Returns the date/time resulting from adding two durations

together.
string add-duration(string, Returns the duration resulting from adding two durations
string) together.
string difference(string, string) Returns the duration between the first and second date.

Returns a duration string representing the number of seconds,

. . ,
string duration(number?) specified by the argument string.

Math:

number max(node-sat)

number minfnode-set)

number power(number, number)
number sqrtfnumber)

Functions Description

Returns the maximum value of the nodes passed as the

number max(node-set) argument

number min(node-set) Returns the minimum value of the nodes passed as the argument.

number power(number,

Returns the value of base expression taken to a specified power.
number)

number sqrt(number) Returns the square root of a number.
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Today:

Today
Mow

Yesterday

Tomorrow

Note: For these functions, you require XSLT skills. Refer http://www.w3.org/TR/xslt or

http://msdn.microsoft.com/en-us/library/ms256138(VS.85).aspx for more information.

Recent XPath

The Recent XPath option displays all the recently used and created XPath expressions. Recent

XPath helps you to reuse the existing XPaths’, instead of typing it again.

J

Recent XPaths | Il

l

Click Recent XPath option and select the XPaths’. The selected XPath is displayed in Text
Editor field.

Toxtk = T - =

Bk View [reert Fomst | Recerk WPaths |
PXPE® coom R T v 2 v BUNY EEAR BN
# Report I Repon - Node Sat
4 Productgroun Yy
Nasie Soolom
g ity
# Product Odtaltire
Nine Mot
Destrption Todey
g Teogiuine
Dats
Marhers
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Inserting Other Elements in Text Field

The text element also offers more possibilities to insert dynamic elements. On the right side of

the text editor window, there are other element icons:

Qﬁ Convert to... | [ Barcode
Citation
\ Foperties L:LJ Date/Time

| 12 Mumeric field
[:jIndex

‘ @ Internet link
1% Choose

m

Text is a composite element. It contains both:

e Static texts

¢ Dynamic text originating from XML (XSD, DTD).

For example:

First Name: {/Report/Order/FirstName}

Last Name: {/Report/Order/LastName}

Address: {/Report/Order/Addressl} {/Report/Order/Address2}

Email: {/Report/Order/Email}
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The example, above contains both static (arranged towards left) and dynamic text (placed in
flower brackets). While placing dynamic text, you may need to format the dynamic text as
links, date, number, and so on. These dynamic elements are used to place dynamic text with

different formats.

The available dynamic elements in text editor window are:

e Barcode

e Date/Time

e |ndex
e Choose
e (Citation

¢ Numeric Field

e Internet Link

Conversion of Text Element

You can convert the text element into other elements like barcode, numeric field, and so on.
E&

To convert, click - Convert icon, available on the right side of text editor window, else,

select Convert option in Context menu.

The available conversions available for text are:

¢ Numeric Field

e XSL Code
e Barcode
e Image

151 |Page



e Internet Link

e Date/Time

e |ndex

e (Citation

You can change the properties of the converted field using

Properties window appears.

Create Text Style

You can create your own text styles, using style editor window.
To create a text style, follow the steps below:

1. Click Edit - Styles. The Logical styles editor window appears.

2. Click “New Text” button. The Text logical style editor window appears.

3. Enter a unique name in Style name field.

- Properties Icon. The

Note: Do not enter an existing style name.

4. Select parent style from Parent style drop-down, if required.

5. Select Font style and size from the drop-down menu.

6. Click “Ok” button to create text style, else, click “Cancel” button.
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Text logical style editor

ﬁ

Settings | Advanced

-Style properties -XSL-FO options
Stvle fiame I [ ["] Normalize spaces inside XML
[] Disable output escaping
Parent style Mo Style v Collapse:spaces
~-Formatting
Arial v’lZ.U'HB 1 u | 4 W
-Preview

Selected style

| Ok ” Cancel J

You can also change the text format by using formatting tools.

[b

‘u

J1

u
A

Bold Underline

ltalics
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To change the text color, use

To change the background color, use

- Text Color icon.

- Background Color icon.

Select any of the XSL-FO options, if required.

You can change the frame properties of the text element, which uses the style created by the

user.

To set the frame properties, click Advanced tab and make changes.

The created text style is now available in Text Editor window and also under Logical Style in

Inspector window.

b ven vom foma ceetra | —

AXE D8

v A

v v BlUNY EExas gn

# Publication
LaryOurTypd
Publcabiony
Description
Publcabory

Heading 1
2

Heading3
Heading 4

feode Set
Stng
Bockoan
Peurber
Date/Tine
Math
Today

Normal -

Mabers

Conditional Styles

This property allows to display text depending on conditions.
Follow the below steps to apply conditional styles:
1. Select the text, in text editor field and right-click.
2. Select Add conditional attribute option.

3. Set the condition property using Font family, Font size, Font style, or Text color

option.
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4. Double-click the Condition column to set the condition. The If Editor screen appears.
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» ProductGroup

R 4

Xsl If Editor B =
XML skructure ¥Path expression

4:pablicabion FublicationLanguageID I I ] Itx:ue | flcle St
LayoutType - String
PublicationID - Boolean
Description MNumber
PublicationCurrencyID Date/Time
PublicationLanguagelD Math
CreatedBy Today
CreationDate Templates
CreationTime
ChangedBy
ChangeDate
ChangeTime

» Text

Clear

J | Evaluate J

With this dialog you can specify conditions under which the contents of the current element will be displayed. Example: If
the current element should only be displayed if one of the contained ProductGroupIDs equals 123, the expression should
look like this: 'ProductGroupID=123", Attention: The grouping node of the current element is very important for the
correct evaluation of the condition. It is possible to specify more than one condition which can be linked either with an

'AND' or an 'OR’",
The result of XPath expression.

ENPY |

Lok

5. Set the condition and click “Ok” button. The condition is displayed in Text Editor

window.
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6. Click “Ok” button and process the layout to view the result.

Result:

roductgroup 1

Ehls is my static text

his is my static text
Productgroup 2

This is my static text
{(Productgroup 3

This is my static text
|Productgroup 4

| Mode Set

g
Soanan
Nurber
Date/Tine
Math
Yodxy
Tenglsrs

;L;Oeus. '

|_gJ Vrsert from trwe

O Convert ..
e e

*
- 3 3

157|Page



Inspector Window

k Aa cTextFlow_4 -
Property | Value |
M ObjecAt_nAc;.rr»r;éru chextFIowv_“; . '
Locked O
a Text Edit...
Background color

Line height 14 pt
Line-stacking-strat... | Select line-stacki... \
Logical style | Select style v
Last line alignment | Auto v

4 Frame properties
4 Bounds
Absolute position
» Paddings
Border
Horizontal alignment
Vertical alignment
Level
Span
4 X5SL-FO options
» Generate ¥SL-FO c...
» Generate XSL-FO ...
Letter spacing
‘Word spacing
HTML markup cony...
Wrap text
Collapse spaces
Linefeed-treatment
Whitespace-treat. ..
Normalize spacesi...
Disable output esc. .,
Suppress if empty
Generate template
Page break inside
Page break after
Space before
Space after
Break before
Break after
If
ForEach

[Absolute position: fal...
OJ

[Left padding: 0.0 pt; ...
Border...

| Left - |
[ Top_ ¥
10

| none v

0pt
0pt
O
O
(]

| preserve v

| ignore-if-surroun... ¥
O

(|

O

(|

[ Auto 4
[ Auto v
0 pt

0pt

| Auto - |
| Auto v |
PublicationLanguagel...

The properties of text element are displayed in the inspector window. They are grouped into

groups belonging together. Use B button to expand the properties or use

=]
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Object Name

Object name displays the name of the element. XSLfast automatically displays the element

name. Double-click the object name to edit.

[ hject name [Texk Element| |

The name available in the object name is listed in the List box drop-down.

Text Element R

Locked

Locked option makes the element as read-only element, if the option is checked. You cannot
perform any actions on the element. The Context menu options of the locked element are

disabled and the tool does not allow to open the editor window.
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[Data I Format &

I Aa TextFlow_1
Property | Walue |
Object name TextFlow_1
Locked
& Text Edit...
Background color
Line height 0pt
Ling-stacking-str... | max-height v

Logical style Select style hd

Last line alignment Auto v

4 Frame properties

4 Bounds [Absolute position: t... g
4 Absolute pos.., B Bring forward
Left 104 pt Send backward
Top 120 pt 18,2 ¥ Undo: locked true Ctrl-Z
width 217 pt ~ Applicable XML nodes bl
Height 132 pt : )(EQE ' chix
4 Paddings [Left padding: 0.0 p... | B copy Crl-C ‘
Left pad... Opt E. | I Paste ctv |
Toppad... Opt 1 | Copyastext !
Right pa... 0pt | Fonit Family »
Bottom .., Opt ‘ Forit size » |
Orientation (o +] Font style A
Border Border... alignment 14 "
Hotizontal alignm.., | Left v ‘ertical alignment by
Vertical glignment Top - :rext color 4
Lewel 11 Background color |
Span none v Move texts to one :
4 X5L-FO options \ ‘_-’;p!it texts
a Generate ¥5L-F.., Fit to content
Customn attri,,, | Generate template
Custom attri... ‘ i /| o Locked R
4 Gererate ¥5L-F.., ‘ R A AR AR AR AR R R AR SR
Keep together | auto - 5::.,,...H..H..H..,::::::::::::: ..............

Text

Text option allows editing the text element, setting background color, setting the line height,

and applying style to the element.

Edit
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The Edit... option opens the Text Editor window. You can enter or modify the content in text

element, using Edit... option. Refer Edit Text Frame section for more details.

Background Color

The Background color option allows the user to set a background color of the element.

Choose the background color you want to assign to your text element. You can also enter color

values on the tabs HSB, RGB and CMYK.

Static color I Colors by condition

&)

Transparent
CMYK: 0| 0| 0| 100

-

Red
CMYK: 0| 100 | 100 | O

Green
CMYK: 100 |0 | 100 |0

Blue
CMYK: 100 | 100 | 0|0

Black
CMYK: 65| 53| 51| 100

White
CMYK:0 0|00

Background color

[]]

# FEFFFFFE |

ok | [ cancel |
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Note: The values you enter may differ from the color displayed on the sheet.

The function Make transparent allows you to give the text element a transparent background.
This is helpful if you want to place the text element in a table, which has a background image,
or a background color or if the work sheet has a background image on it. Click “OK” to apply

the color or click “Cancel”. You can set the color back to default, using “Reset” button.

Expand to right

If the text element is in a table, use Expand to right option available in the inspector window.
This option is used to indicate that the content of a text frame in a table cell may exceed what

it shows.

Note: This option is available, only if you insert text element in a table.

gt

Currently you can only see a small part of the string inside the text frame. Using Expand to

right, XSLfast indicates that there is more text without the need to resize the cell:

A B .........
Productgroupima}y -

R

Line height
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Set the line height for your text using Line height option. Usually, the line height should be 20-
25% bigger than the font size.

Note: Currently this value is only considered for the space between text lines, not text lines

and element border.

Logical style

Logical style allows to apply the in-built or user created styles to the text frame. The Logical
style drop-down lists all the available styles. Select any of the styles. The style is applied to

the text frame. Refer Edit Text Frame section for more details.

Frame Properties

In the group Frame properties, the command Bounds shows the current element settings for

that group.

Absolute Placement

Check Absolute placement option to fix the position of a text frame. In this mode, the frame
will appear in this position. Uncheck the option to align the frame to the next available empty

top left position.

Note: The appearance of a fixed frame depends to a certain degree on the other elements on
the sheet. If a fixed frame is placed below a table with dynamic contents, the frame will

appear below the table after it is finished (which may even take many pages).

When the frame is placed absolute, you can also determine the frame coordinates by entering
values in the fields Left and Top. Enter the distance between the frame and the left rim of the
sheet and between the frame and the top rim of the sheet. The coordinates will also show the

change of values if you drag the element with the mouse.

If the frame is placed absolute, you can re-size the frame either by pulling it into the desired

size with the mouse or by entering values into the fields Width and Height.
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Note: The absolute placement is available, only if you have fo:block/fo:container options

turned ON.

Paddings

Padding left, Padding right, Padding top, and Padding bottom controls the distance between

content and frame. Enter the desired values.

Border

Specifies the color, width, and style of the text frame border. You can set three different

styles of border like: Dashed, Dotted, and Solid. Set different width and color

of all the borders

in the frame. All these are achieved using Left, Right, Top, and Bottom borders.

To set the border of a text frame:

Select the text frame and click Border function. The Borders window appears

required checkbox and click “Ok“.

Borders
Borders

["] Border Border width 1.0 pt Border color - Border style  Sold =
[] Left border Left border width 1.0 pt Border color - Borderstyle  Soid  w
[]Right border  Right border width 1.0 pt Border color - Border style  Solid  w
[] Top border Top border width 1.0 pt Border color - Border style Salid i

[[]Bottom border  Bottom border width 1.0 pt Border color - Border style  Solid  w

. Check the

‘ Ok | Cancel

If you uncheck the Border checkbox, all other checkboxes are enabled. This way, you can

change all the borders of a text frame at once.

Horizontal alignment
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The Horizontal Alignment option determines the alignment of the frame content. You can

align the content to Left, Center, Right, or Justified.

Span

You will only need the command Span if you work with several columns on your sheet. It makes
a frame span all columns if you select "all” from the drop-down or just one column if you select

"none".

XSL-FO Options

Generate XSL-FO block and Generate XSL-FO container

This is XSL-FO specific and controls the creation of blocks and block containers for the frame.
In short, the FO-Block-Container is required to apply padding to its contents (padding can only
be set between a block and a container or a container and a container, not between a block
and another block or between a block and plain text). A FO-Block Container can also contain
more than one FO-Element. You can create custom attribute names and their values for each,
XSL-FO containers and XSL-FO blocks, if you need to use XSL-FO attributes, which XSLfast does

not provide currently.
Link Id

The Link Id option allows you to specify some identifier for an object from an Internet Link

element.

For example:
1. Insert a text frame and edit the frame (say AAA).
2. Apply link id to the frame, or enter a new link id in Link Id option (say linkAAA).
3. Insert an Internet link element and edit the frame (say ‘Go to AAA!’).

4. Select “Document Link” as destination type, in Inspector window.
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5. Select the same link id from Enter or choose link drop-down.
6. Click “Ok” button.

Now, in the output file, when you click on the internet link (Go to AAA), the cursor points to
the frame, which has the link id (AAA).

HTML markup conversion

HTML markup conversion allows converting some basic HTML markup in the object's text like

<b> for bold, <br/> for page break. By enabling this option use html tags for text formatting.

Collapse spaces

The command Collapse space will remove all blanks (spaces) in texts, which are not in the
correct place (e.g. between word and dot: “output .”, will return “output.”). All remaining
runs of two or more consecutive spaces are replaced by a single space, and then any remaining

space immediately adjacent to a remaining linefeed is discarded.

Linefeed-treatment

Linefeed-treatment property allows manipulating new line symbols.
For example:

There are many empty lines between two sentences:

et Ted Text Tedd

Text Text Text Text

L10 ?‘
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Set Linefeed-treatment value as “preserve”.

Text Text Text Text

Text Text Text Text

Set Linefeed-treatment value as “ignore”

Text Text Text Text
Text Text Text Text

Whitespace- treatment

Whitespace-treatment property allows manipulating white spaces.

There are many whitespaces between the words.
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10

ext Text Text Text Text Text

Set Whitespace-treatment value as “preserve”.

ext Tesct Text  Text Text  Text

Set Whitespace-treatment value as “ignore”.

et TexdTextTexd Text Tesdt

Normalize spaces inside XML

Normalize space is used for dynamic data from the XML file, which contains two or more

blanks in places.

168 |Page



Disable output escaping

XSL works with an array of special characters like & or <>. If you would like to use these
characters in your text frames, activate the check box Disable output escaping. Now all

characters are actually shown as letters, not as code in your text frame.

Suppress if empty

If the text object is empty, then this element is not shown in the output file, if Suppress if

empty option is checked.

Generate Template

It is possible to turn a frame into a template that can be used in conditional cases controlled by
XSL code. Check Generate Template checkbox to declare the element as a template. XSLfast
generates a name to the template, but you can also name the template. You can also specify

template parameters, which can be helpful when calling that template.
If

XSLfast offers an “if editor” which allows you to design conditions for a selected element.
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Xsl If Editor = 5=

WML structure XPath expression

4 Report Node Set
¥ Productgroup | | ] I String

- Boolean

Number

Date/Time

IMath

Today

Templates

v Clear || Evaluate ]

Wwith this dialog you can specify conditions under which the contents of the current element will be displayed. Example: If
the current element should only be displayed if one of the contained ProductGroupIDs equals 123, the expression should
look like this: 'ProductGroupID=123'", Attention: The grouping node of the current element is very important for the
correct evaluation of the condition, It is possible to specify more than one condition which can be linked either with an
'AND' or an 'OR"

The result of XPath expression.

&=

JESSR S

I Ok | Cancel

You can apply specific conditions on all possible elements and table rows, meaning that those

elements can be connected with conditions controlling whether they are displayed or not.

On the left side there is the familiar XML tree where you select a node if that is necessary for
your condition. As you create an if condition explicitly for the element you selected on the
sheet first, you can also formulate conditions, which do not involve a certain node from the
XML tree.

On the left side you have your XML tree. On the right side, there is a window for setting in

condition.

There are basic XSL functions available in four menus in the right top corner of the editor -

Node Set, String, Boolean, and Number, but should have some XPath and XSL skills to use
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them. They are active if the cursor is in one if the entry fields and they contain the most

commonly used functions, which can be used by clicking them.

Your condition can consist of one or two parts. You can use the following operators in the

conditions:
=0 =0 =0 =0 =0
=0 | = = = *
= =

Example: Use the Example.xml from the tutorial 10_Example_Manual. Keep the page grouped

to Report and open a table with one row and three columns. Group the table to

ProductGroup/Product:

[Report

~IName}

et

FProductNurnber }

The processed layout looks like this:
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g8 demo-1.pdf

Chairs
Chairs
Chairs
Chairs
Chairs
Chairs
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables

B seten f Evenen f Unterschitten

TR R T
N - o

Chair A
Chair B
Chair C
Chair D
Chair E

Chair F

Table A
Table B
Table C
Table D
Table E
Table F
Table G
Table H
Table |

Table J
Table K
Table L

Let us assume you want all products with product numbers smaller than 4 to be hidden. You

have to create a condition for the XML element containing the product name. Select that

element and click the function If, in the inspector window.

As the condition depends on the product number, you need to drag that node into the first

entry field. You can also enter the name manually but make sure to consider all cases.

The condition is: display the product name only if the product number is bigger than 3. Select

the “>” operator from the middle box and enter 3 into the right field:
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m

XsLIf Editor I

WML structure

XPath expression

4 Report
¥ Productgroup

] |3 | MNode Set
- String

- Boolean
Number
Date/Time
Math
Today
Templates

Productgroup l I -3

v | Cear || Evaluate |

With this dialog you can specify conditions under which the contents of the current element will be displayed. Example: If
the current element should only be displayed if one of the contained ProductGroupIDs equals 123, the expression should
look like this: 'ProductGroupID=123", Attention: The grouping node of the current element is very important for the
correct evaluation of the condition. It is possible to specify more than one condition which can be linked either with an
'AND' or an 'OR',

The result of XPath expression.

MY B

Click “Ok” to apply the condition.

The resulting PDF looks like this now:
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The product name is only displayed for products with product number bigger than 3.

If you like, you can also hide the product numbers for the hidden products. Simply apply the

same if condition to the XML element containing the product number.

This will be the result:
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Chairs
Chairs
Chairs
Chairs
Chairs
Chairs
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables
Tables

w

11
12

Chair D
Chair E
Chair F

Table D
Table E
Table F

‘Table G

Table H
Table |

Table J
Table K
Table L

In this style, you can also suppress the display of the ProductGroup for the suppressed

products. If a row shows no entries any more due to the conditions, it is suppressed entirely:

B Uterschriften q Lesezeichen

Chairs 4 Chair D
Chairs 5 Chair E
Chairs 6 Chair F
Tables 4 Table D
Tables 5 Table E
Tables 6 Table F
Tables 7 Table G
Tables 8 Table H
Tables 9 Table |

Tables 10 Table J
Tables 11 Table K
Tables 12 Table L

It is possible to create several conditions which can be combined by “AND” (meaning that all

conditions have to be true) or “OR” (which means that one or the other condition has to be

true).
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Conditions you have entered before entered can be reselected in the select box below the
conditions. The number of entries available there can be specified with the function Tools -

Preferences 2 View options 2 Length of history for XPath expressions.
All entries can be removed from the select box with the button “Clear history”.
More examples:

You need to generate data only if the number of the specific elements is 5. This condition will
look like this:

Xsl If Editor =1 2

WML structure %Path expression
Pl
Report Productgroup/Ing I I -3 ] IZ Node;Set
4 Productgroup String
MName AND - Boolean

You can enter several conditions to one element generation. They can be listed with the
AND/OR statements:

Xsl If Editor = =
WML structure %Path expression
4
Report IProductgroup/Img l I > ] IZ ] Node;Set
4 Productgroup String
IName AND - Boolean
mg MNumber
4 Product IPx:oductgroup/Product/Mame l I > ] ISU l Date/Tie
game' i OR il
A d
: escription Today
g lPx:oductgraup/Product,/Data l | = l Itrue ] Templates
Data
AND -

For your convenience, it is possible to choose one of the recently created conditions by
choosing them in the select box at the bottom of the XPath expression field. It is also easy to

clear XPath expression fields just by pressing the Clear button.
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By pressing the Evaluate button, you can see the result of the XPath expression you have
entered above.

For Each

The function For Each can be used to address each element in a selection. This allows you to

process all data contained in the selection.

TextFlow_1 - XML node

Edit Recent ¥Paths

»XBE
4 Report g Node Set
» Productgroup String
Boolean
Number
Date/Time
Math
Today
Templates
*
vl Qy ] a @ $ L3
Column: 1, line: 1 I Ok I Cancel

Example: You want to display the ProductGroup ID and the ProductGroup name in a text

element as many times as there are products in the XML source and you do not want to use a

table for it:

Use the Example.xml file from the tutorial 10_Example_Manual. Create a text element and

drag the nodes ProductGroup/ProductGrouplD and ProductGroup/Name into it:
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A0 E 1—
1ProductGroup!Pr0ductGroupID} {ProductGroup/Name} !

H H
] ]

If you generate a layout now, it will only show the first product group and its name:

pl demo-1.pdf

100 Chairs

Lesezeichen \_|

.

Activate the For each property and select the node ProductGroup/Product. A generated layout
will now be empty because you need to specify the correct path. As the For each property
(that we set to ProductGroup/Product) means that this is our current position in the XML tree,
you need to move one step up to address the nodes ProductGroup/ProductGrouplD and

ProductGroup/Name located in the parent node ProductGroup.

To move up in the XML tree, you need to replace the node ProductGroup with two dots, like
this: “../ProductGroupID” and “../Name”.

10 ; b [ 2
Z

JProductGrouplD}{../Name}

The generated output will now show this:
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Urterschriften

El;}enen"*"_'

gl demo-1.pdf

A

100 Chairs
100 Chairs
100 Chairs
100 Chairs
100 Chairs
100 Chairs
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables
200 Tables

Note: Make sure the text element is big enough, as it will not be sized to the content, other

than tables.
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Context Menu

The Context menu of Text frame is below:

Bring forward
Send backward

A Undo: locked false  Ctrl-Z
Applicable ¥ML nodes »

3( Cut Ctrl-X

[@ Copy Ctrl-C

. Paste Ctil-vf
Copy as text

Font Family
Font size
Font style

Alignment
Yertical alignment
Text color
Backaround color

v v v v Vv v wv

Move textsto one
Split texts
Fit to content

Convert to... »
Generate template

Locked

Forward and Backward

The commands Forward and Backward influence the arrangement of frames if you work with

overlapping frames. Refer Arrangement of Elements chapter for more details.

Apply XML Nodes
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With this command, you can group the element to an XML node without having to double click.

Because, it offers you a small window with the XML tree displaying all nodes, which you can

Bring éorward
Send backward

™ Undo: Iockéd false

3 cut
[ copy
. Paste

Copy as text

Font Family
Font size
Font style

Alignment
Yertical alignment

Text color
Backaround color

Move texts to one
Split texts
Fit to content

Convert to...
Generate template

Locked

Appliéabie. %ML nodes

Ctrl-Z

Ctrl-X
Ctrl-C
Ctrl-\f

v

v W |w w w

4 Productgroup
Mame
Img
4 Product
Mame
Description
Irmg
Data

\

currently assign to this element.

Note: This option appears for text frame, only if the frame is empty.

Cut, Copy, and Paste

These options are used to cut, copy, or paste the text element.

Copy as text
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ello {Productgroup/ProductiName}

another XSLfast object, or in external program.

Bring forward
Send backward

Copy as i:ext

Font Family
Font size
Font style

Alignment
Vertical alignment

Text color
Backaround color

Move texts to one
Spﬁt texts
Convert to...
Generate template
Locked

™ Undo: object addition ... Ctr-Z
¥ cu

Copy
. Paste

Ctrl-X
Ctil-C
Ctrl-W

| | | W

Paste Text in XSLfast object:

Copy as text option, copies only the content of the text element, not the frame. This ability

allows to copy text from selected object to clipboard. The copied text can be placed in
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Narm Math
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Paste Text in External Program:

Font Family, Size, and Style

These options are used to change the font settings of the text.

Alighment
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Aligns the content of text frame to left, right, center, and justify. Refer Arrangement of

Elements chapter for more details.

Vertical alighment

Aligns the content of text frame to top, center, and bottom of the text frame. Refer

Arrangement of Elements chapter for more details.

Text Color

Allows change the text color.

Background Color

Allows change the background color of the text frame.

Move text to one

Moves the text of multiple text frames to one frame.

Split texts

Splits the text of a text frame, which has more than one XPath.

Convert

Converts the text element to other elements.

Generate Template

Generates template.

Locked

Converts element to read only element. Refer Locked section for more details.
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Number

The Numeric field element allows you to enter and display formatted numbers. You can use it

as a static frame or fill it with dynamic data from the XML source.

Insert Numeric Field

To insert number field frame/element on worksheet, select Insert & Numeric field menu, or

click 12 - Numeric field icon form the toolbar. Click on worksheet and drag the cursor point.

The numeric field element is inserted.

70,0010 1,000 7
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Edit Number Field

The Numeric field editor window, allows the user to enter number and format the number. To
edit the numeric field double-click on the frame, or click Data field or Format option in

inspector window. The editor window appears.

FormattedNumber_1 - Numeric field =82 =B

Edit  Recent XPaths
n XE
I Format | Data

1,000 Mode Set
String
Boolean
Mumber
DatefTime
Math
Today
Templates

e« 3=

Column: 1, line: 1 Canc” e;l_]
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Format

The Format tab allows you to format the number.

FormattedNumber_1 - Numeric field & =
“Edit  Recent XPaths
»XEBE
Format | pata I
~Input format
Decimals separator . v
Thousands separator -
(®) Use predefined output Format
-Predefined output formats-
Decimal digits 2
Decimals separator . v
Thousands separator v
Mumber formats | 12345.10 2~
12,345.10
00123.10
00,123.10 v
() Mo currency
() Currency before  § v
() Currency after

(") Use custom output format

Custom format

Column: 1, line: 1 Ok I  Cancel

The Format window is divided into three sections:

Input format - Defines the format, in which the input data has to be formatted into a numeric
data.
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For example, if the text data is 123,456 and ', is the thousand separator. Hence, the numeric

value of this string depends on these options.

The input format consists of:

o Decimal separator - Separator for decimal digits.

¢ Thousand separator - Separator for thousands.

Predefined output formats - Defines the format, in which the output data has to be formatted

and displayed in the output files.

For example, if the input data is 12345 and the thousand separator of the output is defined as
“,”. Then the output is displayed as 12,345.

The Predefined output format consists of:

Decimal digits - Defines number of decimal digits after the decimal point. If you define
the decimal digit as 3 and the input data is 12345. The output displays as 12345.000.

e Decimal separator - Separator for decimal digits.

e Thousand separator - Separator for thousands.

¢ Number formats - Defines the format of the number.

e Currency before and Currency after - If you require a number along with currency
symbols, use Currency before to insert it before the number or Currency after to insert

it after the number.

¢ No currency - Use this option to avoid currencies.

Use custom output format - Use this option to customize your output format. If the predefined

options do not contain the format, you require.
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Data

The Data tab, allows you to enter the input string data, in the editor field. You can enter a

static data, or drag and drop a dynamic data from the XML node.

The Data tab also consists of XSLT functions.

Edit  Recent XPaths
nXBE
Iﬁprma!; Data
12345 Mode Set
String
Boolean
Mumber
Date)Time
Math
Today
Templates
 * |
& ||

Column: 6, line: 1 Cancel l
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Inspector Window

The properties of numeric field element are displayed in the inspector window. They are

grouped into groups belonging together. Use B pytton to expand the properties or use™ .

Inspector =

(=]

{absoube posiion: trus; Paddngs: [L... .

2 Gl |
iefi - §
T b
i
e -
v
v
=f0 -
i
-

[ ll.l"g ‘g [MELY

‘
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Few properties of Numeric Field are similar to Text. Refer Inspector Window section of Text

element, to know about similar properties.

Data Field

Allows entering a static or dynamic data. If you assign an XML node to this element, the path is

displayed in this field.

Format

The field Format opens the editor again where you can also enter placeholders for a certain
number format. For example, you would like to display in this frame the product prices of the
products contained in the XML source file. The prices all have different formats, some have no
decimal places, and some have three. You like to display in a uniform way. One of the

permitted placeholders is the hash sign.

Original Placeholder Result
10589.1 HH 10589.1
10589.10 R 10589.1
10589.99 B 10590

The hash sign placeholder will not fill empty spaces with 0, or consider 0 at the beginning or
the end of a sum as a number. However, it will round up or down sums to match the decimal

places you have determined with the placeholders.

Another permitted placeholder is 0. This will fill decimal places with 0 to match the number of

decimal places that you have determined.

Original Placeholder Result
10589. 1 00000.00  10589.10
524 00000.00  00524.00

191 |Page



Decimal and Thousand Separators

Refer Format section for details.

Text Before and After

The fields Text before and Text after can also be used to have numbers labeled, e.g. “Sales

Price” before the number and “in $” after the number.

Note: It is necessary to insert a blank after the text in the field Text before and a blank in
front of the text in the field Text after; otherwise there will be no space between Text and

number.

XPath Before and After

Insert XPath statements before or after the number to enhance the navigation or filtering

possibilities.

Translate From and To

Inadvertently it can happen that entered content is not a number (NaN). Processing this
content will lead to the faulty output ‘NaN’. XSLfast provides the function Translate

from/Translate to to display a customized abbreviation. Please note that the abbreviation

should not exceed 2 characters because only ‘N’ and ‘a’ are available as different characters in

the “NaN” string and more than 2 characters will not be considered.
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Inner Translate From and To

Inadvertently, it can happen that entered content is not a number (NaN). Processing this
content will lead to the faulty output ‘NaN’. XSLfast provides the function Translate

from/Translate to to display a customized abbreviation.

Notes:

The abbreviation should not exceed two characters because only ‘N’ and ‘a’ are available as

different characters in the “NaN”, string more than 2 characters will not be considered.

It is possible to substitute several characters simultaneously. The characters are substituted in
the exact order in which they have been entered into the fields. Character 1 in the field
InnerTranslateFrom is substituted by character 1 in the field InnerTranslateTo and so on. It is
also possible to substitute characters with a blank if you only enter a character into the field
InnerTranslateFrom and leave the field InnerTranslateTo empty. This is only possible at the
end of the sequence, because, if the field InnerTranslateFrom finds no counterpart for the

substitution in the same sequence place, it will use the next character of the sequence.

Replace Zero Values

Replaces the Zero values to the value entered in the field.
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Context Menu

The Context menu for Numeric field is same as Text. Refer Context Menu section of Text

element for details.

.

Bring éorward
Send backward

x Cut

Copy

. Paste
Copy as text
Font Family
Font size
Font style
Alignment
Vertical alignment
Text color
Background color
Move texts to one
Convért to...
Generate template
Locked

™ Undo: text data 1,000 ctr-Z

Ctrl-X
Ctrl-C
Ctrl-v

v v Vv Vv Vv v w

Note: Refer Numeric_Field.xsf under 19_XSL_Code, in Tutorial folder, to work on XSL Code.
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XSL Code

The XSL Code element is used to enter XSL or XSL-FO commands. It allows you to work with

more advanced XSL functions that are not covered by the WYSIWYG interface of XSLfast.

Insert XSL Code

To insert XSL Code element on worksheet, select Insert 2 XSL Code menu, or click XL >
Numeric field icon form the toolbar, or press Alt+Shift+T. Click on worksheet and drag the

cursor point. The XSL Code element is inserted.

R sitext=Text 1=ialtexts 7

Edit XSL Code

To edit XSL Code double-click on the frame, or click Text option in inspector window. The
editor window appears. The XSL Code editor allows you to operate on a part of content. You

can also set conditions, using the available functions, drag and drop the XML nodes.
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Edit  Recent XPaths

" XBE

Text_1 - New Text

4 Report
» Productgroup

: <wsl:text>Text 1</wsl:text>

Node Set
String
Boolean
Number

Column: 28, line: 1

Date/Time
Math
Today
Templates
XSLT
%5L-FO
i
MY K * ¥ )=
ok [ concel |

Apart from the simple editor and the missing function to group this element to an XML node it

has the same handling as text elements.

Unlike, text element XSL Code has XSLT and XSL-FO functions to enter XSL and XSL-FO

commands. Refer http://www.w3.org/Style/XSL/ for more details.

Inspector Window

The Inspector window of XSL Code has similar properties of Text element, except the

following:

o Generate xsl:apply-templates instead of text.

e Escape Comparison sign.
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http://www.w3.org/Style/XSL/

Refer Inspector Window section of Text element for more details.

Data | Format

l XSL Text_1

v
Property [ Yalue l
Object name Text_1
Locked O
4 Text <xslitext=Text 1<xshtext>
Font Font...
Test ok I
Backaround color
Line height 14.5pt

4 Frame properties
4 Bounds
4 Bbsolute position
Left
Top
Width
Helght
» Paddings
Or;entatlon
Border
Horizontal alignment
Yertical alignment
Level
Span
4 15L-FO options
4 Generate ¥5L-FO container
Custom attribute name 1
Custom attribute value 1
4 Generate ¥5L-FO block
Keep together
Custom attribute name 1
Custom attribute value 1
Link Id

Generate xshapply-templates instead 0.,

Escape comparison signs
Wrap text

Collapse spaces
Linefeed-treatment
Whitespace-treatment
Normalize spaces inside XML
Disable output escaping
Generate template

If

ForEach

[Absalute position: true; Paddings: [Lef..,
269 pt

377 pt

227.6pt

17.1pt

[Left padding: 0.0 pt; Top padding: 0.0,
| = A N 93
Border...
| Left

| Top
11

nane >

4

BIER]

| auto v

OO0

4

Lefie

| preserve

| preserve
O
O
O

197|Page



Context Menu

The Context menu options of XSL Code are also available in Text element context menu. Refer

Context Menu section of Text element for details.

Bring Forward
Send backward

b el

Copy

. Paste

[ Copy as text
Font Family
Font size
Font style
Alignment
Yertical alignment
Text color
Background color
Move texts ko one
Convert to...
Generate template

Locked

™ Undo: position/size changes 64,240,227,17 Ctl-Z

Ctrl-X
Ctrl-C
Cel-/

W W | W OW | WO W

Note: Refer XSL_Code.xsf under 19_XSL_Code, in Tutorial folder, to work on XSLCode.
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Barcode

XSLfast offers to create bar code for static and dynamic values. It is possible to generate the
bar code using bar code fonts, or using SVG graphics (this goes for both, static bar code or bar

code generated from XML nodes). The result is identical.

Insert Barcode

To insert Barcode element on worksheet, select Insert & Barcode menu, or click >
Barcode icon form the toolbar. Click on worksheet and drag the cursor point. The Barcode

element is inserted.

(empty)
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Edit Barcode

To edit Barcode double-click on the frame, or click Text option in inspector window. The

editor window appears. The Barcode editor allows you to enter static or dynamic data.

Edit  Recent XPaths

" XBE

4 Report
» Productgroup

Q)

Column: 1, line: 1

Inspector Window

Mode Set

String
Boolean
Number
DatefTime
Math
Today
Templates
+
| @ || & || » |
Cancel

The Inspector window of Barcode has similar properties of Text element, except the following:

e Generation type

¢ Barcode kind
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Refer Inspector Window section of Text element for more details.

Data | Format | 4 F

| Barcode_1 - |
Propetty | value |

Object name Barcode_1
Locked |
Generation type | XML Basedtext,S... |
Barcode kind TEAN-13 -
Barcode height 18 pt
Module 1pt
Font Font...

a Text

Background color

4 Frame properties

4 Bounds [Absolute position: true;...
a4 Absolute position
Left 269 pt
Top 377 pt
wWidth 113.8 pt
Height 28.5 pt
4 Paddings [Left padding: 0.0 pt; T...

Left padding 0 pt
Top padding 30 pt
Right padding 0 pt
Bottom padding 30 pt

COrientation 0 - |
Border Border...

Horizontal alignment [ Left - |
Wertical alignment | Top -
Lewvel 11

Span | none -

4 XSL-FO options
4 Generate X5L-FO con...
Custom attribute ...
Custom attribute ...
4 Generate XSL-FO block
Keep together [ auto -

Custom attribute ...
Custom attribute ...
Link Id

Generate template [

1f

FarEach
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Generation Type

Generation type is used to specify, whether the bar code should be static text or dynamic
content from the XML source and whether it should be based on a barcode font, SVG graphics,
or barcode 4j. The advantage of SVG graphics is the clearer display of the bar code and the

scalability with hardly any loss of quality.

[Generation type Static text. SVG araphics b
Static text, Barcode font
XML Based text, Barcode font

Static text, SVG graphics

XML Based text, SVG graphics
Static text, barcodedj
XML Based text, harcodedj

Barcode kind

In case you prefer SVG bar codes or barcode 4j, it supports different kinds of barcode, as shown

below:

[ Barcode kind JEANA13

EAN-S
UPC-4
UPC-E
3 OF 9
2 OF 5
Codabar

Code128 Y

Bar codes depend on the text you enter; so EAN-13 e.g. requires 13 digits. In case SVG graphics
are used, the checksum number will be calculated automatically if you do not enter it, or the
XML source contains only 12 digits in this example. The “missing” checksum number will not be

added to the number but XSLfast will produce a correct bar code with it.

It contains the bar code font EAN-13 that is the most common bar code font in Europe, and

Fi2o0f5, often used in the US.
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Note: If you need accurate bar codes, which are readable by bar code scanners, use SVG based

bar codes.

Module

Another difference is the function Module when you work with SVG bar codes. This indicates
the current size of the bar code, depending on the height. Setting the value to 0.5 the bar code

is half the size, setting it to 2.0 it will be twice the size.

Context Menu

The Context menu options of Barcode are also available in Text element context menu. Refer

Context Menu section of Text element for details.

' Bring forward
Send backward

™ Undo: add Ctrl-Z

Applicable ¥ML nodes >
¢ cut Ctrl-X
Copy Ctrl-C
B raste Ctrl-y

Copy as text

Font Family

Font size

Font style

Alignment

Text color

Background color

v v |w | W W W

Move texts to one

Convert to... »
Generate template

Locked
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Note: Refer Barcode.xsf under 20_Barcode, in Tutorial folder, to work on barcodes.

List

The List element allows you to display the contents of a node in a list inside one frame without

the need to create a table for it.

Insert List

To insert a List element on worksheet, select Insert = List menu, or click s= - List icon

form the toolbar. Click on worksheet and drag the cursor point. The List element is inserted.

®hio grouping selec:ted?.
Please assign grouping
to enumerate tems

Before editing the list you can group the list to the XML nodes, similar to Page and Table.
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Grouping List

Like a table, a list frame needs to be grouped to a node from the XML tree to specify the place
to begin from in the XML structure. To group a list frame click List >Add or edit grouping, or
select Grouping option in inspector window, or select Add or edit grouping from Context

menu. The Grouping Properties window appears.

Grouping properties b3

Group by position | Fiktering | Group by content |
Grouping:
4 Report
4 Productgroup
Mame
Img
» Product

Auto XPath completion
| Relative nested grouping
["] Conditional region {%5L:IF instead of XSL:FOR-EACH)

Remove grouping Jl Ok ” Close ]

Select the XML node and click “Ok” button.

The List frame is grouped to the selected XML node. By default, the enumeration type is set to

“1 ”
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Edit List

The List editor window, allows the user to assign contents to the list. To edit list frame double-

click on the frame. The editor window appears.

Select the XML node, drag, and drop the node to the editor field.

Edit  Recent XPaths

" XBE

4 Report
4 Productgroup
Mame
Img
» Product

I =N

Column: 1, line: 1

Node Set
String
Boolean

Number
Date/Time
Math
Today
Templates
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The selected node is displayed in the frame, like in a regular text frame:

Now, process the layout, the frame would look like this:

Productgroup 1
Productgroup 2
Productgroup 3
Productgroup 4

et e
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Inspector Window

The Inspector window of List element has similar properties of Text element, except the
following options:

¢ Grouping - This option is explained in Grouping List section.

e Use alternate color - The Use alternate color option is used to apply alternate colors
to the alternate list. Check Use alternate color check box. Double-click on Color1 and

Color2. Select the alternate colors from Text color window and click “OK”.

Alternate colors properties =R

Colors 7 |T|

o

Q
il

=

| add J| Change JI Delete J

| Ok Il Cancel
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4 Use alternate colors

Alternate colors

e Sort attribute - The Sort attribute option sorts the list content, as per sort order, data
type, and case order. To sort a list:

1. Enter the sort expression.

2. Select Sort order, Data type, and Case order.

B Sort attribute 1 [Sort expression: Mame; ..,
Sort expression  [Name
Sort order Descending =
Data type Text |
Case grder Unner first =

3. Process the layout to view the result.

£005RIEY

Productgroup 4
Productgroup 3
Productgroup 2
Productgroup 1

e XxPath - The xPath is used to define or select nodes.

¢ Kind - This option is used to select the kind of list. The function Kind offers a selection
of enumeration and bullet types for the list.
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Kind

Note: Not all fonts support all bullet types from this selection.

Label start indent - Set the gap between the list number and the list item with the
function Label start indent. This property may also have a negative value which implies

an out dent.

Label end indent - Specifies the distance from the end edge of the text to the end

edge of the frame.

Provisional distance between starts - Specifies the provisional distance between the
start indent of the list item label (the bullet or the number) and the start indent of the
list item body; in short: this property specifies how far the left side of the label is away
from the left side of the body.

Provisional label separation - specifies the provisional distance between the end of
the list item label and the start of the list item body; in short: this specifies the

separation between the right side of the label and the left edge of the body.

Keep together - Keeps the complete list together, in a page.

Keep with next - The list will not be separated from the next list, in a page break.

Keep with previous - The list will not be separated from the previous list, in a page

break.

Refer Inspector Window section of Text element for more details.
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Background color

Text color

Label start indent

Label end indent
Provisional distance bet. .,
Provisional label separa. ..
Keep together

Keep with next

Keep with previous

4 Frame properties

4 Bounds
4 Absolute position
Left
Top
\Width
Height
4 Paddings
Left padding
Top padding
Right padding
Bottom pad...
Orientation
Border
Horizontal alignment
Vertical alignment
Level

Span

4 X5L-FO options

4 Generate XSL-FO«c...
Custom attribut, |

Customn attribut, ..

ata | Format 4
:= List_1
Property Value |
Object name List_1
Locked [l
Grouping Productgroup
4 Use alternate colors
Alternate colors
Sort S
*Path
Kind I -
Font Font...

30 pt
10 pt
24 pt
16 pt
O
O
O

[Absolute position: tru...
136 pt

136 pt

113 pt

227 pt

[Left padding: 0.0 pt; ...
0 pt

0pt

0pt

0pt

|0 |
Border...

Left el
| Top v |
11

| none v
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Context Menu

The context menu options of List element are available in Text element, except the following

options:

e Kind - Refer Inspector Window section.

¢ Add or edit grouping - This option is used to group the list frame, similar to Grouping

option in Inspector window. Refer Grouping List section for more details.

e Remove grouping - This option is used to remove grouping of a list.

Refer Context Menu section of Text element for more details.

Bring forward
Send backward

Groupings b

Applicable XML nodes »
™ Undo: grouping Productgroup  Ctd-Z
3 cut Ctrl-X
Copy ctrl-C
‘ l Paste Ctrl-
Font Family

Font size

Font style
Alfgnment

Vertical alignment
Text color
Background color
Kind

Convert to...
Generate template
Locked

v v v Vv Vv Vv Vv v Ww

Note: Refer list.xsf under 24_List, in Tutorial folder, to work on List.
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Chart

Chart object is used to build charts of data, just like some text editors can do. XSLfast allows

you to create two types of chart:
e Bar Chart
e Pie Chart

You can also render charts in two ways:
e 3D Chart

e 2D Chart

Insert Chart

To insert Chart element on worksheet, select Insert = Chart menu, or click h' - Chart icon

form the toolbar. Click on worksheet and drag the cursor point. The Chart element is inserted.
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Inspector Window

The Inspector window of Chart element has similar properties of Text element, except the

following options:

¢ Type - Option to select either Bar chart or Pie chart. You can also use !bar :'v from

the toolbar, or Chart type option from Context menu.

S

Bar Chart Pie Chart

lSD ch... ¥ I
e Chart Type - Option to render charts in 2D or 3D charts. You can also use

from the toolbar.

2D Chart 3D Chart
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e Values - Defines the value based on which the Chart should be created. Specify the

path of the numeric value nodes. Click Values option in inspector window, or click

@ - Set chart value icon from the toolbar. The window to specify path appears.

Select an XML node, which has numeric values and click “Ok” button.

CEdit  Recent XPaths

n XBE

4 Report
4 Productgroup
Mame
Img
4 Product
MName
Description
Img
Data

SN

M

4
Productgroup/Product/Data

Column; 26, line: 1

The select node is assigned to the chart value.

Node Set
String
Boolean
Number

Date(Time
Math
Today
Templates
*
« 3=
_cencel |
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e Value Description - Defines the path to the text string that is displayed, under the bars

(for Bar Chart) or to the right of

the pie (for Pie Chart). Click Value Description option

in inspector window, or click % - Set chart description icon from the toolbar. The

window to specify path appears. Select an XML node and click “Ok” button.

Chart 1 - XML nude FH =
m“

nXED

- apont
# Frodxtgop
Narre

~ Ll

Column: 26, et

Produccgroup /Produce /Hane

| Mode Set
Srng
Boackean
Ny
Date/Tene
Mah
Taday
Targlates
*
- 3 »
|ob ) (_carcel |
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The select node is assigned to the value description.

In the output file, the description is displayed as shown below:
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Productgroup 1

[ Description of product ¢ 2 1
| Description of product D 8.1 7
7.2

6.3 -

54 -

4.5 -

3.6 =

2.7 =

1.8 =

094

0 -4

Description

A Product T
|| Product D

Description

Productgroup 1

The options under Value description differs for Bar and Pie chart.

[ Yalue descriptions ,Name

Preferred cell width |3 ElValue d'_?SC"'Pt'C'“S : iDescnptlon
Descriptions text ... |50 Maxm?unj descript... |100
Description font Font...

Description font Font...
Description text c...

Description kext c...

Bar Pie

e Chart legend - Defines the path to the values shown to the left of the Bar Chart. It may

be some useful information, not necessary equal to the one defined in the Chart value

descriptions. Click Chart legend in inspector window, or click Lﬂﬂ - Set chart legend
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icon from the toolbar. The window to specify path appears. Select an XML node and

click “Ok” button.

Edit Recent XPaths

» X
4 Report : Productgroup/Product/Description Hode Set
4 Productgroup String
Name Boolean
Img Number
4 Product Date/Time
Name Math
Description Today
Img Templates
Data
| * |
MEY = KX EXEN

Column; 33, line: 1

Note: Chart legend is active, only for Bar chart.
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'I'itle: Na me ..........................................
Group by: Produd

Values: Data

value descriptions: Name

Chart legend (FEGrptots

In the output file, the chart legend is displayed as shown below:

Productgroup 1

| Description of product C 45 I
_ | Description of product D81 7
472 -
h =
54 -
4.5
B
2ot
1.8 1
0.9 -
o il

Chart legend

Following are the options under Chart legend:
e Legend Font - Assign Font, style and size.
o Legend text color - Assign text color.

Chart which has similar description and legend value:
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o
814|
72—
6.3 4|
A
45
36
iai
18 1
094

Product C™\
_| Product D

Legend Value

Description

¢ Title - Defines the path or just a static string value that is displayed as Chart title.
TER
Click Title in inspector window, or click - Set chart caption icon from toolbar.

The window to specify path appears. Select an XML node and click “Ok” button.
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| Productgroup /Produce /Hase

Colurey: 26, ket 4

Following are the options under Title:

¢ Title font - Assign Font, style and size.

o Title text color - Assign text color.

i

Taday

Terrglates

- | | » |
(on) Lcmanl ]
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In the output file, the Title is displayed as shown below:

[ Description of product C
Description of product D

roductgroup |

B;T_

=

B3
54~
4.5
2B

2.7 Il

1.8 5

094

0 -

D
o
%%@

<
%
‘0%

e Group by - Defines the path of the logical group that the chart values should be

arranged to; technically it is the parent-node to the value-node. Data of the same

group are displayed with the same color. After defining this parameter, the Chart

values should be set relatively to that path.

Click Group by option in inspector window. Select the node to which you need to group the

chart.
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Edit Recent XPaths

» XBD
4 Report : Productgroup/Product Hode Set
4 Productgroup String
Name Boolean
Img Number
¥ Product Date(Time
Math
Today
Templates
[ ‘,
- - « | 3 [ »
N

Column: 21, line: 1

You can also create your own group and assign the group to the chart.
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Grouping properties 23
Group by position | Filtering Group by content
Grouping:
4 Report Copy subtree
4 Productgroup
Mame Copy From: |ProductgrouplProduct[count(Data)<10]
Img
» Product Mode Set l Add
String T
- Update
Boolean :
MNumber Delete
Date/Time
Evaluate
Math
Today
Templates
The result of XPath expression.
Auto %Path completion
| Relative nested grouping
["] Conditional region {%SL:IF instead of ¥SL:FOR-EACH)
[.‘ Remove grouping ] | Ok ] I Close J

Assign the group to the chart. If you process the chart, the output is displayed as shown below:

AN *w,, RN NS S
RN N NN, ‘%

If you do not set the Group by property, the result would look as follows:
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The major difference is that the bars are not grouped. Thus, the 3 bars referring Product C
displays different colors. If you take a look at the xml data, you will see that each Product

node has 4 sub-nodes:

Name

Description

Data

e Img

Some of the Products do not have Data; some of them have 3 or more Data entries. When we
specify Group by, we tell the system to display each Data entry with the same color for that
Product, and that the Description will be rendered for the whole Product, not each of the Data

entries.

Note: The Products that do not have Data entries are not rendered. For example, Product A

does not have any Data. So, Product A is not available in the chart.

e Custom chart color - Option to specify all the bars to have the same color.
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'_I,'itle’:-Name-

Group by: Product
Walues: Data

Value descriptions: Name
Chartlegend : Name :

e Background color - Option to assign chart background color.

¢ Use bookmark - Lets you specify the bookmark for the pdf; the Description will be

printed in the Bookmarks list of the pdf viewer.

All other properties in inspector window are also available in Text element. Refer Inspector

Window section of Text element for more details.
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| Data | Format 4

i el Chart 3

Property | Yalue |
; ébjéo:f narme ‘C.HarE-_S
Lacked |
Type | Bar hdl
Chart type 730 Chart 3
Group by
Yalues

4 Value descriptions
Preferred cellwidth 5
Descriptions text a,.. 45

Description font Font...

Description text color

4 Chart legend

Legend font Font...

Legend text color ]
4 Title

Title font Font...

Title text color

DI

Custom chart color
Background color

4 Frame properties

4 Bounds [Absolute position: tru...
4 Absolute position
Left 269 pt
Top 377 pt
Width 142.3 pt
Height 142.3 pt
4 Paddings [Left padding: 0.0 pt; ...

Left padding  Opt
Top padding 0Opt
Right padding 0pt
Bottom pad... Opt

Orientation 0 bl
Border Border...

Level 11

Span | none v

4 »5L-FO options
4 Generate ¥SL-FO c...
Custom atkribut.
Custom attribut...
4 Generate XSL-FObl...
Keeo toaether | auto v
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Context Menu

The context menu options of Chart element are available in Text element, except the following

options:
¢ Title color - Assigns color to the title name.
e Description color - Assigns color to description.
e Group color - Assigns color to each group.
¢ Chart color - Assigns color to chart, similar to custom color in inspector window.

e Background color - Assigns background color to the chart.

Chart type - Option to select bar or pie chart.

Refer Context Menu section of Text element for more details.

Bring forward
Send backward

™ Undo: position/size changes 88,200,142,142 Ctl-Z

3 cut Ctrl-X
[ Copy Ctil-C
‘ Paste Ctrl-w

Title color
Description color
Group color
Chart color
Background color

v v Vv Vv v v

Chart type
Generate template
Locked
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Sample Example

This section provides an example to use chart element.
1. Create new layout using Demo.xml as the source for the xml data.
2. Group the page to Report/Productgroup.
3. Insert the two chart elements, for Bar and Pie chart, one below the other.
4. Group the chart to Product, using Group by option.
5. Enter Title in Title option and set font.
6. Select Data as Values.
7. Select Name as Value description.

8. Select Description as Chart legend (only for bar chart).
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Example 40

Chart

[Craemn e 1

Now, if you process this layout. The output is displayed as shown below:
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Example 40

Chart

Clroduz ¢
OProduc 0

It v enits atcom

XSLE st

Note: Refer Chart1.xsf and Chart2.xsf, under 40_Chart, in Tutorial folder to work on Chart

element.
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Images

The Image element is used to insert images. XSLfast allows to insert two types of images:

e Static Image
¢ Dynamic Image

XSLfast supports .gif and .jpg image formats.

Insert Image

To insert an image element on worksheet, select Insert = Image menu, click EI - Image

icon form the toolbar, or press Ctri+l. Click on worksheet and drag the cursor point. The Image

element is inserted.

.@ Image f

Insert Static Image

To insert static image, follow the steps below:

1. Insert an image element.

2. Select Image type as Static, in inspector window.
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X

3. Double-click on image element. The Select background image. Window appears.

Select background image...

2 =’

LookIn: = img v |@ |a
= loyd [ OKI_Products_407.jpg  [] prod202011.gFF [ prodzozo32.gif
=1 loyd-woman D pelikan.jpg D prod202012.gif D prod202033.gif
= Maxdata [ prodio1051.gif [1 prodzo2013.gif [7] prodz02034.gif
=1l shoes [ prodto10s2.gif [1 prodeo2014.gif [ prodz03001.gif
[ 7] box_xslFast.jpg [ prod101053.giF [7] prodzoz015.giF [ prodzo3002.gif
[ edding.jpg [ prodi01054.giF [7] prodz02016.gF [ prodz03003.giF
[ EPSON_C82.jpg [7] prod1010sS.gif [7] prodz02017.giF [ prodz03004.gif
7] Epson_ink_bw.jpa [0 prod101056.giF [ prodzoz018.giF [ prodz03005. gif
("] Epson_ink_c.jpg [ prod101057.giF [7] prodzo2019.gFF [ prodz03006.gif
[ ) Epson_styc1520_r2_c1.jpg ) prod101058.gif [7] prodz02020.gFF [ prodzo3007.giF
[7) Epson_styc3000_r2_c1.jpg ] prod101059.qif [ prodzoz021.giF [7] prodz03008. gif
7] EpsonC_42Plus.jpg [7) prodzo2001.giF [ prodzoz022.giF [7] prodz03009.gif
[] holzstempel. gif [ prodzo2002.giF [ prodz02023.giF [ prodzo4001.gif
[ 7] HPS150. gif [ prodz02003.giF [7] prodz02024.F [ prodzo4002.giF
[ 7] HP_ce4a7c.gif [ prodz02004.giF [ prodz02025.giF [ prodz04003.gif
[ ) HP_c6657an_150.gif [7) prodzo2008.gif [ prodeoz026.gif [ prodz04004.gif
(] HP_c8925a.qif [ prodzo2006.giF [ prodz02027.giF [ prodzo4005. gif
[7] HP_dj450.jpg [ prodz02007.gif [ prodz02028.giF [ xsl_logo_neu.jpg
[ jcatalog.jpg [ prodz02008.gif [ prodz02029.gFF

[ leitz.jpg [0 prod202009.giF [ prod202030.gif

(7] OKI_406.jpa [ prodzo2010.gif [ prodz02031.gFF

File Mame: |

Files of Type:  Images (*.jpg, *.jpeq, *.tif, *.svg, *.png, *.qif, *.tiff)

4. Select the image and click “Ok” button.

XSLE st
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Insert Dynamic Image

To insert static image, follow the steps below:
1. Insert an image element.

2. Select Image type as Dynamic, in inspector window.

.@ Image 3-

3. Double-click on image element. The Select background image.. window appears.
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Edit Recent XPaths

n XB
4 Report : Productgroup/Ing Mode Set
4 Productgroup String
MName Boolean
Img Number
» Product Date/Time
Math
Today
Templates
+
| Qs |8 »
Column: 17, line: 1

4. Select the image. There are three ways to select an image:

o |f the XML data has the image path, select the XML node, which has the image
path.

Note: Do not enter an Image base path here, because, these two specifications would clash.

Make sure that the path information is correct.

‘& Productgroupsimg

[]
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¢ If the XML data do not have image path, specify the directory where the images are
found in the field Image base path. You can enter the image base path directly or

use the search dialog.

o A third way to select the correct XML node is to use the context menu and select

the function Applicable XML nodes.

Inspector Window

The Inspector window of Image has similar properties of Text element, except the following:

¢ Image base path - Specify the image path for a static image, or directory of the image

if the XML does not have image path.

¢ Image/Image node - Specify the XML node, which has image. After you specified an
image file, the path will be displayed in Image/Image node. Depending on the settings
in Tools = Preferences = Path mode it is an absolute path or a path relative to the

XSLfast home\bin directory.
o Fit in Frame - The image is resized to fit it into the given frame.

o Keep aspect ratio - Determine whether the image proportions should be maintained to

prevent a distorted image.
¢ Image type - Define whether the image is static or dynamic image.

¢ Orientation - If you use XEP or XSLFormatter as your Renderer, the menu item
Orientation is available. It allows you to give the contents of the frame four
orientations: 0 (regular orientation), 90 (turned 90 degrees counterclockwise), 180

(upside down) and 270 (turned 270 degrees counterclockwise /90 degrees clockwise).

Note: The orientation is not visible on the working sheet but only after the processing of

the layout.

Refer Inspector Window section of Text element for more details.
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.D?-atfa | Format | 17

(5] 1mage_t - |
Property j value |
Object name Image_1
Locked |
Image base path |
ImagefImage node Mo image
Fit in frame
Keep aspect ratio
Image type: | Dynamic - |‘

4 Frame properties

4 Bounds [Absolute position: true;...
4 Absolute position
Left 269 pt
Top 377 pt
\Width 113.8 pt
Height 113.8pt
4 Paddings [Left padding: 0.0 pt; T...

Left padding 0pt
Top padding 0pt
Right padding 0pt
Bottom padding O pt

Orientation [0 v |
Border Border...

Hatizortal alignment | Left v |
Vertical alignment | Top v
Level 11

Span | none v

4 xSL-FO options
4 Generate ¥5L-FO con..
Customn attribute ...
Custom attribute ...
4 Generate XSL-FO black
Keep together | auto v

Custom attribute .,
Custom attribute ...
Link Id

Suppress if empty

Generate template

If

ForEach

ag
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Context Menu

The context menu of an Image element changes, depending on the type of image selected.

Context Menu for Static Image

e At e e e e At P e e e e e e e e e e

Bring forward

Send backward
A Undo: image type: true  Ctil-Z
¥ cu ” Ctrl-X
@) Copy Ctil-C
. Paste Ctrl-vf

Alignment

Vertical alignment

Select image. ..
Remove image

< Fitin frame
' Keep aspect ratio

Convert to... »
Generate template

Locked
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Bring forward

Send backward
| ™ Undo: position/size changes 200,216,113,113 Ctd-Z
Applicable XML nodes 7 »
3¢ cut Ctrl-X
[ Copy Crl-C
. Paste Ctrl-f
Alignment

Yertical alignment
Select XML image. ..
Remove XML image
 Fitin frame
« Keep aspect ratio
Select base path...
Remove base path

Convert to... »
Generate template

Locked

Context Menu for Dynamic Image

The Image element has similar options of Text element, except the following:

o Select XML image - The image selection can be done with the command Select image,

which opens a file browser window.
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Edit Recent XPaths

A XBD
4 Report : Productgroup/Ing Node Set
4 Productgroup Skring
Mame Boolean
Img Number
» Product DatefTime
Math
Today
Templates

|_ok ]| cancel

¢ Remove XML image - Removes the XML image and clears the frame.

o Fit in Frame - The image is resized to fit it into the given frame.

o Keep aspect ratio - Determine whether the image proportions should be maintained to

prevent a distorted image.

o Select base path - Selects the base path. This option opens the Directory... window,
where you can select the base path. The selected path is now available Image base

path option.
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" Directory... a8 =
LookIn: £ bin -

Folder name: ]E:'ltest\xslfast\dist'lbin [

Files of Type: Al Files v

¢ Remove base path - Removes the base path.

Note: Refer Images.xsf under 21_Images, in Tutorial folder, to work on images.

An example, with a very simple logo is shown below:
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g8 Acrobat Reader - [demo.pdf] =

@ Datei Bearbeiten Dokument Anzeige Fenster Hilfe X
cRsABE|1 > ¢ |[OR-|T-& |
|efe - @ OOOE |-

J W <] 1von1 » W 21ix2884mm 1O = w4

Internet Link

The Internet link element allows you to display Internet links in the layout. You can use it as a

static frame or fill it with dynamic data from the XML source.

Insert Internet Link

To insert an Internet link element on worksheet, select Insert = Internet link menu, click g
- Internet link icon form the toolbar, or press Ctrl+Shift+L. Click on worksheet and drag the

cursor point. The Internet link element is inserted.
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slfast.com

Edit Internet Link

To edit the Internet link frame double-click the frame or click Text option in inspector

window. The Internet link editor appears.

The editor window differs, depending on the type of link selected.

Editor for Static Link

Enter a static link as shown below. Here, the XML tree is not available. The toolbar contains

the formatting tools.
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Editor for Dynamic Link

Select the XML node, which contains the URL.
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Internetlink_1 - Internet link

CEdit  Recent %Paths

nXBE
4 = z
4 Report \|xslfast.com foles
» Productgroup g
Boolean
Number.
Date/Time
Math
Today
Templates
*
Y LIS MR
Choose destination type Web link =
Enter or choose link: http:ff v

ok || cancel |

The Choose destination type drop-down allows to select two destination types:

Choose destination type  |Document link _'__I
Wweb link

Document link: Link within the document. The link works only within a document. Document

link helps to link another element, within a document, using Linkld.
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Web link: Allows you to specify an URL. Web link helps to link to websites.

The Enter or choose link field allows to specify the target address of the link, which the
browser will open after clicking the title of the link, type the target in the field Enter or

choose link or choose it in the select box of that field.

Inspector Window

The Inspector window of Internet link has similar properties of Text element, except the

following:

Destination type - Define whether the link is Static or Dynamic.
e Type - Define whether the text of the link is Static or Dynamic.
e Destination - Enter the target link.

o Keep together - This option is used, when an internet link is placed in table. It keeps

together with other rows.

o Keep with next - This option is used, when an internet link is placed in table. The row

will not be separated from the next row, in a page break.

o Keep with previous - This option is used, when an internet link is placed in table. The

row will not be separated from the previous row, in a page break.

Refer Inspector Window section of Text element for more details.
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Data Format 1

" () InternetLink_t

Property | Value
Object name InternetLink_1
Locked O
4 Text xslfast.com

Destination type | Weh link v
Type ] Dynamib'texl (XML) v
Object kind [ Tex — v
Font Font...

ST

Background color

Destination hittp:/f
Line height 12.0pt
Keep together O
Keep with next O

Keep with previous [

4 Frame properties

4 Bounds [Absolute position: tru...
4 Absolute position
Left 1584 pt
Top 264 pt
Width 227 pt
Height 17 pt
4 Paddings [Left padding: 0.0 pt; ...

Left padding Opt
Top padding  Opt
Right padding 0 pt
Bottom pad... 0pt

Orientation 0 v
Border Border...

Horizontal alignment | Left v
Vertical alignment | Top v
Level 1

Span | none v

4 X5L-FO options
4 Generate ¥SL-FO €.,
Custom attribut...
Custom attribut. .,
4 Generate XSL-FObl,..
Keeptogether | auto v

Custorm attribut...
Custom attribut...
Link 1d
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Context Menu

The context menu options of an Internet link element are available in Text element. Refer

Context Menu section of Text element for details.

Bring forward
ﬁ Send backward
|

; ™ Undo: type false

| p

| [ copy

| 1B Paste

] Copy as text

Font Family

Font size

Font style
Alignment

Yertical alignment
Text color
Background color
Move texts to one
Convert to...
Generate template
Locked

Ctrl-Z
Ctrl-X
Ctrl-C
Ctrl-W/

v v Vv Vv Vv v v

Note: Refer InternetLink.xsf under 28_InternetLink, in Tutorial folder, to work on Internet

link.

Date/Time

The Date/Time element allows you to display a date or time in the layout. You can use it as a

static frame or fill it with dynamic data from the XML source.
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Insert Date/Time

To insert a Date/Time element on worksheet, select Insert - Date/Time menu, click E' >
Date/Time icon form the toolbar, or press Ctri{+Shift+D. Click on worksheet and drag the cursor

point. The Date/Time element is inserted.

0120119163659 F

! ol

Edit Date/Time

The Date/Time editor window, allows the user to enter and format date and time. To edit
date/time frame double-click on the frame, or click Text or Format option in inspector

window. The editor window appears.
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Edit “iew Insert Format Recent XPaths
nXRES |
Data |Format

2012-01-16T11:16:06

— v o~ B 1 UXX E

| #*
EXENEN
Column: 1, line: 1

Format

The Format tab allows you to format date and time. You can specify your own Input and

Output formats for date and time.
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Date/Time format =] =

Input format

Date separator v  Time separator . -
Date-time separator T - Date order ¥Y¥YY MM DD -
(®) Use predefined output format
-Predefined output formats
(&) Date Date separator w  Time separator -
) Time MMM HH:mm
: MMMM dd, yyyy HH:mm:ss
0 Date and time dd MMMM yyyy HH:mm:ssT 2
dd-MMM-yyyy HH:mmT z
dd.MmM hh:mm
dd.MM.yyyy hhimm a
yyyy MMMM hh:mm:ss
yyyy, MMMM hhimm:ss a
Example:
Input:
Output:

(3 Use custom output format

Custom format  yyyy-MM-ddTHH:mm:ss

| ok || cancel

The Format window is divided into three sections:

¢ Input format - Defines the format, in which the input data has to be formatted into
date and time. By default, the Date input format is “YYYY MM DD” with the separator

“_”» [{xei]

. The default Time input format is “hh:mm” with the separator “:”.

Choose the Date separator, Time separator, and Date order for the input data offered in

combo boxes:
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~Input format

Date separator 0 v Time separator v

Date-time separator T v Date order YYYY MM DD hd

¢ Predefined output formats - Defines the format, in which the output data has to be

formatted and displayed in the output files.

e The Predefined output format consists of:

e Date Separator

e Time Separator

¢ Radio buttons to enable fields:

o Date

o Time

o Date and Time
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(®) Use predefined output Format
Predefined output formats
{#) Date Date separator . v Time separator v
) Time MMMM HH:mm
) MMMM dd, yyyy HH:mm:ss

() Date and time dd MMMM yyyy HH:mm:ssT 2
dd-MMM-yyyy HH:mmT 2
dd.rMm hh:mm
dd. MM, yyyy hh:mm a
yyyy MMMM hh:mm:ss
iy, MMM hhimmiss a

After defining the output format you can see the example with Input and Output data in the

format and with the separators you have chosen above:

Example:
Input: 2002-02-22722:22
Output: 22{February/2002 22:22

Use custom output format - Use this option to customize your output format. If the predefined

options do not contain the format, you require.

Data

The Data tab, allows you to enter the input string data, in the editor field. You can enter a
static data, or drag and drop a dynamic data from the XML node. The Data window differs,

depending on the type of data.

Dynamic Data Window
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Edit Recent ¥Paths

n \ x @
Data |Format
4 Report i Hode Set
» Productgroup String

Boolean
Number
Date/Time
Math
Today
Templates

L*
Bl EXENEY
Column: 1, line: 1 V (e

Static Data Window

When choosing static text for date/time, you have the possibility of changing the font type,

size and style, the text alignment, the text color, and the background color.
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Edit View Insert Format Recent XPaths
AXBEES |
Data |Format

2012-01-16T11:16:06

— J~llnov| B 1 UXX

L®
« | % || » |
Column: 1, line: 1 Cancel l

Inspector Window

Refer Inspector Window section of Text and Inspector Window section of Numeric Field for

details.
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lData | Format | 4

|\ DateTime_1

Property | Yalue |
E)bject name DateTime_1
Locked [l
4 Text 2012-01-16T11:16:06

Type | Static text v |
Output format ww-MM-dﬂTHH:mm:ss 7
Text before
Text after
¥Path before
¥Path after

Translate date sep..,

Translate date sep..., -

Translate time sepa... .

Translate time sepa...

Font Font...

Text color ]
Background color

4 Frame properties

4 Bounds [Absolute position: tru...
4 Absolute position
Left 269 pt
Top 377 pt
Width 113.8 pt
Height 17.1 pt
4 Paddings [Left padding: 0.0 pt; ...

Left padding Opt
Top padding Opt
Right padding Opt
Bottom pad..., Opt

Orientation o v
Border Border...

Horizontal alignment | Left v |
Yertical alignment | Top v |
Level 11

Span | none v

4 XSL-FO options
4 Generate XSL-FO c..,
Custom attribut. ..
Custom attribut, .,
4 Generate XSL-FO bl...
Keep together | auto -

Custom attribut. ..
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Context Menu

The context menu options of Date/Time element are available in Text element. Refer Context

Menu section of Text element for details.

Bring forward
Send backward

™ Undo: position/size changes 128,288,113,17

I cut
Copy
. Paste
Copy as text

Font Family

Font size

Font style
Alignment

Yertical alignment
Text color
Background color
Move kexts toone
Convert ko...
Generate template

Locked

Ctrl-Z

Ctrl-X
Ctrl-C
Chil-wf

W | W W | VW W

Note: Refer DateTime.xsf under 29_DateTime, in Tutorial folder, to work on Date and Time.
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Square

The Square object is used to place a colorful rectangular or squared element on the

worksheet. There are two ways to insert a square:

Insert Square

Click the Square icon 9- on the tool bar.

OR

Click Insert menu and select Square.
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The Square menu appears in the menu bar if you select a square from the worksheet.
The Square menu consists of two functions:

e  Background color to change the background color of the square, or revert to default
color. Choose the color you need or set it back to white with the function Revert to
default.

¢ Convert to change the square object to Text or XSL Code.
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Inspector Window

The functions in the inspector window mainly refer to color, rounded rectangle, size, borders,
and position of the square:

Data | Format i1 5

Square_1 v
Property | Value |
Object narné ‘ .Square_-l.
Locked ]
Background color |
» Round corners ]
4 Frame properties
4 Bounds [Absolute position: true]
4 Absolute position
Left 128 pt
Top 72 pt
Width 322 pt
Height 141 pt
Border Border...
Level 11

Background Color

Specifies the background color of a square. There are three ways to change the background

color of a square:
¢ Double-click the square.

¢ Select the square and select Square > Background color > Background color menu

from menu bar.

e Click the Background color value from Inspector window.
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The Background color window appears. Select the color and click “OK“.

Background color 2

| Static color | Colors by condition
W _] 1 =
812 0
Transparent - ——
CMVK:UIUIOIIUU 5 100 %

Red Blioo %
CMYK: 0| 100 | 100 | 0
R |255 |
Green S
CMYK: 100 0] 100 |0 Glo |
Blue B0
CMYK: 100 | 100 |0 | O ]
Black Clo | %
CMYK: 65 | 53| 51 | 100 Moo %
White vliﬁv
CMYK: 00|00 ]-lpqr—_? :
- Ko %
# [ffffooon |

[Lok | [ concel |

To change the Square to transparent, check Make transparent check box.

Rounded Rectangle/Square

Specifies the rounded angle of a rectangle. X-rounding value and Y-rounding value specifies the
rounded angles of a rectangular. These numeric values represent the distance between the

rectangle lines and the angle of the curve.

The rectangle is rounded, only if you check the Rounded rectangle option and set the X and Y

rounding values more than zero. Enter similar values for both the rounding values.

Below figure shows a rounded rectangle, which has X and Y rounding values as 15.
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Note: You can view the rounded angle only in the output file, not in the XSLfast worksheet.

Bounds

Specifies the size and position of the square. Check the Absolute placement check box to set

Bounds value true.

Borders

Specifies the color, width, and style of the rectangle border. You can set three different styles
of border in one rectangle like: Dashed Dotted, and Solid. Set different width and color of all
the borders in one rectangle. All these are achieved using Left, Right, Top, and Bottom

borders.
To set the border of a square:

Select the square and click Border function. The Borders window appears. Check the required

checkbox and click “Ok*“.

If you uncheck the Border checkbox, all other checkboxes are enabled. This way, you can

change all the borders of a rectangle at once.

Note: You can view the arrangement of intersected squares only in the output file.
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Context Menu

The context menu offers some functions, which are similar to text elements. Refer Context
Menu section of Text element for details.

Bring Forward
Send backward

I Undo: background color red  ctil-Z
3 cut Ctrl-X
Copy Ctrl-C

. Paste Ctrl-v
Background color »

Convert to... »
Locked

Note: Refer Square.xsf under 30_Square, in Tutorial folder, to work on Square.
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Pagination

The Pagination element allows you to display numbers of pages in the layout. It allows you to

create different formats of pagination.

Insert Pagination

To insert a Pagination element on worksheet, select Insert & Pagination menu, click m >
Pagination icon form the toolbar, or press Ctri+Shift+P. Click on worksheet and drag the cursor
point. The Pagination element is inserted. You will see a frame containing a character string in

which N stands for Number.

Edit Pagination

The Pagination editor window, allows the user to format page number. To edit pagination

frame double-click on the frame. The editor window appears.
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PageNumber_1 - Pagination = b4

Text before \ |

Text after ] ' |

Use page numbering "n of K" ]

Separator of

| ok || cancel |

Text before - Option to insert text, before the page number. Here “Page |” is inserted before

the page number.
Text after - Option to insert text, after the page number.

Use page numbering “n of N” - Option to generate the number of the current page and
number of all pages in the layout. For example, if the layout has 10 pages and you are in 7

page, the pagination is displayed as 7 of 10.

Separator - Option to separate current and last page. For example, 7 of 10. Here of is the

separator.

After defining the format click “Ok” button.

Inspector Window

The Inspector window of Pagination element has similar properties of Text element, except the

following options:
¢ Text before
e Text after

¢ Use page numbering “n of N”
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e Separator

These options are already explained in Edit Pagination section.

Refer Inspector Window section of Text element for more details.
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Data | Format | 1 &
| w] Pagehiumber_t vl
Property | Value [
Object name PageMumber_1 i
Locked | -
4 Text <MN>
o Text before B
Text after
Use page numberin... []
Font Font...
Text colar _

Backaround color
4 Frame properties
4 Bounds
4 Absolute position
Left
Top
Width
Helght
4 Paddings
Left padding
Top padding
Right padding
Bottom pad. ..
Qrientation
Border
Horizontal alignment
Vertical alignment
Level
Span
4 XSL-FO options
4 Generate X5L-FO«c,.,
Custom attribut. .,
Custom attribut.,,
4 Generate XSL-FO bl...
Keep together
Custom attribut. .,
Custom attribut.,,
Link Id
Wrap text
Collapse spaces
Linefeed-treatment
‘Whitespace-treatm...

Mormalize spaces in...

[Absolute position: tru...

269 pt
377 pt
113,86 pt
17.1 pt

[Left padding: 0.0 pt; ...

0pt
0pt
0pt
0pt

|0

Border...

| Left

| Top

11

| none

| auto

L

| preserve

| preserve

[
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Context Menu

The context menu options of Pagination element are available in Text element. Refer Context

Menu section of Text element for details.

Bring Forward
Send backward

H cut

Copy

. Paste
Copy as text
Font Family
Font size
Font style
Alignment
Yertical alignment
Text color
Background color
Move texts to one
Convert to...
Generate template

Locked

] ™ Undo: add <fo:page-number/> Ctri-Z

Ctrl-X
Ctrl-C
Ctrl-W

W W | WO | e W

Note: Refer Pagination.xsf under 31_Pagination, in Tutorial folder, to work on Pagination.
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Index and Citation

The Index and Citation elements are used to create index and citation of a document.

Insert Index or Citation

To insert Index or Citation element on worksheet, select Insert 2 Index menu or Insert >

Citation, or click - Index icon or - Citation icon form the toolbar. Click on

worksheet and drag the cursor point. The Index or Citation elements are inserted.

Edit Index or Citation

To edit index or citation frame double-click on the frame. The editor window appears.
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To create an index of the items in a table, you have two buttons in the button bar: Index

and Citation . You need to create two layouts: one for your document, one for your table

of contents.

In the first layout, you need to have a table containing data, which will produce a document
with several pages. This data is grouped to a certain node of your XML data source. The index
will list those items belonging to the node that you grouped the index field to. If you put the
index field into a table grouped to e.g. the node Product, the index will show the products

contained in that node.
Example:

Create a simple table with three columns and one row, just for demonstration. You can use the
XML file from ..\Tutorial\Example_manual. Group the table to the node Product because we
want to see all products displayed in it. Drag the node Report/ProductGroup/Product/Name
from the XML window into the first cell of the table, then open a dynamic image frame in the

second row and set it up to display the product images (group to
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Report/ProductGroup/Product/Properties/img and select the path to the image base). Then
make the table row a little bigger by pulling its bottom boundary line and select the function
Fixed row height, so that the table is guaranteed to extend over more than one page in the
document. The table could look like this now:

FroductG roupiProduct]
Marme} ML Propetiesimg

To create the index you place an index frame into the third table cell. The index we want is

supposed to display the products in the table and the page they are on.

FroductG roupProduct] w T
MHame} o Propediesiimg Trdex 0

You do not need to enter anything into the index frame, just pull it to the right place.

Save your layout file, e.g. with the name table.xsf.

Now create the layout for your Table of Contents page. We also use a simple example here
where we want to have the product and their page number displayed. This layout only contains

a table for the index with one row and two columns:
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Note: You need to set the same XML file as data source!

Drag the node Report/ProductGroup/Product/Name into the first table cell and add a Citation

frame to the second cell. That is all there is to do right now.

Productis roup

roduAio T

Marme}

tation

Save this layout as well, e.g. with the name index.xsf.

Now use the Multilayout manager in the file index.xsf (Refer Process Multilayout section) to

combine these two layouts. Add the two files to the list and generate the layout:

Table J

Table ¥

Table L

Chair A
Chair 8
ChairC
ChairD
CharE
Chair F
Table A
Table B
Tabie C
Table D
Tablz E
Tablz F
Tabl= G
Table H
Table |

Table J
Table K
Tablz L

B DB WWWWWRNRRNRMNR - -
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The result is a five-page document where the last page is the index for the previous four pages,
showing the product name and the page it is on. If you put the file index.xsf first in the list,

the index will be the first page of the document.

This is the general principle to create an index for a document. The index page can certainly

be designed as you like it.

Note: The index frame reads and generates IDs for all the items in the table grouping that it
was grouped to. The citation frame on the index page reads these IDs and assigns these to the

correct pages when the layouts are combined in the multilayout manager.

Inspector Window

Index

The Inspector window of Index is shown below. The Index element has the properties similar to

text element, except the following:
¢ Node - Click this option to open Index Editor window.
e Name - Assign a hame to the Index.

Refer Inspector Window section of Text element for more details.
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loatg l Format 4 F

[ D Index_2 v|
Praperty | Value |
Object name Index_2 =
Locked | I
Node g
Name

Backaround color

4 Frame properties

4 Bounds [Absolute position: tru...
4 Absolute position
Left 269 pt
Top 377 pt
Width 113.8 pt
Height 17.1 pt
4 Paddings [Left padding: 0.0 pt; ...

Left padding 0pt
Top padding Opt
Right padding 0pt
Bottom pad... Opt

Orientation ] v
Border Border...

Horizontal alignment | Left v
Vertical alignment | Top v | = |
Level 11

Span | none v |

4 XSL-FO options
4 Generate XSL-FOc...
Custorn attribut. ..
Custom attribut. ..
4 Generate ¥SL-FO bl...
Keep together | auto -

Custom attribut. ..

Custom attribut, ..

Link Id
Wrap text
Collapse spaces ]
Linefeed-treatment | preserve v |
Whitespace-treatm,.. | preserve v

Mormalize spacesin... [_]
Disable output esca... []
Generate template O

If e

4

ForEach
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Citation

The Inspector window of Citation is shown below. The Citation element has the properties

similar to text element, except the following:
¢ Node - Click this option to open Citation Editor window.
¢ Name - Assign a name to the Citation.

Refer Inspector Window section of Text element for more details.
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loata | Format I

Citation_1

el

Praperty Yalue |
Object name Citation_1
Locked |
Node
Name
Text color —

Background color
4 Frame properties
4 Bounds
4 Absolute position
Left
Top
Width
Height
4 Paddings
Left padding
Top padding
Right padding
Bottom pad. ..
Orientation
Border
Horizontal alignment
Yertical alignment
Level
Span
4 X5L-FO options
4 Generate X5L-FO c..,
Custom attribut. ..
Custom attribut, ..
4 Generate XSL-FO bl...
Keep together
Cuskom attribut. ..
Custom attribut. ..
Link Id
Wrap text
Collapse spaces
Linefeed-treatment
Whitespace-treatm. ..
MNormalize spacesin,..
Disable output esca...
Generate template
If

[Absolute position: tru...
269 pt

377 pt

227.6 pt

17.1 pt

[Left padding: 0.0 pt; ...
0pt

0 pt

0pt

0pt

0 hd
Border...

| Left v
| Top ¥
11

| none - |

O

| preserve v

[ preserve v |
1
O
]

| »

([
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Context Menu

The Context menu of Index and Citation are similar. Its options are already explained in

Context menu section of Tex element. Refer Context Menu section of Text element for more

details.

Bring forward
Send backward

I cut
[ copy
- Paste

Copy as text

Font Family
Font size
Font style

Alignment

Text color

Convert to...

Locked

Yertical alignment

Background color

Move texts to one

Generate template

™ Undo: position/size changes 160,336,113,17 Ctl-Z

Ctrl-xX
Ctrl-C
Ctrl-\f

WO | W | W Y
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Template

With these commands it is possible to create templates representing conditional input for table
cells, depending on defined conditions. Templates and the elements they are called from (Call
template and XSL code frames) do not necessarily have to be part of tables but can also be

independent elements placed outside the actual working sheet.

In the XSLfast tutorial there is an example for this in 06_Template.But, you can also create

your own table to use templates.

This is a simple example for the use of a template: You define the condition that every time
one of three specified manufacture makes a product, its logo should be displayed, and XSLfast
is supposed to pick the correct logo template. You create the templates outside the table as
small independent elements; in this case they are static image frames showing the respective
logo in the size you determine. Then declare them as templates by clicking the check box

Generate Template for each and giving them names, e.g. “Leitz”, “Edding”, and “Pelikan”.

Note: Make sure the templates are not placed absolutely.

There are two ways to call templates in your document. The first one offers more control

possibilities by far but requires XSL skills:

1. Create an XSL frame (where the template should be displayed later) with XSL code in
it, e.g.

<!-- choose the logo of the manufacturer -->
<xsl:choose>
<xsl:when test="contains (ManufacturerName, 'Leitz')">
<xsl:call-template name="Leitz"/>
</xsl:when>

<xsl:when test="contains (ManufacturerName, 'Pelikan')">
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<xsl:call-template name="Pelikan"/>

</xsl:when>

<xsl:when test="contains

(ManufacturerName, 'Edding')">

<xsl:call-template name="Edding"/>

</xsl:when>

<xsl:otherwise>

</xsl:otherwise>

</xsl:choose>

Your working sheet now could look like this:

[progatiras]

This is the XSL code alament

that controls the condition

o vxmm‘ ProduciD | [Descshon) [~ chaosa Tha rchazeiy||
™ . o r APRIRe, (Abe) o
i JOesclong )

T o

And these am the three templates for
the three manufacturers

The templates can be placed completely outside the working sheet.

An exemplary PDF file could now look like this:
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\mage

; o 202001

202002
&

L2000
\’/r

202008

|

ol

&

202010

3

and 202011

202017

202018

202019

\ & AC

Product No. Product descriptian

485

500

| et 0 50

152

@30

150

Every time the manufacturer is one of the three manufacturers you specified before, its logo is

displayed.

2. A fast and simple way but with limitations: Open a “Call template” frame in the table

cell with this button .

inatead of the XSL code element there 15

a Call template clament here

L 9 0
' =5 HProdctin) DescShor ) [-ad 1emgtate dPurchsedn EIT4
— o/ o7 jo y A [Pelban), , BEe) |y 2
> Descloeyg | [
g0 v

The three templates are still there but
only one can be called now,

On double click the frame switches to selection mode.

280|Page



Tem)

f}f;tall template

Call |

Leitz
Pelikan

Edding

Concel |

In the select box all existing templates for this layout are listed. Select the template you want

to display in the frame. The template will be displayed in the Call template element after

processing the layout.

Note: If you choose this method, it is not possible to define a condition on which the template

will be called as it is in method 1 (if the condition is matched, display the correct template - if

the condition is not matched, do not display the template etc.). In this option, the specified

template is always called.

The layout we created the second way looks like this:

é?} 202001
% 202002
/ 202003
P:" L 202002

o=
202006

Leitz block stapler

Cartriage system for the exchange
of clips for different sheet pie
heignis. Ever 3 one-way cartidge
of the leg ‘engtn are provided.
Celor grey. 2 years wamranty.
Newvus block stapler

Block stapier. Low-priced ang
simply serving standard
depariment stapiar.

Newus long stapler

The prefessional document
stapier. complete metal and plastic
shroud, magazine guidance made
of metal. doubis dlip guidance
Skrebba stapler

Cocument stapler, attaching fimy
and solvable.
5Star staple remover

(Serikan © g

(Setikan © o

Foetikan © 23

Gelikan © 2
(Serirean © &
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The same template is called every time.

Note: As long as you do not activate the check box Generate Template belonging to the
element, it cannot be used as a template.

Enter the name of the template in the field Template Name. This name is the name of the
template itself.

In the field Template Parameter you have the chance to enter a parameter that can be
addressed via the Call template function. The template selection dialog then shows the
parameter for the template:

(A — =

Call |Pelikan v

Template parameteris)

Parameter name Data type Parameter value

ABC [Dynamic text (XML) v“ H Edit... J

I Cancel I

This is useful when the called template needs to evaluate a parameter for further processes.
XSLfast also offers to define more than one parameter at the same time by offering a new

empty entry field after each specification of a parameter value.

Note: The menu items in the menu Call template are only available if you checked the check
box Generate XSL-FO block.

Inspector Window

The Inspector window of Template element is shown below:

e Template Name - Assign a name to the template, using Template Name.
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o Parameter name1 and value1- Assign parameter name and value. Refer above section
for more details.

I Data | Format 1 HF

- ) TemplateCall_t v
Property | Yalue |
7O.bjenit name fembléietéli_i ‘
Locked ]
Template name | v

Parameter name 1
Parameter value 1

4 Frame properties

4 Bounds [Absolute position: false]
Absolute position  []
Level 11

4 X5L-FO options
Generate X5L-FO con... [

Generate XSL-FO block  []

Suppress if empty E]

Page break after - Auto v
Break before | Auto bl
Break after | Auto v]
If

ForEach

The other options of inspector window are explained in Inspector window section of Text

element. Refer Inspector Window section of Text element for more details.

Context Menu

The Context menu options of Template are available in Text element. Refer Context Menu

section of Text element.
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Bring forward
Send backward

™ Undo: template parameters Ctrl-Z
3 cut Ctrl-X
Copy Ctrl-C
. Paste Ctrl-v

Alignment
Vertical alignment

Text color
Background color

Templates

v v v Vv Vv Vv

Convert to...
Locked

Note: Refer Template.xsf under 06_Template, in Tutorial folder, to work on Template.
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Line

The Line element is used to draw line, with different line width, style, and color.

Insert Line

To insert a Line element on worksheet, select Insert = Line menu, or click / - Line icon
form the toolbar, or press Ctri+L. Click on worksheet and keep the left mouse button pressed
on the sheet and draw a line in the desired length. After releasing the button the line is visible

on the sheet.

Alter the position by picking up the line with the mouse and pulling it into the new position.
Alter angle and size by clicking on one of the blue squares at each end of the line, keeping the

left mouse button pressed and moving the box up or down or back and forth.

After releasing the button, the line has a new angle.

Inspector Window

The Inspector window of Line element has the following properties:

¢ Object name and Locked - Refer Inspector Window section of Text element.

e Line width - Option to increase or decrease the line width. Double-click the default

width of 1 pt and enter the new width.
¢ Line Color - Option to change the Line Color.

e Pattern - Option to change the pattern of the line. The Pattern has the following

options, select any of them, as per required.
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Patkern: If B

e X1,Y1,X2,and Y2 - X1 and Y1 are the coordinates of the line’s starting point; X2 and

Y2 mark the end point. They can be entered manually but they also change according
to the position of the line.

¢ Generate Template - As all elements, a line element can also be declared as a

template. Use the check box Generate Template.

l Data | Format 1

-/ Lline_t v
Property I Yalue
Object name Llne_l
Locked ]
Line width 1pt
Line color _
Pattern: : hdl|
X1 269 pt
1 377 pt
xe 411.26 pt
Y2 377 pt

4 X5L-FO options

Generate template ]
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Context Menu

The context menu options of Line element are available in Text element, except the following

options:

Line width and Line Color, which are already explained in Inspector Window section.

Refer Context Menu section of Text element for more details.

Bring forward
Send backward

™ Undo: v2 3258.0

K cut

Copy

. Paste
Line width
Line color

Generate template
Locked

Ctrl-Z

Ctrl-X
Ctrl-C
Crl-v
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Table

The Table element in XSLfast, is used to insert a table and provide XML information in a
tabular format, using other elemnts of XSLfast. Table allows to insert any type of element in its
cells. These cells contain static or dynamic data from the XML file. To accomplish this, several
steps are necessary: arranging the frames on the sheet, filling the table, and assigning the

nodes.

Types of Table

There are three types of tables available in XSLfast:
e Normal Table
e Slave Table
e Pivot Table

The functionality of these tables is explained in the proceeding sections.

Normal Table

The Normal table is a table, which consists of XML or static data represented in a table format.

Insert Table

To insert a normal table, click Insert - Table menu, or click E - Table icon from the

toolbar, or press Ctrl+Alt+Shift+T. The Create table window appears.
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Select table type...

() Create atable

Mumber of rows 2

~

Number of columns

(&) Create a table from XML data

Please select which XML nodes you would like to represent the rows of the table

Report{Productgroup
Report/ProductgroupProduct

|A Mew filter... I

The Create table window consists of three sections:
e Row/Column settings
o Header/Footer settings
e Preview

Row/Column Settings

The Row/Column settings allow you to enter number of rows and columns for the table.

¢ Number of rows - Select number of rows.

(Filters / Groupings- -‘ : rExample of selected nodes-
 ghe—
| CdResult:

&4 Productgroup
[ ) Name : "Productgroup 1"
[ 1mg : "prod101051.gif"
1 Product
1 Product
1 Product
1 Product
=1l Product
& Productgroup
1 Productgroup
=1 Productgroup

Back | Next H Finish J| Cancel l
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e Number of Column - Select number of columns.

e Omit empty rows - Check the check box to omit or remove empty rows.

Header/Footer Settings

The Header/Footer settings allow to create header and footer to a table.

¢ Table header - Option to add header to a table.

e Omit header page break
e Table footer - Option to add footer to a table.

¢ Omit footer page break

Group Table

Connecting the XML nodes to the elements on the worksheet to display the XML content, is

called Grouping. Grouping the page or elements to certain nodes of the XML tree, establishes a

connection to specify the path through the tree file to the node containing the data, which you

want to display in the element. As the application reads the XML tree always from the top, this

must be considered in the path to the correct node. There are some factors that influence the

path to the correct node.

XSLfast allows you to group tables for:

e Existing groups

e New groups

Once you set the table properties, click “Next” button.
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Select data columns... 3

Available columns Columns
R ( Name
Product/Name : Img
Product/Description > Product

Product)Img -
Product/Data | ‘ I

*
&
() Place cells from top to bottom
{®) Place cells from left to right
[ Table header
| Omit header page break
| | Add captions
[ Table footer | Add partial summary
| Omit Footer page break | Add accumulative summary
Add summary Repeated content on page 10

~ Back | \ Mext | Finish JI Cancel J

Click any filter from Filters column, and click “Next” button (Using Existing group).

OR

Click “More filters” button to create new filters and assign to table.

XSLfast allows you to group the table in three different ways:

e Group by position

e Filtering

e Group by content
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Group by Position

The Group by position tab, groups the table as per the position of XML nodes:

Grouping properties

Group by position IFiItering || Group by content
Grouping:
4 Report
4 Productgroup
MName
Img
» Product

Auto XPath completion
‘| Relative nested grouping
[T Conditional region {XSL:1IF instead of XSL:FOR-EACH)

Remove grouping JI Ok Il Close J

Example of Grouping by Position

A new layout page is grouped to the top node of the XML file, in our example it is Report. Every
element connected to XML contents, which is placed on the sheet, now shows the path to the

node without Report, for example, ProductGroup/Name.
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E} @' Product
»»»»»» [ Producthiumber
o] Name
[ ProductPrice
=12 Properties
)D Height

If the page is grouped, for example, to the node Report/ProductGroup/Product, the elements
on the sheet now already refer to those nodes contained in Product and show only the name of

the node because the first part of the path is already determined by the page grouping:

= Report
b4 ProductGroup
=) ProductGy

: D ProductPrice
- Properties
{7 Height
] weight
[ Color
Y i

And if an element like a table is itself grouped to a node (in this example it is grouped to
Report/ProductGroup/Product/Properties), the elements placed into the table will only show

the name of the node because the first part of the path is already determined:
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Report

= ProductGroup i
»»»»» [ ProductGroupID

..... D MName

% Product

- Producthumber
[ Mame

: L]
-] ProductPl:V
= Propertie

Of course, it is also possible to place nodes from all levels of the XML file on the sheet or in
tables; XSLfast will automatically add the necessary elements for the right path. This example

is supposed to give you a general idea what grouping is and what it is used for.
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Filtering

If you create a table, most of the time it will be grouped to a node of the XML file. To have

more possibilities using the XSLfast requirement of grouping tables to nodes, you can create

helpful additional nodes in your XML file. These additional nodes are not saved within the

actual XML file. But, they allow you to perform functions, which could not be achieved with

only the regular structure. To do this, follow the steps below:

1. Click Filtering tab.

2. Enter the filter, in the editor.

Grouping properties

Group by position | Filtering IGroup by content I

Grouping:
“Revot Copy subtree
4 Productgroup )
MName Copy from: [Productgroup,fProduct
Img
» Product Productgroup/Product[Name='Product Node Set | Add
BE'] String Update
Boolean
MNumber |  Delete
Date/Time |:Evaluate
Today
Templates
The result of XPath expression.
Auto XPath completion

|| Relative nested grouping

[T] Conditional region {XSL:IF instead of XSL:FOR-EACH)

Remove grouping

Ok | Close |
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3. Click “Add” button to add the new filter.

Grouping properties b3
Group by position | Filtering |Group by content I
Grouping:
Report Copy subtree
4 Productgroup
Mame Copy from: |
Img (
» Product Mode Set add
» =" Skrin
' ProductgroupProduct[Mame="Produd g Update
Boolean
DatejTime
Evaluate
Math
Today
Templates
The result of XPath expression.
4 ll | »
Auto XPath completion

|| Relative nested grouping
[ Conditional region {XSL:IF instead of XSL:FOR-EACH)

[ Remove grouping ” Ok ” Close J

4. Click “Ok” button to group the table to the selected filter.

Now, process the layout. The resulting output is shown below:

[ 459 | Description of product B |

The “Update” button is used to update or modify the groups. Drag a drop the existing groups,
modify the group and click “Update”.
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Grouping properties 23
Group by position | Filkering |Group by content I
Grouping:
4-Report Copy subtree
4 Productgroup
MName Copy from: |
Img
» Product Node Set Add
¥ ProductgroupiProduct{iame = 'Product D'] String Update
Boolean
Mumber
Date/Time
Evaluate
Math
Today
Templates
The result of ¥Path expression.
4| e >
Auto ¥Path completion

|| Relative nested grouping
[] Conditional region {XSL:IF instead of XSL:FOR-EACH)

| Remove grouping || ok || close |

The “Delete” button is used to delete the existing group. Select the group from Grouping

column and click “Delete” button.

The “Evaluate” button is used to evaluate the XPath expression and view the result.
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Grouping properties

Group by position | Filtering | Group by content

Grouping:
“Repsd Copy subtree
4 Productgroup _
Mame Copy from: |ProductgroupfProduct{Name="Product B']
Img =
» Product Productgroup/Product[Name='Pr | Node Set ‘ Add I
oduct B'] String |E
Boolean 8
Number Delete
DateTime ————
Evaluat
M TN
Today
Templates

Result type: NODESET Count:1

CIResult:
& Product
D Name : "Product B

[ 1mg : "prod101052.gif"

D Description : "Description of product B"

<« [ »

Auto XPath completion
Relative nested grouping
["] Conditional region (XSL:IF instead of XSL:FOR-EACH)

Remove grouping

Auto XPath Completion

ok | Close

The check box Auto XPath Completion completes the path to the selected node from the page

level, if checked. If you uncheck this function, the table will not show the complete path from

the page level on but just the node it was grouped to.

For example, group the table to Product node. Check Auto XPath completion. The table

grouping shows the entire path, as Productgroup/Product. Now, uncheck Auto XPath

completion. The table grouping shows only the selected node, as Product.

>raduct]

Check Auto XPath Completion Uncheck Auto XPath Completion
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Relative Nested Grouping

The function Relative nested grouping allows you to have different groupings for rows in

tables in an easy way.

For example, display all product groups in a simple table, with the list of products contained in

them. Use the XML file Demo.xml. Create a simple table grouped to the node ProductGroup.

Drag the node ProductGroup/Name into the first cell and node ProductGroup/Product/Name

into the second cell.

[

Product/Name}

Processing the layout now would produce the following result:

Unterschriften

78l demo-1.pdf

Lesezeichen

Productgroup 1
Product A
Productgroup 2
Product E
Productgroup 3
Product J
Productgroup 4
Product O
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Only the first contained product is displayed with the product groups. Now, right-click the
second row and add Product as the break level. Check Relative nested table function and

Auto-XPath completion check-boxes.

Now, process the layout to view results. All product groups are displayed with their products.
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p8l demno-1,pdf

Productgroup 1
Product A
Product B
Product C
Product D
Product E
Productgroup 2
Product E
Product F
Product G
Product H
Product |
Productgroup 3
Product J
Product K
Product L
Product M
Product N
Productgroup 4
Product O
Product P
Product Q
Product R
Product S

You can also add the line “End of” and display the name of the product group at the end of the
list. Add a break level to the third table row and group it to the node ProductGroup. Make sure
to uncheck the check box Relative nested grouping for this case now, because, the nesting

would refer to its superior node in that place which would be Product.

Now drag the node ProductGroup/Name into the first cell of the third row and double click it.

Enter the words “End of” in front of the node and give the entire text the color red:

301|Page



Enc ofiProducizroupliamer

Rl=

| Condtion
Cokeen: 27, ez 1

Process the layout to display result.
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gl demo-1.pdf

Productgroup 1
Product A

Product B

Product C

Product D

Preduct E

End of Productgroup 1
Productgroup 2
Product E

Product F

Product G

Product H

Product |

End of Productgroup 2
Productgroup 3
Product J

Product K

Product L

Product M

Product N

End of Productgroup 3
Productgroup 4

Lesezeichen

Urterschriften

This is the final result with a nested grouping inside a table.
Conditional region (XSL:IF instead of XSL:FOR-EACH)

Tests whether the selected node or expression exists. It does not display any data. If there is
no matching node or expression, it shows nothing, except in headers and footers. Because, the

function refers to the body and tables and the grouping commonly refers to the body.
The “Remove grouping” button is used to remove grouping of the selected table.

Group by Content

303|Page



The Group by content function supplements filtering, sorting, and grouping of table contents.
It allows you to quickly define a condition if contents should be displayed for example,
together or not at all.

A simple example to demonstrate how group by content can be used. Create a simple table and

fill it with some data, as shown below. Refer Content Settings section to assign content to

table headers.

Repor]

Group by content: Example

Deserption Material

Description

The XML file is also very simply structured:

[z Report
=8 B Product
[ Color

The respective PDF output now would look like this:
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XSKE st
Group by content: Example
IPYosuct Description Matonal Codor
Frocuct A Oescrpion of prodkct A wood green
Procuct B Oescripton of product 8 woed red
Frocuct C Dascrpton of poduct © - wood s
Procuct © Osscrpton of pioduct O steel ™d
Procuct £ Description of product £ steal Qreen
Procuct E Descripton of produtt E shesl biue
Procuct F Descrobon of product F - sheal Qreen
Procuct G Descripton of product G woed Qreen
Procuct H Description of product H
Procuct | Description of product | red
Froouct J Destriphon of product J
Procuct K Description of product K Sras
Frocuct L Descrighion of product L e
Frocuct M Descripion of prodoct M
Froouct N Oascroton of prodict N wood
Product O Oescription of product O
Procuct P Descrpton of product P
Product Q Descrphon of proouct © green
Procuct R Orscrpion of product ]
Procuct S Descripton of product S shep

You can see the data for the products, name, description, material, and color. You can also see
that the products are currently sorted by their name. With the Group by content function you

can now influence the display of these data sets.

Open the Grouping dialog for the table and switch to the tab Group by content:

Grouping properties R
Group by position HFiltering | Group by content |
Grouping:
4 Report Use I Attribute name .|___ Expression I
4 Productgroup [] Img [
Mame [ Mame 0
Img [7] Product i
» Product [7] Product/Data 0
[T]  Product/Description 0
[7] Product{Img 0
[7] Product/Name 0
Auto XPath completion
v Relative nested grouping
[7] Conditional region (%5L:IF instead of XSL:FOR-EACH)
_ Remove grouping 4] ] Ok I | Close J
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In the right frame you can see all nodes contained in the node Product, where we grouped the

entire table to. Every node listed here offers a selection of expressions. To view these, click

the [] symbol in the column Expression. For example, for Color, select Color from Attribute

name column, and then click the double arrow symbol to open the expression overview:

|| Relative nested grouping
[] Conditional region {%SL:IF instead of XSL:FOR-EACH)

Grouping properties &3
Graup by position | Fikering | Group by content
Grouping:
4 Report Use | Attribute name { Expression . i
4 Productgroup ] Img [ ¥
Name [ mame Sort order »
Img [ Product
» Product [[] Product/Data S fko
[[] Product/Description O Custom
[] Productfimg [] prod101051.gif
[] Product!Name D prolelOS?.glf
[ prod101058.gif
O xPath
[
Auto ¥Path completion

| Remove grouping l | Ok ” Close ]

The function Auto has the effect that you only have those data sets displayed, which actually

possess a value for this attribute. In this case the values for color:
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IProduct

Product A
Product E
Product F
Product G
Product Q
Product B
Product D
Product |

Product C
Product E
Product L

Group by content: Example

Description

Description of product A
Description of product E
Description of product F
Description of product G
Description of product Q
Description of product B
Description of product D
Description of product |
Description of product C
Description of product E
Description of product L

Material
wood
steel
steel
wood

wood
steel

wood
steel

XSEE St

Color
green
green
green
green
green
red
red
red
biue
hiue
biue

The current sorting type is neither ascending nor descending, but both are certainly possible.

Select Sort order: ascending:

Expression

[ Mode auto, sort: ascending ]

1
¥

Sort order: none

® Auto

® Sort order: ascending

Custom

The result:

Sort order: descending

(W]

Group by content: Example

IProduct

Product C
Product E
Product L
Product A
Product E
Product F
Product G
Product Q
Product B
Product D
Product |

Description

Description of product C
Description of product E
Description of product L
Description of product A
Description of product E
Description of product F
Description of product G
Description of product Q
Description of product B
Description of product D
Description of product |

Matenial

wood
steel

wood
steel
steel
wood

wood
steel

XSEE St

Color

hiue
biue
blue
green
green
green
green
green
red
red
red
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The Sort order: descending has this effect:

Group by content: Example

IProduct Description Materiai Color
Product B Description of product B wood red
Product D Description of product D steel red
Product | Description of product | red
Product A Description of product A wood green
Product E Description of product E steel green
Product F Description of product F steel green
Product G Description of product G wood green
Product Q Description of product Q green
Product C Description of product C wood biue
Product E Description of product E steel biue
Product L Description of product L biue

XSEE St

For example, you can also specify that you need to display only green products:

(= Akkribuke name
O

Data
Description
Irng
Material
Mame

)

The result:

Expression

[ Mode custom: green, sort: none] F

Sort arder

¥

Auko

& Cusktom

green
[ ]red
[ blue

*Path
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Group by content: Example

Product

Product A
Product E
Product F
Product G
Product Q

XSEE St

Description Matenal Color
Description of product A wood green
Description of product E steel green
Description of product F steel green
Description of product G~ wood green
Description of product Q green

If you only want to display those green products made of wood, add one more attribute to your

Group by content rule:

The result:

Llsel Atkribute name | Expression
[w] Colar [ Mode custom: green, sort: none]
[] Data [
[] Description [
L] Img 0
.EI [ Mode auto, sort: none ] - 4
L] Mame Sork order ]
Auto
& (Cuskam
[w] wood
[ ] steel
xPath

Group by content: Example

XSEE st

roduct Descriphon Materad Color
Proguct A Description of product A wood green
Proguct G Descriphion of product G wood green
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The Group by content function is very convenient to filter and sort data to achieve the display
you need. All attributes can be combined, even attributes, which are not actually used in the
table, can be used to group and sort the data.

In case, you cannot achieve the result you need with the options offered in the dialog, you can
also enter XPath expressions into the entry field.

After making all entries, click “OK” button to apply, or click “Close”.

Once the grouping is done, the next step is to define the content for headers. Click “Next”

button to open Content settings window.
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Content Settings

The Content settings window allows assigning XML nodes to the table.

Select data columns... b3
Available columns Columns
B ( MName
ProductjMName Img
Product/Description > Product
Product/Img
Product/Data ' ‘ I
*
4
() Place cells from top to bottom
(®) Place cells from left to right
[ Table header
| Omit header page break
| Add captions
[ Table footer Add partial summary
Omit Footer page break Add accumulative summary
Add summary Repeated content on page 10
| Back || mext || Finish || cancel |

The Build table content check box, allows assigning XML nodes to the table. If you uncheck

this option, the lists are disabled.
The left list contains all the XML nodes of the selected grouping.

Select any node from the left list and move them to right list using navigation keys. The nodes

in right list are assigned to the table.
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<
=
Up

Down

Move selected left
Move selected right
Move all left

Move all right

Option to re-order
the nodes

Combo-boxes Place cells from left to right and Place cells from top to bottom lets you choose

a scheme for placing objects in the table.

The Add captions and Add summary properties require Table footer and Table header

properties, respectively, in the first tab to be checked.

Add partial summary and Add cumulative summary require Saxon extensions to be enabled

which is be performed in the Preferences window.
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XSLtast preferences

b3

DGonoraI options

| Wiew options

| Jadditional options

[ Jperformance options
[ compatibility options
| st output settings
[ Jxspfo10 settings

[ sy settings
CdDafault settings

XSL output settings
[ 7] %8LT 2.0 Features enabled
[v] Use 5YG graples lor lines
|| Include Java-Namespaces (possible problems with non-Java XSLT systems)
(V] Prafer CMYK color space If possible
|V Use selacted unit of measures in XSL output
[ Paint cropmarks
|| Use bookmarks
Ploase use "Extra/Generate font metrics" to apply font smbedding options,

{v| Embed fonts
|| Embed all fonts, alsa Base-14 (necessary for PDF/A)
[v| Create separate block elements for empty lines

XSL output encoding
[
‘ | UTF-a - w
[ Default XSL-F0 processor

‘ [ FOP 1,0

vH

|_ok || cancel |

For an accumulative summary you have to define the number of nodes per page to be printed.

IV Add accumulative summary

Repeated content on page

.@

Click “Finish” and drag the mouse on the worksheet to insert a table.
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Productaroup|
Mame Product/Name

MName} ProductiNam
£}

kxsliftest=" kxsliftest="

Name I=""> Product/Name
000 to| #EA0.00 to
number(surry  number{surr§repeatCounterd = 0 or posiion( = lastq)

You will notice that the table consists of two parts: the table rows and columns with the table
cells, all colored in blue, and the table frame which may be bigger than the actual table and

even extend over the boundaries of the sheet.

The bigger table frame gives you access to single table rows and table columns. The table cells
should not be extended over the edge, because, they will not be entirely visible after the

generation of document.

Black dotted vertical lines mark the columns; the black horizontal dotted lines mark the rows.
To select columns or rows, click the left mouse button inside the desired part. The selected

parts are colored. To select the entire table, click the bottom right cell of the table frame:

The table above is grouped to Productgroup.

Inspector Window

The properties of Table element is shown in Inspector window.
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If

Data Format | 1 F
] FH Table_4 - |
Property Yalue |
Object name Table_4 -
Locked | '
4 Table
Grouping Grouping is not specified
Background image
Background color
Omit header page b... []
Omit Footer page br... []
Logical style | Select style v
Row properties | v
Column properties [ v |
4 Frame properties
4 Bounds [Absolute position: tru...
4 Absolute position
Left 483 pt
Top 256 pt
Width 522 pt
Height 110 pt
4 Paddings [Left padding: 0.0 pt; ...
Left padding Opt
Top padding  Opt =
Right padding Opt
Bottom pad... Opt
Orientation |0 v
Border Border...
Collapse border |
Harizontal alignment | Left v
Yertical alignment | Top v
Level 10
Span | none v
4 XSL-FO options
4 Generate XSL-FOc..,
Custom attribut. ..
Custom attribut...
4 Generate XSL-FO bl...
Keep together | auto v
Custom attribut...
Custom attribut...
Link Id
Generate template ] —
-
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Object name and Locked

These options are also available in Text element. Refer Inspector Window section of Text

element, for details.

Default cell border

Creates borders around each table cell. Click Border... to set the border width and the color.

Note: Due to renderer limitations, the Default cell border applies only to table cells, which
are filled after the function was activated. All previously filled cells will not display a cell
border. So, if you want to have a default border around all table cells, you need to set this

property before you start filling the cells.

Grouping

Usually a table is grouped to a node from the XML tree. The grouping is displayed in the field
Grouping and can also be modified there. If you click Grouping option in inspector window, the

Grouping Properties window appears.

You can manually enter the nodes in this option, only if you check Use simple filter dialog in
inspector option. Click Tools 2> Preferences - Compatibility options 2 Advanced and check
Use simple filter dialog in inspector option. This selection, allows you only to enter the nodes

manually.
To select the nodes from Grouping Properties window, uncheck this option.
Use alternate color

You can create a table with many alternating background colors for the table rows.

Note: You can assign alternate colors, only if the table is grouped to XML node. If the table is

not grouped to an XML node, Use alternate color option is not available in inspector window.

By default, there are only two alternate colors Color1 and Color2. Click on these options, the

Text color window appears. Select the color and click “OK” button. By default, the two
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alternating row colors are set to white and grey, meaning that in a generated PDF one row will

be colored in white and the other one in grey.

To add more alternate colors, click Tools 2 Preferences - Compatibility options

> Advanced, check Use advanced alternate colors wizard, and click “Ok” button.

Click AlternateColors option under Use alternate color. The Alternate colors properties

window appears.

Alternate colors properties =2

Colors | Up l
[ SS———————

‘ “ | Down |
I
=~
s
|

Aadd Jl Change || Delete
[ Ok l[ Cancel I

To change a color, select the color and click “Change” button. The Text color window appears.

Select the color and click “OK” button. The selected color is changed.

To add more colors, click “Add” button. The Text color window appears. Select the color and
click “OK” button. The selected color is added.

To delete a color, select the color and click “Delete” button. The selected color is deleted

from the Alternate colors properties window.

To change the order of the colors, select the color and use “Up” or “Down” buttons.
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Sort
The Sort option allows you to sort the contents of the table, as per the expression.

To enter a sort expression, double-click on Sort expression option and enter the expression
manually.

To enter many sort expressions, click Tools » Preferences - Compatibility options >

Advanced, check Use advanced sort wizard option, and click “Ok” button.

Click Sort option in inspector window, the Sort properties window appears.

Sort properties ¥
4 Report y Attribute name Sort arder Data type Case order | Recent XPaths
4 Productgroup Node Set
Name String
Img Hoolwan
» Product Number
Date/Time
Math
Today
Tamplates
Add
Deolote
™ P
[ ok || cancel

You can sort the table by a node, which is not currently a part of the table, but must be

contained inside the exact node the table is grouped to, no subordinated nodes.

To add sort expression click “Add” button. The Sort properties window appears:

Enter name in Attribute name field, according to which you would like to sort.
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Note: Consider the table or row grouping, because, the attribute name should be written

correctly according to this grouping.

In the select box Sort order you specify the Ascending and Descending order for your sorting:

Sort order Ascending L]

In the Data type combo box you can choose Text, Numeric, and Custom QName but not
NCName types of data:

Data type Text L‘
MNumeric

<Custom QMame but not NCMame =

Note: It is possible to use the type “Text” for nodes, which contain only numbers. But, the
numeric data (considered as Text) are sorted alphabetically, for example, if you have numeric
data like 3, 2, and 10. The sorted result will be 10, 2, and 3.

However, it is not possible to use the type “Number” for nodes containing text or text and

numbers.

In the select box Case order you specify Lower first and Upper first sorting modes:

Case order ]Lower first L,

IUpper First |

Note: The case order choice will work only with the “Text” type.
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After setting all the properties, click “Add” button to add the attributes. The sorting attribute
is displayed in the Sort properties window. There are two columns - in the first column there is
the Attribute name, in the second column there is the Expression containing all the settings
you have made here.

It is possible to enter more than one sorting mode:

Sort properties B4
4 Report : Attribute name | Sort order \ Data bype [ Case order | Recent XPaths
4 Productgroup Name Descending Text Upper first Node Set
Name Img Ascending Text Lower First String
Im
9 Product Descending Text Lawer First Boolean
4 pProduct N
Name Product/Description Ascending Text Upper first e
e DatefTime
Description T
Img
Data Today
Templates

| add |
| Delete I

e

() (e

To delete the sort attribute, select the sort attributes and click “Delete” button.

To edit the sort attribute, select the sort attributes and click “Edit” button. The Sort
properties window appears.
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For example, use Example_Manual.xsf from Tutorial\10_Example_Manual. It contains a

table with seven columns and two rows grouped to Product.

Spring Collection

Example 10

B

HProducth
| umber}

Price in §

ProductPri

ce}

Height

{Properties
IHeight}

W sight

{Properti

Af i b
esielgn

{Properties’ | & Propertiesimg
Colar}

t}

Now, process the layout. The generated output appears as shown below:
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Example 10

Spring Collection

Now, set sort property to Product Name.

Now, process the layout. The Product Name is sorted in descending order.
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Example 10

Spring Collection

Background Image and Background Color

Tables can also be given background images and colors. With Background image you can assign
or remove a background image to the entire table. Background color specifies a color for the

table, which can be set back to default with Back to default.

Note: The use of alternate colors will overwrite a background color or a background image.

Omit Header/Footer page break

These options display header and footer of a table only in the first or last page.
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If you use a header or footer for a table in a multipage layout, and you do not want to see

them in your table on every page of your document but the header only on the first page and

the footer only on the last page; use the functions Omit header page break or Omit footer

page break.

Omit empty rows

This option omits or removes empty rows from a table.

Logical Style

This option is used to apply styles to table. Refer Create Table Style section for more details.

Row Properties

The Row properties drop-down allows you to select rows and displays more properties of rows.

Bl Row properties

Fixed row height
Row height
Background image
Background color
Grouping

Keep with next
Keep with previous
Keep together
Omit empty rows
Logical style

1

1 i |
12

30 pt

Mo image selected I

23 s |

Select stule =

Fixed row height

Assign a fixed height to the row, using Fixed row height.

Row height

Enter a value in Row height filed or drag the row to the height you want with the mouse. The

Row height is set.
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Background image
Assign a background image to a table row, using Background image.
Background color

Assign a background color to the table row, using Background color. Use this option, if you do

not want to use the Alternate color function for the entire table.
Grouping

Similar to grouping an entire table to a node, it is also possible to group single table rows to
XML nodes. This helps for a broader control of the output of the table. The grouping of rows,
also offers you more sort options for the contents of the row. Refer Group Table section for

more details.

Note: It is not only possible to add groupings to table rows consecutively. The string "../"
moves you one level higher from the current grouping level (two levels higher in the structure
require the string twice and so on). The name of the next lower level and the slash move you

one level lower.

Keep with next/previous

These functions help you to specify that the selected row will not be separated from the

next/previous row in a page break.

Keep together

This function keeps the selected row, together with the other rows.
Omit empty rows

This option omits or removes empty rows from a table.

Logical style
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This option is used to apply styles to row. Refer Create Table Row Style section for more

details.

If

The If option is used to set condition for the row. Refer Inspector Window section of Text

element for details.
Column properties

The Column properties offer the possibility to enter a value for the Column width. Of course,

it is also possible to determine the width by dragging the column to its desired size.

The Frame properties and XSL-FO options are already explained in the Inspector window

section of Text element. Refer Inspector Window section of Text element for details.

Context Menu

The context menu options of Table element are available in Text element, except the options

mentioned below.
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Bring forward
Send backward
Gfoﬁpiﬁds
b Undo: use alternate colors true
5( Cut
) copy
. Past.e'

Row
Column
Cell

Table header
Table footer

@ Add slave table
Bado;round .image
Background color
Roll cells to nested table
Fix kable layout
Set all borders. ..
Generate template

Locked

Chl-Z

Ctrl-X
Ctrl-C
Ctl-\f

v v v v w

¢ Row - Sets the properties of a row.
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Bring forward
Send backward
Groupings >
™ Undo: use alternate colors true  Ctrl-Z
3¢ cut Ctrl-X
Copy Ctrl-C
‘ Paste Ctrl-W*
Row DKE% Add row after
Column »| & Add row before
Cell > 2B Remove row
Table header ’( Keep together »
Table Footer 4 Keep with previous »
&% Add slave table : Keep with next 3
Background image bi Fixed row height
Background color > Background image  »
Roll cells to nested table Background color
Fix table layvout . Convert to...
Set all borders... Mowve up
Generate template Mowve down
Locked Split
S .

e Add row after - Adds a row after the selected row.

¢ Add row before - Adds a row before the selected row.

¢ Remove row - Removes the selected row.

¢ Move up and Move Down - Option to re-order the rows.

e Split - Option to split the merged rows. This option is enabled, only if you join two
or more rows. It is enabled, whenever any cells in the row are spanned over more

than one row actually.

e Join - Option to join two or more rows. This option is enabled, only if you select

two or more rows.

Refer Inspector Window section, for Keep together, Keep with Previous, Keep with next,

Fixed row height, Background Image, and Background color details.

e Column - Sets the properties of a column.
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Brinéif-‘(;rwarai
Send backward

Groupings >
™ Undo: use alternate colors true  Ctil-Z
1 9¢ cut Ctrl-X
Copy Ctrl-C
DB Paste Ctrlw
: Row >
Column )" B Add column after
Cell " F Add column before
Table header »| B8 Remove column
i Table footer )‘ B a G AR
EE) Add slave table \ Add to existing summary
] Background image > Replace summary
Backaround color > Add a new partial summary

Roll cells to nested table ‘ Add to existing partial summary

5 Replace partial summary
Fix table layout

Add a new count
Set all borders...

Generate template
{ Replace count
Locked e

Add to existing count

e Add column after - Adds column after the selected column.

e Add column before - Adds column before the selected column.

¢ Remove column - Removes the selected column.

¢ Add a new summary - Adds summary to a selected column.

¢ Add to existing summary - Updates the existing summary.

e Replace summary - Replaces the existing summary.

¢ Add a new partial summary - Adds a new partial summary.

¢ Add to existing partial summary - Updates the existing partial summary.
¢ Replace partial summary - Replaces the existing partial summary.
e Add a new count - Adds count to the selected table.

e Add to existing count - Updates the existing count.

¢ Replace count - Replaces the existing count.

e Cell - Sets properties of a cell.
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e Background Image - Sets a background image to the cell.

e Background color - Sets background color to the cell.

¢ Cell border - Sets cell border color.

o Split cell - Splits the merged or joined cells.

e Join cell - Joins two are more cells.

¢ Table header - Adds or removes table header.

e Table footer - Adds or removes table footer.

¢ Table grouping - Groups the table to the selected node. If you select this option

Grouping properties window appears. Refer Group Table section for more details.

¢ Remove table grouping - Removes the table grouping.

¢ Add slave table - Adds slave table to the selected table.

¢ Roll cells to nested table - Arrange the cells in selected rows and columns of the
nested table. To do this you need to select a column and a row, or a set of

rows/columns, and the cells that are within the crossing would form a table.

o Fix table layout - Check this option to align or fix the table frame to the borders of the

tables and set property ‘Fixed row height’ true for all of the table’s rows, too.

............................................................

Uncheck Fixtable layout Check Fixtable layout

¢ Set all borders - Sets all the borders of a table to single color and width and style.
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Insert Other Elements in Table

XSLfast allows to insert other elements inside a table cell. The handling of these elements is

identical with the elements inserted outside a table.
The major two elements, which are frequently used in table are text and Image.
Insert Text Element in Table

Moving the horizontal and vertical lines modifies the size of the table cells. Move your mouse
over a line until the cursor turns into a double arrow. Now pick up the line and move it to the

desired position.

To create a field containing text information click on the icon “Text“ and open a frame in the
desired cell, in table, header or footer. You will see a text frame containing the word "empty”

appear in the cell:

1 fempty)
o T &

The handling of these text frames is identical with the text frames outside a table. Double click
the frame to enter the text directly into the editor or drag and drop an XML node into the right

frame to make a connection

For your convenience, it is also possible to directly drag XML nodes into a table from the XML
tree. Select a node from the XML data source on the left side, click on it with the mouse, keep
the mouse button pressed, and drag the node into the table cell where you want it to be.

Release the mouse button. You will see that an XML frame has been placed in the cell, but now
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it already shows the node name including the correct path up or down the XML structure,

depending on where you grouped the table to.

A B
1 Produmgroup.l'ProductJNam;{
Lo T

sLIU J

Note: XML elements display their content in curly brackets, whereas static text does not
display any automatic brackets. The curly brackets inside text elements are usually used to
indicate XML nodes or functional elements. It is nevertheless possible to write static text in
curly brackets, these text parts will then be displayed in a box with a blue dotted line around it

in the text editor window:

B s s [

AXRES w=n v el vu v BIUNAESs=
4 Reprt e
4 rodigos ’
tere
Er
¥ Produdt

This effect does not influence the display in the output, however.
If you would like to add XSL code to control table cells, use the icon “XSL code”.
Insert Image Element in Table

To insert a constant image into your table, click the icon "Image (static)" and open a frame in

the chosen cell after that. An empty frame appears in the cell:
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10 T

Double click the field and enter the image path of the desired constant image.
The handling of static image frames in tables matches the handling outside of tables.

It is not possible to drag a node containing image information from the XML tree into a table
cell. You can however, insert a Text element by dragging a node into a cell and convert it to an

Image through Convert option (either from Context menu, or from Editor window).

Create Table Style

You can create your own table style, using style editor window.
To create a table style, follow the steps below:
1. Click Edit & Styles. The Logical styles editor window appears.

2. Click “New Table” button. The Table logical style editor window appears.
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Table logical style editor £

Settros  Advanced |
-Style properties -

Parerk style  Ho Sivle -

| select badgoundimage |

Remove dackground imags

| Sekdt background color_ |

3. Enter a unique name in Style name field.

Note: Do not enter an existing style name.

4. Select parent style from Parent style drop-down, if required.

5. Select background image or background color, using “Select background image” or
“Select background color” buttons.

Note: This step is optional.

In Advanced tab, you can set the Frame properties.
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Table logical style editor X4

Settings | Advanced

Property | Yalue
4 Frame properties

Horizontal alianment | Right

Vertical alignment Top

‘E Cancel

6. Click “Ok” button to create a table style.

The created table style is now available in Logical styles editor window and in Logical styles

option, under inspector window.

Create Table Row Style

To create a table row style, follow the steps below:
1. Click Edit > Styles. The Logical styles editor window appears.

2. Click “New Table row” button. The Table row logical style editor window appears.
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Tshin row bgacel style editer %]

[ |
Style properties
Stykk naew
Faent gyle  NoShyle -
Formatting
Preview Keep with next
" hest
T st wichn bne
[7] Nt sty cohrn
7] Nest withan page
Levp with prevwos
[7] Praicus sthin Ine
[] Prevscus within coburn
[ Privicus sithin page
| Seisct hadroundmage | Semive bsdposd mage | Selet background coke

| ok || conca

3. Enter a unique name in Style name field.

Note: Do not enter an existing style name.

4. Select parent style from Parent style drop-down, if required.

5. Select background image or background color, using “Select background image” or
“Select background color” buttons.

Note: This step is optional.

6. Use Keep with next and Keep with previous check-boxes, if required.

7. Click “Ok” button to create a table row style.

Similar to table style, the created table row style is now available in Logical styles editor

window and in Logical styles option of Row properties, under inspector window.
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Create Table Cell Style

To create a table row style, follow the steps below:
1. Click Edit > Styles. The Logical styles editor window appears.

2. Click “New Table cell” button. The Table cell logical style editor window appears.

Tahla cell fogical style odior O

Styfe pruperties

Style name

Parerk style Mo Siyie -

Formatting

Preview — e
Seiect bachground mage
Ramove Background mace
Selnct background coloe
| ok I‘ Cancel

3. Enter a unique name in Style name field.

Note: Do not enter an existing style name.

4. Select parent style from Parent style drop-down, if required.

5. Select background image or background color, using “Select background image” or

“Select background color” buttons.

Note: This step is optional.

6. Click “Ok” button to create a table cell style.
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Similar to table style, the created table cell style is now available in Logical styles editor

window and in Logical styles option of Cell properties, under inspector window.

Note: Refer table1.xsf, table2.xsf, table3.xsf, and table4.xsf, under 22_Table, in Tutorial

folder, to work on Table.
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Slave Table

The Slave Table element is used to add a slave table to a parent table. The pre-requisite of a

slave table is to have a parent table. Select a table and click & > Add slave table icon, from
the toolbar or right-click the table and slecet Add slave table option from the context menu.

The Create table window, similar to the normal table wizard appears.

Select table type... 2

() Create a table
Number of rows 2

Number of columns 2

() Create a table from XML data

Please select which XML nodes you would like to represent the rows of the table

Filters / Groupings 4 -Example of selected nodes
» —
Report/Productaroup)Product dResult: -
4 Product

[ Mame : "Product "
D Description : "Description of product A"
[ 1mg : "prod101051.gif"

=1 Product

= Product

=4 Product

=1 Product

=3 Product

= Product

=1 Product

=1 Product v

I

| New filter ... l

Back | Mext Il Finish ]| Cancel ]

The functionality of slave table is similar to normal table. Refer Normal Table section for more

details.

After you set necessary properties and click “Finish” button, a slave table is added to the
layout. It is placed outside the sheet to the right from the parent table. The slave table is
created as a template and a Template Call object for it is placed in the parent table, in the
intersection of the rows and columns being selected, or in the first available cell, if none is

selected or current selection is somewhat inappropriate for adding objects.
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The inspector window and context menu of slave table is similar to normal table.
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Pivot Table

Pivot table is data summarization table, which automatically sorts, counts, and totals the data

stored in the one table and creates another table displaying the summarized data.

Insert Pivot Table

To insert pivot table click Insert - Pivot table, or click E - Pivot table icon from the
toolbar. Click on worksheet and drag the cursor point. The Pivot table is inserted. By default,
the pivot table is created with one row and column. The rows and column can be added

through buttons in the toolbar or menus.

1 row anid 1 column:

...................................

There are two ways to add data to pivot tables. You can drag and drop elements into
row/column cells or pivot table body, or with a double click in a cell you can call an editor and

select the cell value in it. The object will be added to the cell simultaneously.

Inspector Window

The properties of Pivot table inspector window are available in Table element inspector

window, except the following properties:
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Show values as - The Show values as drop-down has the following options:

¢ Quantity view - The amount of objects is printed in the body.

Occurrence view - A mark is printed in a cell if any amount of objects is found. An
additional property Occurrence mark is available when this view is selected. Select the

Occurrence mark that has to be displayed.

Show values as Occurrence view |
Occurrence mark X 2
“~
o
:
K
.
a v

¢ Quantity for non-numbers view - If the value of the cell is non-numeric the

amount of object or their sum is displayed.

e As is (plain) view - The plain value of the object (the first available during XML

parsing if they are more than one) is printed.

e Summary view - The sum of values are displayed.

o Percentage view - The portion of total amount of values in the current row is

displayed in percentage.

Use grand total summary - If this option is enabled grand total columns and rows are
added to the table. Use grand total summary and Grand total text are available only

for Quantity, Quantity for non-numbers, Summary, and Percentage views.

Grand total text - Option to specify titles for grand total columns/rows. This option is

available only if Use grand total summary is enabled.
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e Use Labels - If this option is enabled labels are added to title columns and rows. By
default, node names are used as labels. For example, in the below figure, the Grand

total text is specified as Total and the Use Label is checked.

Use grand total sum... v
Grand total text Tatal:
Use labels v

If you process the layout, the text Total: is displayed.

_ Maerial

£ 10000
£10135  €10135

£ 10200 € 108,00

€900 €00

: 10400 £ 10400
£12305 £12308
£100,00 £ 10000
€390 €20.00
£100,00 £ 10000
£101,00 € 10100

£103,00 € 108,00

£980,00 €980 £1.07300

£10400 £ 10400
£12300 € 12300

£100.00 £ 10000
£80.00 €290

10000 € 10000

€245 €£2%34

£500,00 £50000
€ 10100 £ 10100

£103,00 £103,00

100,00 € 10000

£30.00 €2900

€1230C € 12300

L Total, = 1.11605 €129300 €4R00 €60700 £47060 £3.07874

This property can also be changed for each cell separately. To change this select a cell and edit

the value of Parent table > Cell properties > Use cell label and Cell label in Inspector.
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B Parent table
& Cell properties
Use cell label
Cell label

Material

v

¢ Column/Row sort attribute - Rows and columns may be ordered according to

expressions in Columns sort attribute and Rows sort attribute. Refer Inspector Window

section in Normal Table for more details.
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Data Format {5

"B PivotTable_t v
Property [ Value |
Object name PivotTable_1 &
Locked O
4 Pivot table

Default cell border Border...

Title column width 80.0

Title row hight 30,0

Show values as [ Quartity for non-n... ¥ |
Use grand total su..,

Grand total kext

Use labels O

Columns sort attribute ..

Rows sort attribute ..

Backaround image

Backaround color

Logical style Select style v

4 Row propetties L1 ¥ ]
Row height 30pt =
Column properties -

4 Frame properties

4 Bounds [Absolute position: fals...
Absolute position []
4 Paddings [Left padding: 0.0 pt; ...

Left padding Opt
Top padding  0pt
Right padding 0 pt
Bottom pad... 0pt

Orientation 0 v

Border Border...

Collapse barder O

Hotizontal dlignment  [Left  w|
Yertical alignment Top -
Level 11

Span Tnone v -
4 %5L-FO options

4 Generate X5L-FO c...
Custom attribut. ..
Custom attribut. ..

4 Generate ¥SL-FOBI...
Keep together auto v
Custom attribut...

Ciskam akbribob
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Context Menu

The Context menu options of Pivot table are available in Context menus of Text and Table
element, except the Switch axes option. Refer Context Menu section of Text and Context Menu

section of Table element, for more details.

e Switch axes - Option to change row to column and viceversa. The content of rows and

columns also switch along with rows and columns.

Ering forward
Send badhward
WP Undo: postonysze changes 72,245,522,80 T2
p 4 oK
B oy oe
B e SH
Row )
Cobmm )
el )
Badhgrownd mae )
Badhground cobor )
Swbch aes
Comvertto... ]
Generaie fempizte
Locked

Note: Refer Pivot_Table.xsf under 43_Pivot_Table, in Tutorial folder, to work on Pivot
Table.
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Choose

Choose element is used to select a single value out of the XML node set, based on the specified

condition.

Insert Choose

To insert Choose element on worksheet, click Insert - Choose menu, or click i1 - Choose
icon form the toolbar. Click on worksheet and drag the cursor point. The Choose element is

inserted.

Edit Choose Element

The Choose editor, allows you to select an XML value, based on the condition set. To edit
choose element double-click the element or click Edit... option in inspector window. The editor

window appears.
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Choose_1 - Choose E =

4 Report

4 Productgroup | |Dynamic Productgroup/Name

» Product

Type | Yalue [ Expression

Color | Background | Recent XPaths

Mode Set
String

Mame

Dynamic ProductgroupfImg
Img

Dynamic ProductgroupProduct Boolean
Mumber
DatefTime
Math
Today

Templates

Add

| Delete

Up

| Down

Lok J [ concel |

This window, allows you to set conditions to the XML values.

Type - Defines the type of the value printed. The Type field consists of following
options:

¢ Dynamic

e Static

e Template call

Value - Specifies the value to be displayed in the output file.

Expression - Sets the condition for the values. The values are displayed depending on

the condition.

Font, Color, and Background - Specify the value font, color, and background color
respectively.

Add - Adds new value.
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Type l Yalue l Expression

Font Color  |Backgroung

Dyna... ¥ |Product;’DescShort DescShort="flat scre...
Dyna... ¥ lProducthescLong DescShort="printer'

Dyna... ¥ lProductj'DescShort

Arial

Bookman CI_
Arial -

o Delete - Deletes the existing value.

¢ Up and Down - Moves the values up and down.

Inspector Window

The Inspector window of Choose element has similar properties of Text element. Refer

Inspector Window section of Text element for details.
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Data | Format &

| 11 Choose_1 - |
Property | Value |
Object name Choose_1
Lacked [
Text Edit...
4 Frame properties
4 Bounds [Absolute position: true;...
4 Absolute position
Left 269 pt
Top 377 pt
width 100 pt
Height 30 pt
4 Paddings [Left padding: 0.0 pt; T...

Left padding 0pt
Top padding 0pt
Right padding 0Opt
Bottom padding 0 pt

Orientation o hdl|
Border Border...

Harizontal alignment | Left -
vertical alignment | Top -
Level 11

Span | none -

4 XSL-FO options
4 Generate XSL-FO con...
Custom attribute ...
Custom attribute ...
4 Generate XSL-FO block
Keep together | auto -

Custom attribute ...
Custom attribute ...

Link Id
Wrap bext
Collapse spaces O
Linefeed-treatment | preserve -
whitespace-treatment | ignore-if-surroundin... v |
Mormalize spaces insi... []

Disable output escaping [
Suppress if empty [
Generate template [
1f

ForEach
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Context Menu

The context menu options of Choose element are available in Text element. Refer Context

Menu section of Text element for details.

Bring forward
Send backward

I Undo: position/size changes 152,280,100,30 Ctd-Z
p | CHlX
Copy Ctil-C
. Paste Crl-v
- Copy as text

Fant Family
Font size
Font style

Alignment
Yertical alignment
Text color
Background color

v v v v w w W

Move texts to one

Convert to.., ]
Generate template

Locked

Sample Example

This section provides an example to use choose element.
Example 1:

1. Open a new layout.
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2. Select Demodata_en.xml as the source data.
3. Insert a Choose element.

4. Set ForEach property, in inspector window, as ProductGroup/ProductGroup.

frogu ciGrou EJIPro ductG rougp

5. Open the editor window.
6. Add three dynamic values.

7. Set their values to Product/DescShort, Product/DescLong, and Product/DescShort
respectively.

8. Set the Expression values to DescShort="flat screen (pc)’, DescShort="printer’, and

leave Expression empty for the third value.
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“ Rogort
+ Productproun

9. Click “Ok” button.

oductiDescShort Product/DescLong Product/DescShof, -

ProductG roup/ProductG roup]

10. Process this layout. The generated output is shown below:

i

]
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BELINEA 101705 TFT 17.0° ANALOG+SPEAKT 18
'

p . £
Lioyd Men's shoe Basra

Lioyd Lady's shoe 96426-05

As a result, the first and second values are displayed once. Because, there is only 1
ProductGroup with DescShort equal to flat screen (pc) and DescShort equal to printer. The
third value is displayed twice. Because, there is no expression specified and there are 4
ProductGroups matching ForEach clause, and 2 of them would match the previous 2
expressions, thus 2 more ProductGroups need to be processed. In other words, the process of

printing values can be described in the following way:
e |f expression condition is true display print value.

e Expression condition is recalculated at iterations; the number of iterations depends on

the external conditions that are in our case presented by ForEach property.

o If Expression is not specified, it matches every condition and is treated as Otherwise

condition.

Values with no expression will be displayed last.

Example 2:

It is also possible to use Choose objects inside Text Flow objects. Let us make a table that

shows the amount of Data entries for each Product.
1. Make new layout, use Demo.xml as source.
2. Add new table, with 2 columns and 1 row.
3. Set the table grouping to Productgroup/Product.
4. Type some static data in the left cell (“How many data entries are there for product

{Namej?”).
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5. Double-click on right cell.
6. Select Choose icon.

7. Set the Type as Static, Value as “Less than 2, maybe 1 or 0”, Expression as
count(Data)<2.

8. Click the (+) button to specify another condition.

9. Set the Type as Static, Value as “2 or more”, leave the Expression field empty. An
empty Expression field means that this condition applies the last, in case, there are no
other conditions.

Tousf AT 2, \ndexfa, 1] T 4 =
£ View [rest  Formst  Reosnt iDatte
PXPES Coten (vl Moopeed (v 1l v B/ UXKK [ESEAS §
# Report it Nods Set
4 Productgroup Sorg
Name | Bodlean
g Numbert
4 Produt | DatefTime
Namre Math
Description | Today
:3. Tengiaces
Markers.
| I from tre
@CMW...
A Frovertes
Trpe yas Expranstn) 5. Cor . Badground |||
Lezs than 2, maybe Lor 0 courk{Data}e2 +2 or mare Aria), 12 Br
T e
*
-l aee
Cokamn: 2, brmc 1 IAQH Cancel I

10. Click “Ok” button.
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Howmany data entries are there
for product Name}? hore

Less then Z maybe 1 or 0 Z or

11. Process this layout. The generated output is shown below:

How many data is there for
product Product A?

How many data is there for
product Product B?

How many data is there for
product Product C?

How many data is there for
product Product D?

How many data is there for
product Product E?

How many data is there for
product Product E?

How many data is there for
product Product F?

How many data is there for
product Product G?
How many data is there for
product Product H?

How many data is there for
product Product 17

How many data is there for
product Product J?

How many data is there for
product Product K7

How many data is there for
product Product L?

How many data is there for
product Product M?

How many data is there for
product Product N7

How many data is there for
product Product C7?

Less then 2; maybe 1 or 0
Less then 2; maybe 1 0r 0
2 or more
2 or more
Less then 2; maybe 1 or O
2 or more
Less then 2; maybe 1 or 0
2 or more
Less then 2; maybe 1 or 0
2 or more
2 or more
Less then 2; maybe 1 or 0
2 or more
Less then 2; maybe 1 or 0
2 or more

2 or more

Note: Refer Choose.xsf, under 39_Choose, in Tutorial folder to work on Choose.

356 |Page



Arrangement of Elements

The menu Arrange, enables you to arrange the elements on worksheet. It helps in proper
alignment and accurate positioning of elements. This inturn, helps in formatting and a better

look and feel of the document.

i.ﬂrrange—l Page Run Tools

@, Bring forward
& Send backward

i Add horizontal guide
| Add vertical quide

g Clear guides

F1 align Left

=] align center horizontal
I8 align right

B align top

8l align center vertical
i align bottom

=l same width
E] same height

Same space horizontal

2r3 Same space vertical
®®W Tile objects

‘ Mirror vertically

& Mirror horizontally

= Move out from page

8 Compact relative elements

The functionality of each sub-menu options, under Arrange menu is explained in below

sections.
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Forward

The Forward option places the selected element in front and change its level value if the

elements overlap.
To bring an element forward, follow the steps below:
1. Select an element from the worksheet.

2. Select Arrange = Forward menu or right-click the element and select Forward from

Context menu.

@ B

Before applying Forward function. After applying Forward function.

In the above figure, both element A and B has level value as 10. Apply Forward function to

element B, the element B is placed in front and its level value is changed to 9.

Note: The level value changes in descending order.
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Backward

The Backward option places the selected element backwards and change its level value if the

elements overlap.
To bring an element backward, follow the steps below:
1. Select an element from the worksheet.

2. Select Arrange - Backward menu or right-click the element and select Backward

from Context menu.

@@ ’
A A
B B
Before applying Backward function. After applying Backward function.

In the above figure, both element A and B has level value as 10. Apply Backward function to

element B, the element B is placed backward and its level value is changed to 11.

Note: The level value changes in ascending order.
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Align Left

The Align left menu aligns the elements to left side of the window.

To align the elements towards left, follow the steps below:

1. Select more than one element.

2. Select Arrange > Align left menu or click E—_I - Align left from the toolbar.

(empty) Empty)
L0 Li0 "‘
{empty) {empty)
Lo ?‘ L10 ?‘
Before Alignment After Alignment
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Align Center Horizontal

The Align center horizontal menu aligns the element in center, horizontally. The mid points of
the selected elements are aligned in a vertical axis and the elements are placed in horizontal
plane.

To align elements to center horizontal, follow the steps below:

1. Select more than one element.

2. Select Arrange > Align center horizontal menu or click E[ - Align center horizontal

from the toolbar.

Before Alignment

After Alignment
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Align Right

The Align right menu aligns the elements to right side of the window.

To align the elements towards right, follow the steps below:

1. Select more than one element.

2. Select Arrange > Align right menu or click 1—-?'6

- Align right from the toolbar.

{empty)

Lin

{empty)

Li0 ?“

{empty)

(ermpty)

L10 ?‘

Before Alignment

After Alignment
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Align Top

The Align top menu aligns the elements towards top of the window.

To align the elements towards top, follow the steps below:

1. Select more than one element.

[

2. Select Arrange - Align top menu or click s Align top from the toolbar.

empty) {empty) empty)
A ;
L10 FA L10 P-‘ Lo ?i
A B
(empty)
B
Li0

Before Alignment After Alignment
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Align Center Vertical

The Align center vertical menu aligns the element in center, vertically. The mid points of the
selected elements are aligned in a horizontal axis and the elements are placed in vertical
plane.

To align elements to center horizontal, follow the steps below:

1. Select more than one element.

2. Select Arrange > Align center vertical menu or click L

the toolbar.

- Align center vertical from

1o ﬁ

Before Alignment After Alignment
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Align Bottom

The Align bottom menu aligns the elements towards bottom of the window.

To align the elements towards bottom, follow the steps below:

1. Select more than one element.

2. Select Arrange 2> Align bottom menu or click m - Align bottom from the toolbar.

(empty)

L10 #‘

fempty)

Li0

(empty)

Li0

(ermpty)

&

A

Lio

A

Before Alighment

After Alignment
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Same Width

The Same width menu aligns all the selected elements to the same width.
To align all the elements to same width, follow the steps below:

1. Select more than one element.

2. Select Arrange - Same width menu or click ]:=I - Same width from the toolbar.

e ] Yo ol
H P e { . £715 | EAASS R R PR :
Before applying After applying

command command
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Same Height

The Same height menu aligns all the selected elements to the same height.
To align all the elements to same height, follow the steps below:

1. Select more than one element.

2. Select Arrange - Same height menu or click - Same height from the toolbar.

Lo 2
Yoo o} s Fen 1 &
2 i 'l’ém‘ﬂ ' 3.’1"".’;'?..“
ey | i e
Before applying After applying
command command
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Same Space Horizontal

The Same space horizontal menu aligns the elements horizontally, with the same space

between the elements.
To align all the elements to same space horizontal, follow the steps below:

1. Select more than one element.

2. Select Arrange = Same space horizontal menu or click ©is > Same space horizontal

from the toolbar.

a al Pt 31| 3 Ao\ (f
?‘e'm‘;v) Yo | fenen Yoty 1 Yoy ] onaty)
‘ ............. 4.;. ............ a im .......... & ; ......... a
Before applying After applying
command command
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Same Space Vertical

The Same space vertical menu aligns the elements vertically, with the same space between

the elements.
To align all the elements to same space vertical, follow the steps below:

1. Select more than one element.

a @
2. Select Arrange > Same space vertical menu or click 2”2 > same space vertical from
the toolbar.
{2 A
Teretr) o]
A é St 3!
£ 3]
Yeretn
GRS Yerety 1
F RERI K
A5
ety Yorein
S [ SRR 4
Before applying After applying
command command
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Tile Objects

The Tile objects menu aligns the selected elements in line. Its functionality is same as Tile

windows option, but for selected elements.
To tile the elements, follow the below steps:
1. Select more than one element.

2. Select Arrange = Tile objects menu.

fempty)
(empt;}/i‘ Li0 P*
‘ {empty) (emp’g; (emnt;; (emp’t;; (empt;;
empty) o After applying command
i L10 ?‘
Before applying command

Notes:

All the elements are aligned or sized, with respect to the first selected element.

Except Forward, Backward, and Move out of page menus, all other menus are enabled, only if

you select more than one element.
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Mirror Vertically

When you selected two or more elements, the elements are bounded to virtual box. This box

also has virtual lines - vertical and horizontal and it is passed through the center of this virtual

box. Therefore, mirror command changes the position of elements against these virtual lines

like mirroring.

To mirror elements vertically, follow the steps below:

1. Select more than one element.

2. Select Arrange 2> Mirror vertically menu. The selected elements are mirrored against

the virtual horizontal mirroring line.

TProductaroupiNamey

........ 10

“““““ Ao ;1 /_F"
ProductgroupiName} |- | 11110l T AR
FGE oy e Al
.......... es‘
P oahes e mTestE| BRE NERE
---------- Test | oo - o0 o . 5 "
---------- .yirtual horizental mirroring line
7y

Before applying command

After applying command
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Mirror Horizontally

To mirror elements horizontally, follow the steps below:

1. Select more than one element.

2. Select Arrange 2 Mirror horizontally menu. The selected elements are mirrored

against the virtual vertical mirroring line.

g L
.. .. }Productgroups|. . .
- Name}

...............

o I'Productgroupi
- Name}

i mom
9 g
£ £
@

- >
E -
3 3
E £
» >

Before applying command After applying command
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Move Out from Page

The Move out from page menu moves the selected element from work area to non-work area.
To move an element out of page, follow the steps below:
1. Select an element(s).

2. Click Arrange 2> Move out of page menu. The selected element is moved from work

area to non-work area.

(Productgroup/Pro} - - - - Productoroupiera;
ctieseption) Eluctoes%ript?on} E
o b e
FARERAT | T S —
e 5 . ... £ 2
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Page

A page in XSLfast allows you to insert and arrange the elements as per the requirement. This in

turn, produces a style sheet.

Types of Page

XSLfast has different types of pages, which makes it easier to create a multipage brochure or a
booklet.

Following are the pages available in XSLfast:

¢ Main page

o Title page regions

e Tail page regions

o First page regions

e Last page regions

e Rest page regions

¢ Any page regions

e Even page regions

e 0Odd page regions

e Any page regions (odd or even)
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These pages are used with the combination of other pages, as specified in table below:

Command

Use with

Result

Add first page regions

Add rest page
regions

The first page has a specified region, all other pages
have other specified regions or no specified region.

Add last page
regions

First and last page have the same regions, all other
pages have different regions or no specified regions.

Add last page regions

Add first page
regions

First and last page have the same regions, all other
pages have different regions or no specified regions.

Add rest page
regions

The last page has a specified region, all other pages
have other specified regions or no specified regions.

Add rest page regions

Add first/last
page regions

See above

All pages will have these regions, including first or last

Add any page regions None pages

Add even page regions None All even pages will have these regions
Add odd page regions None All odd pages will have these regions
Add any page regions None All pages will have these regions

(odd or even)

You can add a title page, which has no special properties and serves as the top page of your

document. The same goes for the tail page, which is the bottom page of your document.

XSLfast also allows adding several title or tail pages, which are displayed in the order they

were created. They are named as title.1, title.2, tail.1, tail.2, and so on.

Note: Different renderers like FOP, XEP, or XSLFormatter have different function ranges

concerning regions and title/tail pages. FOP cannot use even or odd regions separately. But, if

odd regions are specified; even regions need to be specified, as well. FOP is also unable to add

tail pages to documents and more. Refer http://xml.apache.org/fop/ for more information on

FOP’s function range.

Regions in a Page
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http://xml.apache.org/fop/

Regions are areas on the top, bottom, left, and right of the page, indicated by blue lines.
Elements placed in these regions will appear on every page of the generated document. The

use of the regions gives you lot of possibilities to design your document in a sophisticated way.

XSLfast offers you to design the layout of a multipage document in a comfortable way using
regions. There are different regions, which can be combined to control the look and feel of the

document.

You start with a page, which will be used as the body of the document, where the actual
contents are placed. Let’s create a quick layout with a simple table, which runs over several

pages.
Select the XML file from ..\Tutorial\10_Example_manual\Example.xml.

Create a table with one row and two columns:

Group the table to ProductGroup/Product:

Repor]

A roductG roupiProduc 10

Now drag the node Report/ProductGroup/Product/Name into the first cell:
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[ProductGroup

Add an XML image frame to the second cell and assign it to the node

Report/ProductGroup/Product/Properties/img:

3 Propertiesimg *“

Select the image base where the images are located ..\Tutorial\Example_manual\img to

make sure XSLfast can find the images.

Image base path ..finput{TutorialExample_manual
Image/Image node. Propertiesfimg '

As you do not specify the commands Fit in Frame and Keep aspect ratio, the images will be

displayed in their original size. If you process this layout now, it would have three pages:
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So far we have not specified any elements in regions at all.

Let us place pagination for this document. We would like to have the page number on the right
side for odd pages and on the left side for even pages. Use the command Page - Insert Page
->Add even page regions. A new page opens, which displays the page body in grey and only

the regions in white.
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Your body page now shows its body in white and the regions in grey.

Only the regions should be edited here, elements placed in the grey region are not considered
in the generated document. They are also marked with a red frame.

Place a pagination element into the left bottom corner, because these are the regions for even
pages and we want it on the left side:

Now use the command Page - Insert Page = Add odd page regions and place a pagination
frame into the right bottom corner:
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Now you have three tabs open: body, even regions, and odd regions. Process your layout now:

On the first page, the pagination is on the right side, on the second page it is on the left side,
on the third page it is back on the right side. With regions you can control the elements shown

in your document, even if the design is different for odd or even pages, or you can add a title
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and a tail page, or a first or last page, or use different designs for the first page and all other

pages, and so on. The regions can be combined with each other, e.g. odd and even regions and

a title page.

Note: Some of these functions are not operational with FOP or that they need to be combined

in a special way to work correctly. Using FOP requires e.g. the specification of both odd and

even regions and does not allow to use the first page/last page function.

Command

May be used
with

Result

To be
considered

Add first page
regions

Add rest page regions

The first page has a specified
region; all other pages have
different specified regions or
no specified regions.

Add last page regions

First and last page have the
same regions, all other pages
have different regions or no
specified regions.

Add last page
regions

Add first page regions

First and last page have the
same regions, all other pages
have different regions or no
specified regions.

FOP does not allow
this function

Add rest page regions

The last page has a specified
region, all other pages have
other specified regions or no
specified regions.

Add rest page
regions

Add first/last page
regions

See above

Add any page
regions

May be combined with
all other regions

All pages will have these
regions, including first or last
pages.

Add even page

All even pages will have these

FOP requires odd

. None . .
regions regions. and even regions
Add odd page None All odd pages will have these FOP requires odd
regions regions. and even regions
Add any page -
regions (odd or None All pages will have these

even)

regions.
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Insert Page

To insert a page, click Page - Insert page menu, or select any of the page icons from the
toolbar, or right-click on the page and select Insert page option from the context menu. The

selected page is inserted. By default, when you open a new layout, the main page is inserted.

Beoi 250 rane> 258 80 8
.

XSLfast allows you to insert different types of page, in the similar way.
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Page Grouping

The Grouping command is used to establish a connection between the page and the XML file.
The page is grouped to the top node by default. If no XML file has been grouped, the entry
shows “/”. During the layout process, you will probably group the page, tables, and XML frames
to nodes from the XML file. The grouping functionality of a page is similar to table grouping,
except the page is always grouped to the higher level node than the grouping of other
elements.

For example, if the page is grouped to the node Report/ProductGroup/Product, the elements
on the sheet now already refer to those nodes contained in Product and show only the name of

the node. Because, the first part of the path is already determined by the page grouping:

ork e
= ProductGroup e
- ProductGy \\
A‘ﬁ?ﬁﬁﬁaﬁﬁﬁ%?}“‘i
‘r{Producthidiber]~=T"|

/ MName
7 ProductPrice
=1z Properties

......

Refer Group Table section for more details.
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Page Properties

The properties of the page can be set through the Properties window. To open Properties

window, click Page > Page properties, or press Alt+P. The Properties window appears.

Properties =R
Categorized Alphabetic I
Property | Yalue
Size: - (a4 — ~
width 593 pt
Height 345 pt
Orientation: | Portrait -
Columns 1
Gap between columns 10 pt
Alternate page numbers 1
Custom title
Expression
Description
Backaground color
Force page count | no-force - |
Locked 1
4 Region precedence
Top (|
Bottom 1
4 Regions
Left 23 pt
Right 28 pt
Top 25 pt
Bottom 28 pt
4 Paper margins
Left 10 pt
Right 10 pk
Top 10 pt
Bottom 10 pk
4 Custom page attributes
Custom attribute name 1
Custom attribute value 1

I Ok l _ Cancel l

The options in Properties window are also available in inspector window of Page.

e Size - Sets the size of a page.
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[ Size: 24 2
A3

US Letter
US Legal
Tabloid

B4 Y

e Width and Height - Width and Height are preset with the paper size you select in
Tools 2> Preferences 2> Default settings > Page, but can be modified here with the
corresponding entry fields. If you enter a custom size here, the paper size in that menu

changes to Custom and displays the values you entered here.

e Orientation - Sets the type of page, either Portrait or Landscape.

[ Grientation: | Portrait =

Landscape

e Columns - If you want to have your page divided in columns, use the command

Columns. Enter the number of columns into the field.

A page with two columns:
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¢ Gap between columns - Modify the gap between columns with the command Gap

between columns. The columns are marked on your sheet with blue dashed lines.
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:

Gap between columns

¢ Alternate page numbers - If you want to add pagination check this option.

Separate numbers for every page sequence - Every page sequence created by
the page grouping will have its own set of page numbers and numbering will begin
at 1 again (or the initial page number), every time, when a new page sequence

starts.

Initial page number specifies the number the page numbers should start with. It is

also possible to start with another number than 1.

Forced page count - There are many options in the select box. Force-page-count is
used to impose a constraint on the number of pages in a page-sequence. In case,
that this constraint is not satisfied, an additional page will be added to the end of
the sequence. This page becomes the "last” page of that sequence. The values have

the following meanings:

o auto - Force the last page in this page sequence to be an odd-page if the initial-
page-number of the next page sequence is even. Force it to be an even-page if

the initial-page-number of the next page sequence is odd. If there is no next
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page sequence or if the value of its initial page number is "auto” do not force

any page.
o even - Force an even number of pages in this page sequence.
o odd - Force an odd number of pages in this page sequence.
o end-on-even - Force the last page in this page sequence to be an even page.
o end-on-odd - Force the last page in this page-sequence to be an odd page.

o No-force - Do not force either an even or an odd number of pages in this page-

sequence.

Expression - The function Expression for pages is used only in layouts, which were

created by combining pages from independent layouts (Refer Combine Layouts). This

expression represents a way to apply conditions to the page and is only available on
main pages. Entering One (1) or leaving the function empty always displays the page. If
you want to hide this page in the layout, enter Zero (0). It is also possible to enter a
condition on which the page should be hidden or displayed (similar to if condition of

elements).

Description - Enter some information about this page, when it should be used or why it

is used for.

Background color - Set a background color of the page. Click Background color option

the Background color window appears. Select the color and click “OK” button.

Background image - Set a background image of the page. Click Background image
option the Select background image... window appears. Select an image and click “Ok”
button.

Locked - Check this option to make page as read-only. The page cannot be altered, it
is locked. This affects all modifications like grouping, adding regions, or changing the

background color or image.

Regions - This option is used to set the size of the regions such as:
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.
—
0]

=
=y

Right

e Top

Bottom

e Paper margins - This option is used to set the paper margin size, such as

o Left

¢ Right

e Top

e Bottom

Inspector Window

The inspector window options are similar to Properties window option. Refer Page Properties

section for more details.
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Data I Format |

1 &
| Pick Element -~
Property | Value |
Size: | A4 -
‘Width 595 pt
Height 845 pt
Orientation: | Portrait -
Columns 1
Gap between columns 10 pt
alternate page numbers (|
Grouping Report
Custom title
Expression
Description
Background color
Force page count | no-force -
Locked 1
» Background image
4 Region precedence
Top (|
Bottom (|
4 Reqgions
Left 28 pt
Right 28 pt
Top 28 pt
Bottom 28 pt
4 Paper margins
Left 10 pt
Right 10 pt
Top 10 pt
Bottom 10 pt

4 Custom page attributes

Custorn attribute nam...
Custom attribute walu. ..
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Context Menu

The Context menu of a page has the following unique options:
¢ Grouping - Groups a page to an XML node.
o Reset page grouping - Removes page grouping.
¢ Insert page - Inserts a page.

¢ Delete page - Deletes a page. Click this option, Confirm deletion window appears.

Confirm deletion bX4

y
‘f - The page will be deleted. Are vou sure?

Click “Yes” button to delete the page, else click “No”.

¢ Portrait/Landscape - Option to change a Portrait page to Landscape and vice versa.
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Groupings
Insert page

. Delete page
Portrait/Landscape

Backaround colar...
Background image

Ctrl-X

Cel-C
Chrl-vf

Preferences

The menu Preferences contains settings for the layout and the application. To open XSLfast

preferences window, click Tools = Preferences, or press Alt+0. The XSLfast preferences

window appears. The XSLfast preferences window consists of the following options:

e General options

e External tools

e View options

e Performance options

o Compatibility options

e XSL output settings

e XSD/DTD settings

o (CSV settings

o Default settings
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The functionality of these options is explained in the following sections.

XSLiast preferences

| JGeneral options General options
[ Wiew options [¥] Show startup wizard

B::;‘:ﬁ:::::t;:rom [v] Disable layouts without XML

Jcompatibility options || Track all changes as ssparate versions of layout
ML output settings Bt 1 tool

| JMSDIOTE settings rRHCAINEl LO0IS

[ )CsY smttings Initial layout root directory

2 L smtt
@Rostaut sattings Source files bass path

Delault image base path

Default x5l base path

Path mode
’ Path mode | Relative paths

Updates
[ ] Chuck for updates

Graphic library

wffect,

Hurw you can set the graphic library used to paint figures in editor, You should restart 250Fast For these changes to take ’

Sulwct active graphic library | GEF

Paths to external tools
l KSLFormatter path: ]

Use internal pdf viewer
l (W] Usm intmrnal pdf viewsr

-,’
e

[ ok |[ cancel |
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General Options

The options under General options tab refer to the layout creation settings. The General

options tab contains the following options:
e Show startup wizard
e Disable layouts without XML
e Track all changes as separate versions of layout
¢ Initial layout root directory
e Source files base path
e Default image base path
o Default xsl base path

¢ Path mode
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|_Jamneral options

[ Wiew options

| Jadditional options

| JPerfarmance options

PCompatlblllty options
sl output settings

L %8D/OTD settings

[ JCSY smttings

o ADelaull settings

XSLtiast preferences =

General options
V] Shaw startup wizard
[v] Disable layouts without XML

%] Track all changes as separate versions of layout

External tools |

Initial layout root directory

Source Flles bass path

\
\

Delault image base path \ I e |
\

Default x5l base path

Path mode
‘ Path mode | Relative paths - "

Updates
‘ [ ] Chuck far updates ’
Graphic library

Hurw you can st the graphic library ussd bo paint figures in editor, You should restark $5LFast For these changes Lo take
wffect,

Sulwct active graphic library | GEF - \

Paths to external tools

‘xSLFormlttor path: l e ||

Use inturnal pdf viewer
[ Lm internal pdf vieyesr l

e Show startup wizard - Option, which pops up the startup wizard, when you open

XSLfast or open a new layout. The startup wizard allows you to open a new layout, an

existing layout, recently used layouts, or the Templates. If you do not want this wizard

to open every time you start XSLfast or open a new layout, uncheck the check box

Show startup wizard.
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Open.

1. Create/Open layout 2. Attach XML/DTD data file

3. Modify layout 4. Render layout

=1 Open existing layout...

Open recently used layout...

D C:/Documents and Settings/.../Footnotes.xsf

D C:/Documents and Settingsfnasgor/.../Table.xsf
D C:/Documents and Settingsfnasgor/.../Text.xsf
D C:fDocuments and Settingsfnasgor/...j1.xsf

D D:fXSLFastfxslfast)...ftable background image.xsf
D C:J...ftable background image.xsf

D C:/Documents and Settings/...JPivot_Table.xsf
D C:/Documents and Settingsfnasgor/. .. flist.xsf

D . JlibjTemplatesfLayoutsfBusiness report. xsf

[ Create new layout...

Open from template...

D Business report

[ Text document

D Assessment

D Order

D Brochure with columns
D Brochure

D Master-Slave

[ chart

[ Business card

Show this dialog at startup

| Cancel |

o Disable layouts without XML - Usually a layout requires an XML source. Also, there will

be layouts which do not require XML source. For your convenience, it is possible to set

XSLfast to ask you for an XML source every time, when you open a new layout with the

function Disable layouts without XML,

box.

or to turn this function off, uncheck the check
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Open &K

LookIn: 1 input

=1 Tutorial

[ ) Dema.xml

[ ] emodata_de.xml
[) Demodata_en.xml

File Mame: Dema.xml

Files of Type:  DTD/XML{XSD schema files (*.xsd, *,xml, *.dtd) -

[] Do net bind layout to top node

| OpenJ | Cancel l

e Track all changes as separate versions of layout - The function Track all changes as
separate versions of layouts allows you, to keep the original layout unchanged, while
performing changes on it. All changes will be saved as a separate independent file
versions, the next time when you save the layout. The new files will be saved in the
same folder as the original file, where the file name is suffixed with the _v1, _v2,
followed by .xsf (for example, from the original file name Invoice.xsf to Invoice_v1.xsf
and so on).

Note: A separate layout version is saved but the new file is not automatically opened. The

original file stays active. If you want to save the original file without suffix i.e., _v1, _v2,

use the function Save as or turn the function Track all changes as separate versions of
layouts off.

¢ Initial layout root directory - Option to specify the path, where all the layouts can be
saved.
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¢ Source files base path - Option to specify the path, where you can save the source or
input files like XML, XSD, and DTD files.

o Default image base path - Option to specify the path, where you can save the images
and select the images from. The image base path acts as a reference and XSLfast picks

the images from the specified path and displays in the output file.

o Default xsl base path - Option to specify the path, where the generated output files
such as XSL and XSL-FO are saved.

¢ Path mode - The Path mode option consists of two types of mode:

e Relative paths - The relative path mode indicates that all files currently used
(images, templates, and so on) are referred to the output files relative to the
XSLfast installation directory (for example, ../input/mylayout.xsf) in the output

files.

e Absolute paths - The absolute path mode indicates that the absolute path name is
saved with the layout (for example, C:/Program

Files/XSLfast/input/mylayout.xsf).

Note: The absolute path mode may lead to problems if the layouts are used on another

machine with a different file structure.
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View Options

The View options tab helps to set the look and feel of a layout, display layout information, and

so on. The View options consist of the following options:
e Grid size
e Grid point of origin
¢ Snap on grid
¢ Show grid
e Enable preview of fonts in font listbox
¢ Display system fonts first
e Show layout options in status bar
e Show XML in alphabetical order
e Show log in status bar
e Autozoom in Text editor
e Show node value tooltips in Grouping dialog
e Highlight recommended nodes Grouping dialog
e Length of history for XPath expressions
e Default precision
e Default system font

e Language
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XSLtast preferonces

| JGeneral options

| Wiew options
|_)additional options

[ Jpartormance options
[ Jcompatibiity aptions
[ J#sL output settings
[ 5001 settings
[Jcsv settings

[ IDefault sattings

Grid properties
[v] Show grid
[¥] Snap on gtid
Grid sizn

Other properties

|| Create preview when saving the layout

[ Enable preview of fonts in font listbox

|¥| Display system fonts first

[¥] Show layaut options in status bar

(V] Enable swarch in XML tree

[T Show ¥ML in alphabetical order

[ Show log in status bar

[¥] Autazaom in Text sditor

[V] Enable hints for $ML structure in fiters dialog
[¥] Highlight recommended nades in Grauping dialog
[] Do not show bad groupings notification dialog
[ Office-like menus

(V] Shaw detalls while dragaing

(V] Shaw page tooltips

|v| show XML tree and Inspector in tabs

V] Use multi-document Interface

|| Use old behavior for tables

[ Smart guides
Length of histary for XPath expressions

élé&r hEtori.. l

u [
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Grid Properties

¢ Grid size - Determines the distance between each grid points, in the layout.

Grid properties

Grid size 30

Distance between grid
© points’ ¥ %4 ®

You can also do this setting through View menu. Select View 2> Grid preferences = Grid size.

Refer Customizing Interface section for more details.

Note: You can view this setting only if Show grid option is enabled.

e Grid point of origin - Determines the start position of grid points. Usually left/top
point of page is (0,0). Grid point of origin allows to change the grid points start
position. All coordinates will be re-calculated against new point of origin. You can also
do this setting through View menu. Select View = Grid preferences - Grid size.

Refer Customizing Interface section for more details.

e Snap grid - Snap grid arranges elements to grid points. In other words, when this
option is turned on, and the grid size is specified as 10x10, you can place (move)
elements only to positions 10, 20, 30, and so on, but not to 25, 17, 6, and so on. You
can also do this setting through View menu. Select View - Grid preferences = Grid

size. Refer Customizing Interface section for more details.

¢ Show grid - Enables the grids on the worksheet. You can also do this setting through

View menu. Select View - Grid preferences - Grid size. Refer Customizing Interface

section for more details.
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Other Properties

¢ Enable preview of fonts in font listbox - This option displays the preview of the fonts
in the font listbox. It displays the name of the fonts in its corresponding font style, so,
you can see the look of the font right away.

rial Bold Italic v

If you uncheck Enable preview of fonts in font listbox option, the font names are displayed in
Default system font:

arial

B [

Agency FB

Aoency FB Bold

Algerian

Arial

Arial Black

Arial Bold

Arial Bold ltalic v

Note: The Font listbox is available only for Text, Numeric field, XSLcode, Barcode, Internet

link, Date/Time, Pagination, Index, Citation, List, and Choose elements.

o Display system fonts first - This option displays all system fonts first and then lists all
other fonts in alphabetical order, in Font listbox.
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— Displays system fonts
first.

Agency FB Bold
Algerian

Arial

Arial Black v

¢ Show layout options in status bar - The check box Show layout options in status bar

displays the output format and the current Renderer in the lower right corner of the

layout status bar.

FOP 0.20.5 Portable Docume;

Click the output format and renderer to change.

T — ]
w FOP0D.20.5 1
FOP 0,95 #aL-FO
YEP & HTML Document
XSLFormatter e ——= | W Portable Document
[
FOP 0.20.5 I Portable Document FOP 0.20.5 | Portable Document

This function also controls if you see the current coordinates of your mouse cursor in the lower

left corner.

¢ Show XML in alphabetical order - Sorts the XML nodes alphabetically, in XML window,
without changing their structure. You can also perform this from View menu. Select

View - Show XML in alphabetical order.

403 |Page



ED Report

=3 Productgroup
s Name
=23 Product

XML node sorted alphabetically

I Report

=3 Productgroup
~oo @ Name
‘ Img
=29 Product

XML node not sorted

e Show log in status bar - This option displays so information about the layout in the

status bar.

| &\ 05-05-2003 11125:01 Flsase charge the path to POF resder!

| |

FOP0.55 | Portable Documert |

¢ Autozoom in Text editor - Autozoom in Text editor is used when the text in some

objects is unreadable (very small). So, when you try to edit the text, it may be

indistinguishable. The Autozoom option will automatically zoom in the text, and makes

it readable.

e Show node value tooltips in Grouping dialog - Option to view the node values as a

tooltip, in Grouping properties window. Check this option to view the node values of a

selected XML node, in Grouping properties window. If you uncheck this option, the

tooltip is not displayed in Grouping properties window.
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'Ta Grouping properties

Group by position [ Filtering ][ Group by content

Grouping:

rt
= Productgroup
Lo Name

Fo @ Im [Productgroup 1 prod101051.gif Product A Description of product A prod101...
=83 pri]

~ 4 Name \

@ Description Tooltip

L@ Img
Lo Data

[[] Conditional region {¥SL:IF instead of XSL:FOR-EACH)

[ Remove grouping ][ Ok ][ Close ]

¢ Highlight recommended nodes in Grouping dialog - Option to highlight the

recommended XML nodes that can be used for grouping, in Grouping properties

window.

Note: This option is particularly meant for beginners of XSLfast, which helps them to

choose worthy nodes for grouping.

Check this option and open Grouping properties window to view highlighted nodes. If you

uncheck, the nodes are not highlighted.
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L‘@ Grouping properties ¥4 Grouping properties

Group by position @E%ﬂgﬂ@g&

Group by position | Fiktering

Grouping:
e oS-
EID =23 Productgroup
. ...... ’ MName
Fo ) Img # Img
- Product - Product
Check Highlight option Uncheck Highlight option

e Length of history for XPath expressions - The function Length of History in XPath
expressions refers to the Recent XPaths’s option in editor window. It controls the
number of XPath expressions, which are saved during a session. This number of used

XPath expressions can be viewed and reselected in a list box.

Recent ¥Path's

ounotgruprame)
Productgroup/[position{)=1]]Mame
Productgroup/[last{)IMame

HReport

e Clear history - This button removes or clears all the XPath entries from Recent
XPath’s.

e Default precision - Due to the calculation from e.g. mm/inches... into pt, there can be
lot of decimals. The Default precision specifies how many decimals should be

displayed in the entry field in the inspector window.

Note: After you changed the precision value, you need to restart the application to apply

the setting.

Choose the precision you need to apply in your layout in Default precision field:

Default precision 52 I
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Note: Minimum precision is 2 decimals and maximum precision is 15 decimals.

o Default system font - The function Default System Font allows you to specify the font,

which is used by default in your layout. The XML nodes are displayed in this default

font style.

Note: For Windows, the default font is Arial Unicode rather Arial. This font provides

support CJK and Arabic glyphs in user interface on non- CJK/Arabic Windows.

Click the Font button to select another font and click “OK” button. The application will now

use this font everywhere in XSLfast, also in the display of the XML tree.

Default system font

[ Arial Unicode MS ]

79 Report
C:I@ Productgroup
------ # MName
. Img
=23 Product
coo g Name
~.-# Description

fo & Data A

~Font \

Font: Font size:

r ~Font style

| Trebuchet M5 ! '11 ]

Symbol ~ sl %
Tahoma 12 [] tkalic
Tahoma Bold 14

Tempus Sans ITC 16 [] underline
Times 18

Times Mew Roman 20 e,

Times Mew Roman Bold 22 | ~Font effects
Times Mew Roman Bold Italic 24

Times Mew Roman Italic 36 [[] superscript
M — |45 :
{Trebuchet M3 Bold w72 [ subsaript

rLayout

Preview

[ OK ][ Cancel

e Language - Select the Language for the tool from the drop-down and click “Ok”

button.
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Language

English

German
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Performance Options

The Performance options are used for an efficient performance of XSLfast. The Performance
options have the following check boxes:

e Transparent while dragging

¢ Enable level indicator

¢ Enable type indicator

e Enable collisions indicator

e Enable region indicator

e Use syntax verification

XSLfast preferences

DGeneraI options
DView options
DAdditionaI options
DPerformance options
DCompatibility options
DXSL output settings
[ }%SD{DTD settings
[Ncsv settings

= IDefault settings

Performance options
Transparent while dragging
Enable type indicator
Enable collisions indicator
Enable region indicator

Use syntax verification

e Transparent while dragging - When dragging frames, the background is sometimes

covered by the frame, which makes it hard to place the frame exactly in the desired

place. If you select the check box Transparent while dragging, all frames are

semitransparent, and allow seeing the background while they are dragged over the

sheet.
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Bricle |

e Enable level indicator - This option displays the level of the frame it belongs to. Check

Enable level indicator option, the frame is displayed with its level, on the worksheet.

l v Ly - L
empty] empty)
Check "Enable level indicator" Uncheck "Enable level indicator"

¢ Enable type indicator - This option displays the type of the frame it belongs to. Check

Enable type indicator option, the frame is displayed with its type, on the worksheet.

Check "Enable type indicator" Uncheck "Enable type indicator

« Enable collisions indicator - This option indicates that an element is collide with other
regions of a layout (Start, End, Header, or Footer), other than body. It considers the

collide element belongs to the region and not the body of the worksheet.
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Check "Enable collisions indicator Uncheck "Enable collisions indicator

e Enable region indicator - This option indicates the region, where the element is placed
in (Header, Footer, Left, and Right). The frame will appear on every page of the

document.

Check "Enable region indicator" Uncheck "Enable region indicator"

Note: All indicators can be active, simultaneously.

e Use syntax verification - This option, displays error in syntax as you type, in editor
window. The errors are highlighted in red, and display the proper syntax. The syntax

verification is usually displayed in editor window and XPath preview.

(‘@ XPath preview

>§ML structure ¥Path expression Mode Set
D ?SML_SOWCE: /Report/Productygroup[position() @ String
=) <Report> —
- ) <F rodictaroups Encountered "]" at line 1, column 33. Was expecting one of: Boolean
() <Productgroup> (_@ *( f fi' d o Humber
@‘13 <Productgroup> and div mod key self child Date/Time
#-|5) <Productgroup> parent ancestor following preceding attribute Math
namespace descendant ancestor-or-self descendant-or-self Today
following-sibling preceding-sibling text node
comment processing-instruction
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If you uncheck this option, the editor does not highlight error.

M@ XPath preview

XML structure ¥Path i Node Set
) ¥ML-Source: RepomProductgroup[positioj):D i
S = Skrin
=) <Report> L‘*‘-— |g
@b <Productaroup> Boolean
() <Productgroup> Humber
-2 <Productgroup> Date/Time
[#-[77) <Productgroup> Math
Today
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Compatibility Options

The Compatibility options are used to make XSLfast compatible with the renderers. The

Compatibility options consist of the following options:
¢ Smart vertical alignment (FOP specific)
e Merge cell and object borders in old layouts
¢ Seek missing files near layout
e Use system locale settings
e Allow empty row omitting
¢ Indicate bad elements in output
e Use different border for cell and its contents
e Do not treat white background as transparent color
e Add templates with “match” pattern
e Adjust line height automatically
e Show registered fonts only
e Use simple filter dialog in inspector
e Use advanced sort wizard
e Use advanced alternate colors wizard

o Apply grouping to selected rows only
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XSLfast preferences X3

[General options Compatibility options
DView options Smart vertical alignments {FOP specific)
[laddtional optlon_s [] Merge cell and object borders in old layouts
DPerformance options
["compatibilty aptions [7] Seek missing files near layout
[#sL output settings [] Use system locale settings
[(xsD/DTD settings "
Allow empty row omitti
DCSV settings O s ke
= IDefault settings [] Indicate bad elements in output

[ Use different borders for cell and its contents

[ ] Do nat treat white background as transparent color
[] Add templates with "match" pattern

["] Adjust line height automatically

["] Show registered Fonts only

-Advanced
Use grouping dialog in inspector
Use sort wizard
Use alternate colors wizard
["] Apply grouping to selected rows only
[ old-fashioned abject placement

Compatibility Options

¢ Smart vertical alignments (FOP specific) - If you use the function Smart vertical
alignments (FOP specific), XSLfast applies top padding in text elements, depending on
the font size. This is helpful because FOP does not support top, middle, or bottom

alignment for text.

For example, you need to have text of different size in one text frame. Without smart vertical

alignment it could look like this:

Small text Blg teXt Small text

Check Smart vertical alignments (FOP specific), it changes into:
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Small text B'g teXt Small text

A top padding is automatically set so that the bigger text is not stuck to the top rim of the

element.

Merge cell and object borders in old layouts - In old layouts, the cell and object of
the cells had two different borders, this lead to a problem in the output PDF. Objects
in cells had two-line borders, one for the object’s border and other border for the cell.
Now the Merge cell and object borders in old layouts, merges both cell and object

borders into a single border, and the width value is set to the greater of the two.

Seek missing files near layout - This option helps users to exchange layouts with one
another, very simpler. When the layout is moved to another system layout’s external
paths (images, templates, and so on.) it might be incorrect. So, XSLfast tries to find
them in the layout’s folder, because the users often place all the files necessary for

layout, together.

Use system locale settings - XSLfast uses system locale settings for numeric field

representation, such as decimal and group separators.

Allow empty row omitting - This option omits or deletes empty rows in tables.

Indicate bad elements in output - This option prints the string "(empty XSL)" for every
empty XSL code, in the output file. It is useful to clean up the layouts and avoiding
empty objects in the layout. If disabled, the output does not display “(empty XSL)"

string.

Use different border for cell and its content - This option uses a different border for

the cell and its content of a table.

Do not treat white background as transparent color - This option do not treats white

background as a transparent color, if applied to any of the elements.

415|Page



¢ Add templates with “match” pattern - Whether or not XSLfast should use "match”
templates (<xsl:template match="...">) in files specified as External templates in the

Layout settings.

e Adjust line height automatically - The function Adjust line height automatically
provides way to re-calculate line height XSL-FO attribute for FOP on the fly.

o Show registered fonts only - The font list-box displays only the fonts that are

registered for a renderer.

Advanced

o Use simple filter dialog in inspector - This option allows entering the grouping XML
node manually. It does not allow the Grouping properties window to appear. This view

is rather recommended for more experienced users. Refer Inspector Window section of

Table element for more details.

Categorized ' Alphabetic |

Property I Value
Object name Table_1 a
ElTable

I Grouping. [ '

¢ Use advanced sort wizard - This option displays the Sort properties window. It allows
opening Sort properties window and multiple Sort expressions for a table. Refer

Inspector Window section of Table element for more details.

416 |Page



Sort properties ¥
“ Report : Attribute name | Sort arder | Data type Case order | Rucant XPaths
A Productgroup Node Sat
Nama StHng
Img Hoolwan
* Product Number
Date/Time
Math
Today
Tamplates
| Add |
Delote
ok || cancel

If you uncheck this option, you can only enter the sort expressions manually.

| EISort attribute 1 [Sort expression: ] |
| Sort expression_| I

o Use advanced alternate colors wizard - This option displays the Alternate colors
properties window. It allows opening Alternate colors properties window and adding
multiple alternate colors to a table. Refer Inspector Window section of Table element
for more details.
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Alternate colors properties ==

[ Colors | (ue ]
g )

add J' Change Jl Delete J

[ ok | [ cancet |

If you uncheck this option you can select only two alternate colors manually.

4 Use alternate colors

Alternate colors

o Apply grouping to selected rows only - This option, applies grouping only to the

selected rows.

Sroductgroup] B 10
1
.................
2
3
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Here, the table is grouped to Productgroup and row 1 is grouped to Product. All other rows are

grouped to Table grouping itself.

If you uncheck Apply grouping to selected rows only option, the grouping is applied from

current row to the last row of the table.
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XSL Output Settings

The XSL output settings tab provides some settings for the XSL output. The XSL output

settings tab has the following options:
¢ Use saxon extensions -
e XSLT 2.0 features enabled
e Use SVG graphics for lines
¢ Include Java-Namespaces (possible problems with non-Java XSLT systems)
o Prefer CMYK color space if possible
e Use selected unit of measures in XSL output
e Paint cropmarks
e Use bookmarks
¢ Embed fonts
e Embed all fonts, also Base-14 (necessary for PDF/A)
o Create separate block elements for empty lines
e XSL output encoding

e Default XSL-FO processor
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XSLtast preferences =

| General options

| Wiew options

| Jadditional options
[jPerFormanco opklons
| Jcompatibility options
|_J¥SL output settings
DXSDIDTD settings

[ jCsV sattings
Cpefault settings

[%SL output settings

[ 7] %8LT 2.0 Features enabled

V] Use SYG graples lor lines

|| Include Java-Namespaces (possible problems with non-Java XSLT systems)
[¥] Prafer CMYE color space if possible

|¥| Use selected unit of measures In XSL output

7] Paint cropmatks

|| use bookmarks
Please use "ExtrajGanerate font metrics" to apply font smbedding options,

[¥| Embed fonts
| Embed all fonts, also Base-14 (necessary for PDF{A)
[v] Create separate block elements for ampty lines

XSL output encoding

utka -
Default XSL-FO processor
CFOP 1.0 ) v

|' Ok ]|> Cancel |

XSLT 2.0 features enabled - This option enables XSLT version 2.0 standard possible
(adds such menu items in XSL code objects as xsl:for-each-group, xsl:analyze-string,

xsl:next-match, and so on. as well as, extra items to the Text editor function panel).

Use SVG graphics for lines - If you need to use lines which are not orthogonal in your
layout, check the check box Use SVG graphics for lines. If this check box is not active,
lines are created by FO-Blocks, which will lead to problems with non-vertical or non-
horizontal lines. Such other functions like SVG bar codes and crop marks will not be

available too.

Include Java-Namespaces (possible problems with non-Java XSLT systems) - Activate
the check box Include Java namespaces (possible problems with non-Java-XSLT
systems) if you want to use Java namespaces. Namespaces make static functions e.g.

from the Math library available in XSLfast.
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Note: There may be problems using the XSL output with Non-Java processors if you activate

this check box.

Example 1: Java namespaces are not included in the layout. In the beginning of the XSL file

you can see strings such as these:

<xsl:stylesheet xmlns:fox="http://xml.apache.org/fop/extensions"
xmlns:fo="http://www.w3.0rg/1999/XSL/Format" version="1.1"
xmlns:date="http://exslt.org/dates-and-times"
xmlns:saxon="http://icl.com/saxon" extension-element-
prefixes="saxon"

xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform">

Java namespaces are included in the layout:

<xsl:stylesheet xmlns:fox="http://xml.apache.org/fop/extensions"
xmlns:Integer="java.lang.Object.Integer"
xmlns:Calendar="java.util.Calendar"
xmlns:fo="http://www.w3.0rg/1999/XSL/Format" version="1.1"
xmlns:saxon="http://icl.com/saxon" extension-element-
prefixes="saxon" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform"
xmlns:Math="java.lang.Math"
xmlns:Double="java.lang.Object.Double"
xmlns:Date="java.util.Date" xmlns:String="java.lang.String"
xmlns:date="http://exslt.org/dates-and-times"

xmlns:Locale="java.util.Locale">

xmlns:Integer, xmlns:Calendar, xmlns:Math, xmlns:Double, xmlns:Date, xmlns:String,

xmlns:Locale - these are namespaces, which can be used in layout.

Example 2: This example will show how to print current date and time using Java

namespaces.
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Java-Namespaces are included in the layout. Click Layout = Layout settings = Additional

templates and press the “Edit” button opposite to Internal variables title. The Edit internal

variables window appears.

Enter <xsl:variable name="rightNow" select="Date:new()" />. This phrase means that you

declare a variable named rightNow and call the function new () from the Java class Date:

Edit

Edit internal variables

<

2 Raport
* Productgroup

=N

Column; %2, line 1

™ 3R 1) "C\‘E]Ca:

cxal:variable name="rightNow" aelect="Date:new()"/>

-

(] ()

Insert an XSL Code element on the worksheet, open the text editor by double clicking the

element and enter the call for the variable (<xsl:value-of select="SrightNow" />) to

generate its value, which was declared in the Internal variables field:
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Text_1 - New Text E B
Edit  Recent XPaths

" XBE
4 Report : <xsl:value-of select="§rightHow"/> “ || Node Set
» Productgroup String
Boolean
Number
Date/Time
Math
Today
Templates
XSLT
XSL-FO
+
~
MR ] aal i S « | § | =

Column: 35, line: 1 | Ok |_Cance| ]

Process the layout. The result of the specifications described above will be:

Thu Apr 13 11:14:42 EEST 2008

o Prefer CMYK color space if possible - The checkbox Prefer CYMK color space if
possible has the effect that you will be offered to enter CMYK color values in the

process of creating the layout which supports the printing process of the file.

Note: The CMYK colors values that you enter in the fields may differ from the displayed
colors.

¢ Use selected unit of measures in XSL output - XSLfast offers you to use four different

units of measures in the layout. These measures can be: points (pt), millimeters
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(mm), centimeters (cm), and inches (in). By default, all these measures are converted

internally into points (pt) in the generated XSL file. To avoid converting the unit of

measures used in the layout, XSLfast offers you to use the selected unit of measures in

the XSL output: Use selected unit of measures in XSL output means that the currently

selected unit of measure (mm, pt, inch, and cm) is assigned for the XSL output. If this

option is unchecked, all units of measure are converted into pt in the XSL output.

e Paint cropmarks - This option provides ability to draw crop marks at PDF. Basically,

crop marks are necessary to indicate the size of page, including regions and margins,

and will not be seen in case, the printer paper is the same as layout size, and will be

played only if you need to print small page on large paper.

Note: This option requires SVG support to be activated.

o Use bookmarks - This option is used to display bookmarks in the generated PDF. This

helps to view the topics of the document and navigate to the topics directly.

Page-master. pdf - Adobe Reader

File Edit View Document Tools Window Help

x

Options v

=& Page
=-E] Types of page

D Regions in a
Page

E Insert Page
[l i

= Page Properties
AN

Bookmarks

except the pagg
elements.

If you uncheck this option, the bookmarks are not displayed in the PDF.
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Embed Fonts - The function Embed fonts are necessary if you are planning to embed

fonts, used for PDF generation into that PDF file.

Embed all fonts, also Base-14(necessary for PDF/A) - The function Embed base-14
fonts provides non-standard embedding even for well-known standard fonts like
“Courier” and “Helvetica”. This option is useful to make PDF files close to PDF/A

standard.

XSL output encoding - XSLfast offers the possibility to choose the encoding which the

XSL output should have, select the encoding from the list box XSL output encoding.

Default XSL-FO processors - The option allows selecting the default XSL-FO processor.
Whenever you open XSLfast, the default XSL-FO processor will be selected.
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XSD/DTD Settings

The XSD/DTD settings tab contains the setting options for XSD/DTD files. The XSD/DTD settings
tab has the following options:

¢ Enable custom entity descriptions

e DTD file path

¢ Enable custom namespaces

e XFN file path

XSLfast preferences

[ General aptions
DView options

[ additional aptions
[performance options
DCompatibiIity options
DXSL output settings
[JxSDIDTD settings
[lcsw settings
(Default settings

XSD/DTD options
[ Enable custom entity descriptions

DTD file path
[7] Enable custom namespaces

XFN file path

o

¢ Enable custom entity description - Some special characters cannot be entered as plain

text in XSLfast, but must be defined as an entity. If you want to have your own custom

entity descriptions added to the target XSL and XSL-FO files, check Enable custom

entity descriptions and select the file containing the descriptions with the browser

window. It is usually a simple text file with the extension .xfd, where the required

entities are listed (e.g. <!ENTITY euro "&#x20ac;">, which can be used to add the Euro

sign (as &euro;)). This function allows you to add your own custom entity descriptions

to the target XSL files and enhance the range of entities in XSLfast. A typical entity file
could look like this:

<!ENTITY euro "&#x20ac;">

<!DOCTYPE xml

[<!ENTITY pound "&#163;">]>
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All entities can be listed this way.
e DTD file path - Specify the path of the DTD files.

¢ Enable custom namespaces - Enable custom namespaces is used e.g. for Java
namespaces or your custom XSLT engine extensions like Saxon or MS XSLT component.
This is typically a simple text file with the extension .xfn. Custom namespaces are used
to add custom functions like Java mathematical functions, and custom elements inside
XSL, like Saxon variables. Just a simple example is

xmlns:saxon="http://icl.com/saxon". A typical namespace file could look like this:
<xmlns:jcat="http://jcatalog.com/jCatalog”>
<xmlns:xslfast="http://jcatalog.com/XSLfast”>

<xsl:stylesheet

xmlns:date="http://www.jclark.com/xt/java/java.util.Date”>

All namespaces can be listed this way.

o XFN file path - Specify the path of the XFN files.
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CSV Settings

The CSV settings tab contains the settings option of CSV files. The CSV settings tab has the
following options:

e CSV encoding

e CSV delimiter

e (CSV quote

e Root element name
¢ Row element name

e Column element name

XSl fast preferences X
[(icensral optioes (S¥ settings
[ cptions CS¥encadng UTs -
Dladdtonl opt d
:}j f : CS¥ defmicer v
| Kompatiity cpbons C5¥ quate -
JSL cutput setbngs
/DD setts oot element name:
[icsv settings Row element name
EdDefaut settings Coburrn element nane

e CSV encoding - The encoding of the assigned CSV files.
e CSV delimiter - A character that separates values in the CSV file.
e CSV quote - A quotation character used in the CSV file.

¢ Root elements name - The name of the top-level node in XML that the CVS files are

converted to.

¢ Row elements name - A node of this name is created to include values of each line in
the CSV.
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Column element name - The name of nodes that contain actual data from the CSV.
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Default Settings

XSLfast offers you to make default settings for all the elements. This feature is useful if you

need to create several identical objects with the same values for different parameters. The

folder in the list on the left contains more options for this purpose.

XSLiast preferences

| JGeneral options

[ view options

[ additional options
| JPerformance options
| Jcompatibility options
[ J#sL output settings
| J%s0/DTD settings
[ Jesvy settings
CADefault settings

| Page

| Jcall template

| Line

| Chart

| st

|_JPivot table
Table

| )Citation

| Jindex

| JPagination
isquare

| Joate/Time

| Jinternet link

| Jimage

| JBarcode

| JXSL Text
Numeric Field
Text

Categorized | alphabetic

Properfy

IFont
& Frame proportio
4 Bounds
Absolute position
4 Paddings
Left padding
Top paddirg
Right padding

Bottom padding

Barder
HMorizontal allgnment

Span

.

XEL-FOQ optlons
Wrap bext

Collopse space:

Normalize spaces inside XML

Disable output escaping

Suppress IF ampty

Font...

Value

[Absolute position: true; Paddings: [Left padding: 0....

[l

[Left padding: 0.0 pt; Top padding: 0.0 pt; Right pa,..

0 pt
0 pt
0pt
O pt
Border ...

Lett
[ hane

| Restore default settings I

(o] [caneei ]

All functions and features for all the elements can be seen here. Settings made here are

considered as default and are saved within the application. If you want to restore the original

settings, click “Restore default settings” button.
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Page

The Page properties are already explained in Page Chapter

Page chapter, for more details.

. Refer Inspector Window section in

XSl fast preferences =
| JGeneral options Categorized [Alphabntlc
[ Jview options i | g '
| Jadditional options RECRRECY, Sk
| JPerformance options Sizel | Ad x|
| Jcompatibility options Width 598 pt
| Jwsl output sattings Height 845 pt
[ 1%sD/DTD settings Orlentationt [“Portrat -
DCSV aetngs columns 1
CADefault settings ”
JPOOC Gap between columns 10 pt
_]Call template st bitle
| Line Description
:_]chert Background color
L Juist Force page count [Tno-force -
%’;:’;t&tablo » Background Image
JCIt-tlon a Raglon pracedences N
| Jindex Top [
_JPagination Battom 1
gs::uaro 4 Ragions
Date/Time Left 28
- pt
| Jtnternet link R 26 pt
gh
| Jimage e P
| |Barcode Top 28 pt
| IXSL Text Buttom 28 pt
| JNumeric Fisld a Paper marging
LTt Left 10 pt
Right 10 pt
Top 10 pt
Bottom 10 pt
A Custom page attributes
Custom attribute name 1
Custom atbribute value 1
| Restore default settings ]

[0k [ ancel|
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Call Template

The Call Template properties are available in inspector window of Call template element.

Refer Inspector Window section in Template element, for more details.

XSLtast preferences =

|_JGeneral options Categorized l;lphabetlc I

[ view options e o

[ Jadditional options Property ‘ Value |
Performance options 4 ['rame properties

[ JCompatibility options « Bournds [Absolute position; false]

[ st output sattings Absolute position ]

Bxso/mn sottings Width 100 pt
CSV settings 4

EIDsFaul sattings ey ARRS

| JPage

| Jcall template

| Line

| JChart

| uist

| JPivot table

| JTable

| )citation

| Jindex

| JPagination

| Jsquare

| Joate/Time

| Jinternet link

| Jimage

| JBarcode

| JxSL Text

| JNumeric Fleld

| Text

| Restore default settings ]
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Line

The Line element has the following options:
e Line width
e Line color
e Pattern

These properties are already explained in Line section of Elements chapter. Refer Inspector

Window section in Line element, for more details.

XSLfast preferences 93
| )General options Catagorized |ﬁipiiabei]'c l

[ Wiew options - -
[)additional aptions il ' e !
| Jrerformance options Line width 1pt

|_Jcompatibilty options Line colar |
[ 1451 autput settings Pattern| -~
| J%S0I0T0 settings
| sy settings
Clpefault settings
[ JPage

| Jcall template
| Line

| Chart

st

|_JPivot table

| Table
:]Cltetlun

| Jindex

| JPagination

| )square
jDate.leme

| Jinternet link
| Nmage

| JBarcade
|J%SL Text

| INumeric Field

[ Text

| Restors default settings ]

| __2_!5_“ Cancel I
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Chart

The Chart properties are available in inspector window of Chart element. Refer Inspector

Window section in Chart element, for more details.

| JGeneral options

| Miew options

[ Additional aptions

DPerFormanco options

| Jcompatibility options

[ 141 output settings

Bxso/om settings
CSY settings

lpefault settings

[ JPage

| Jcall template

| Line

[ JChart:

| Juist

|_JPivot table

| Table

| Jcitation

Jindex

| JPagination

| )square

| JbateTime

|_Jinternet link

| image

| Barcade

| J%sL Text

| Numeric Fleld

[ Text

XSLiast preferences 23
Categorized phabetlc J

} onpq(ﬁy | Value |
Type | Dar Rl
Width 1423 pt
Helght 142.3 pt
Chart type | 3D Chart v |
Values
custam chart color ]

Background coloy
a Frame properkin
a Bounds
Abmolute position
& Paddings
Left padding
Top padding
Right padding
Bottam padding
Border

Span

[Absolute position: true; Paddings: [Left padding: 0.,

(v

[Left padding: 0,0 pt; Top padding: 0.0 pt; Right pa...

0pt

0 pt

0pt

0 pt
Border ..,
[ hone

l Restore default settings ]

I...E.'.‘,J ,.Cancpil, |
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List

The List properties are available in inspector window of List element. Refer Inspector Window

section in List element, for more details.

XSl fast proferences =
|_Jaeneral options Categorized [ Alphabetic |
[ View options ey e ’
[ Jadditional options SRR ‘ g
| JPerfarmance options Kind (1 e
| Jcompatibility options Width 1138 pt
[ %50 output settings Height 227.6 pt
[ J4SDOTD sottings ffont fort..:
| Jcsv settings é
. Backaround colo
JDefault settings A
b Tt cob ———
Jc.|| template Label start indent 30 pt
| Juine bl end indent 10 pt
| |chart Fravisional distance between starts 24 pt
»3”“ Provistonal label separation 16
avistional label separstio pt
|_JPivot table
JTabIo Koop togathe |
]Cltatlon Keep with next ]
:]]ndex Kianp with previous 7]
|_JPagination 4 Frame properties
JSquaro 4 Vournds [Absolute position: true; Paddings: [Left padding: 0.,
3?5:5!“"'; ‘ Absolute position [v]
_]I:':;:.t n 4 Paddings [Left padding! 0.0 pt; Top padding! 0,0 pt; Right pa...
asercodo Left padding 0pt
[ Sl Text Top padding 0 pt
| INumeric fisld Right padding 0pt
.JTe"t Boktom padding 0pt
Bordat Border...
Marizontal alignmert | Lett hdl
Span | hone hal|
4 X51-FO optlons
Wrap text [v|
Collopsm spaces m
Narmalize spaces inside XML 1
Disable outpul escaping ]

Restore default settings
| Restore defauk seting: |
[ ok || cancel |
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Pivot Table

The Pivot table properties are available in inspector window of Pivot table. Refer Inspector

Window section in Pivot Table element, for more details.

XSLfast proferonces 2
DGaneraI optlons Categorized I Alphabetic |
[ View options i T
[ Jadditional options OREERY, L
[_Jperfarmance options 4 Pivot table fox
[ Jcompatibility options Number of rows 1
[ 450 output settings Numbor of columns 1
DXSD/DTD sottings Fow height 30,0
If_,j_-csv Sotfings Column width 80,0
JDefault settings -
:JPGOB Default coll border Border..,
| \call termplate Iitle column width 00,0
JLIne Title raw hight 30,0
| JChart Show values as | Guartty for non-numbers view v |
| st Use grand Latal summary
-JJ:':;:"H' Grand total text
Clcitation Lize |abels [
:j]ndex Columns sork attribute "
|_JPagination Raws soit attribute
]square Background image o
3105:0!"':; ‘ Background color b
JI;:;:. L Logical style | gelem atyle |
Jsmcode Row properties [ -
:stl. Tt Calume propesties T =
| INumetic fild 4 Frame propertios
et 4 Bounds [Absolute position; Falss; Paddings: (Left padding: (..
Abrolute position ]
4 Paddings [Left padding: 0.0 pt; Top padding: 0,0 pt; Right p...
Left padding Opt
Top padding 0pt
Right padding 0 pt
Bottom padding 0pt
Border Border...
Harizantal alignment | Left -]
Span | none v v
Restore default sptélngs I

ok
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Table

The Table properties are available in inspector window of Table. Refer Inspector Window

section in Table element, for more details.

XSLfast preferences =
DGeneraI optlons Categorized l Alphabetic |
[ Wiew options 5
[ Jadditional options Firopatty l value
| JPerfarmance options 4 Table
| Jcompatibility options Number of rows 2
[ %50 output settings Numbor of column 2
Bxso/mo sottings roblis haadr ]
CSV settings
Jbefault s:ttlnqs Taule foater ]
apage Row height 30.0
| )call template olumn width 00,0
;]Llne Background image
%Chart Background color
List Omit header page break
ﬂ:lv;t table Omit Iru'::'n |:::: I"me:i g
:]C::a:l'on Logical style | Select style v
amdex Row properties [ -
L_Pagination a Frame propertios
35‘1'-'5'9 4 Vournds [Absolute position;: False; Paddings: [Left padding: 0.
Ej]z_‘:t:'mrﬁnk Absolute position ()
[Jimage 4 Paddings [Left padding! 0.0 pt; Top padding! 0,0 pt; Right pa...
:Barcodo Left padding 0pt
[ Sl Text Top padding opt
L INumeric fiald Right padding 0pt
JText Bobtom padding Opt
Border Border...
Iarizontal alignmert: | Lett -
Span | norne - |

Restore dafault,sptélngs I
o]
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Citation

The Citation properties are available in inspector window of Citation. Refer Inspector Window

section of Index and Citation elements, for more details.

XSLfast preferences

| JGeneral options

| Miew options

BAddltlonal options
Performance options

[ Jcompatibility options

[ %S0 output settings

[ J%s0/OTO settings

| )Csv settings

CDefault settings

Page

|_call template

e

| Jchart

| uist

| Pivel table

| Jrable

| Jciation

| Jindex

| Pagination

|_]square

|_|pate/Time

| internmt link

| Jimage

| |Barcade

5L Taxt

| JMumeric field

| Text

Categorized Alphal:;ﬂc_ l
Property
Name 7
Width
Halght
Text color
Background color
a Frame properting
& Bounds
Absolute position
4 Paddings
Left padding
Top padding
Right padding
Botbom padding
Border
Morizontal alignment:

Span

227.6pt
17.1 pt

Valus

[Absolute position: true; Paddings: [Left padding: 0.,

vl

[Left padding: 0.0 pt; Top padding: 0.0 pt; Right pa...

0pt
0pt
0 pt
0pt
Border,

| Lett

| none

| Rustore default uttlngsJ

[Lok || cancel |
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Index

The Index properties are available in inspector window of Index. Refer Inspector Window

section in Index and Citation element, for more details.

XSLfast preferences 3
| JGeneral options Categorized | alphabetic |
DV'.W thlﬂﬂ‘ eSS t ’ B | O ‘
[ JAadditional options FrORMEY ol :
| Jperformance options Name
| Jcompatibility options Width 113,08 pt
[ 1451 output settings Meight 17.1 pt
BXSDIDTD settings Background colof
(CSY settings SRR v
Frame proporties
CDefault settings 1 R
Mpage a Boundes [Absolute position: true; Paddings: [Left padding: 0.,
__jCa“ template Abmolute position v]
| ine & Paddings [Left padding: 0,0 pt; Top padding: 0,0 pt; Right pa, .,
%chart Lusft padding 0pt
List Top padding 0 pt
ﬂ:‘:;::table Right padding 0 pt
Citation Bottom padding 0pt
ﬂlndox Border Border..,
_jPaolnatlon Horlzontal alignment | Lert -
| Jsquare span [hone -
| JoateTime
| Jinternet link
| image
| lBarcade
| J%5L Text
| INumeric field
[ Text
| Restora default settings |

L_QE{_I ,,Canqel |
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Pagination

The Pagination properties are available in inspector window of Pagination. Refer Inspector

Window section in Pagination element, for more details.

| General options

| View options

[ JAdditional options

DPerFormanco options

| Jcompatibility options

[ 1451 autput settings

BXSDJ'DTD settings
CSY settings

Clpefault settings

[ JPages

| Jcall template

| ine

| JChart

st

|_Pivot table

| Table

| Jcitation

| Jindex

| JPagination

| )5quare

]Deteh’lmo

| Jinternet link

| Jimage

| IBarcade

| %S0 Text

| INumeric Field

[ Text

Categorized Alphabetlc |

Text betore

Text after

Use page numbering "n of N

Font
Teoxt color
Background color
Width
Hulght
@ I'rame properties
4 Bounds
Abszolute position
4 Paddings
Left padding
Top padding
Right padding
Bottom padding
Bordar
Harizantsl alignrmmnt

Span

XSLiast preferences

Property

9
Value
]
Font..,
113.8 pt
17.1 pt

[Absolute position: true; Paddings: [Left padding: 0,,,,

vl

[Left padding! 0.0 pt; Top padding! 0.0 pt; Right pa...

0 pt

0pt

0 pt

0pt
Border, .,
[ Left

| nones

| Restore default settings ]
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Square

The Square properties are available in inspector window of Square. Refer Inspector Window

section in Square element, for more details.

| )General options

| Jview options

[ Jadditional aptions

DPorFormun:o options

| Jcompatibility options

[ J#s1 output settings

Bxso/m‘o settings
CSY settings

Cpefault settings

[ JPage

| Jcall tamplate

| tine

| Chart

| st

|_JPivat table

| |Table

| )citation

| Jindex

| JPagination

[ Jsquare

| Joate/Time

|_Jinternet link

| Jimage

| JBarcade

|JX5L Text

| INumeric field

[ rext

Categorized | alphal otic

Background color
Width
Height
4 Round corners
Aerounding value
Yeraunding value
& Frame propertios

Horder

XSLfast preferences

113,8 pt
113.8 pt

[

16.0
15.0

Border, .,

| Restore default settings ]

L..E.'.‘,_I ,Canqell, l
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Date/Time

The Date/Time properties are available in inspector window of Date/Time. Refer Inspector

Window section of Date/Time element, for more details.

XSLfast preferences

| JGeneral options

| Miew options

BAdditlond options
Performance options

| Jcompatibility options

[ %51 output settings

[ JxspjoTO settings

| )csv settings

CDefault settings

JPage

|_call template

e

| Jchart

| st

| JPivot table

| rable

| JCiation

| Jindex

| Pagination

|_)square

| |oate/Time

L JInternmt link

| Jimage

|_|Barcade

[ )50 Taxt

[ Ivumeric Field

[ Jrext

Categorized Alphab_stlc_[

Proparty
Type 7
Width
Halght
Clutput Format
Twxt lalore
Tt sflmr
HPath before
HFath after
Translate date separstor from
Translate date separator to
Translate time soparator from
Translate Hine separator Lo
Font
Taxt color

Background color

4 I'fame properties

& Dounds
Abcolute position
a Paddings
Lot padding
Top padding
Right padding
Hottom padding
Border
Horlzontal alignment

Span

=
Valus
Dynamio text (XML -
113.8pt
17.1 pt
dd MMMM yyyy
Font,.,

[Absolute position: true; Paddings: [Left padding: 0....

[¥]

[Left padding: 0.0 pt; Top padding: 0.0 pt; Right pa...

0pt
0 pt
Opt
0pt
Border...

| Lett

v |

| none

- |

Rustore default nttlngsJ

[Lok || concel |
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Internet Link

The Internet link properties are available in inspector window of Internet link. Refer Inspector

Window section in Internet Link element, for more details.

| JGeneral options

[ iew options

[ Jadditional options

DPorFormonco options

| Jcompatibility options

[ J451 autput settings

Bxswom settings
CSY settings

Clpefault settings

[Page

| Jcall template

| uine

L JChart

| Juist

|_Pivot table

|_Table

| JCitation

| Jindex

| JPagination

| )Square

| JbateTime

| Jinternet link.

| Jimage

| Barcade

| %S0 Text

| INumeric Field

[Text

Categorized A]phgbetjc
Lire height
Width
Meight
Destination type
Type
Sbject land
Fant
Twxt calor
Background color
Keop together
Keop with next
Keep with previous
4 Frame properties
4 Bounds
Absolute posltion
& Paddings
Lalt padding
Tap padding
Hight padding
tottom padding
Horder
Harizontal alignment
Span

XSLfast preferences

s

12,0 pt
2276 pt
17.1 pt

value

| Web link

|

[ Dynamic text (ML)

| Text
Font, .,

[]
[]
[

[Absalute position: true; Paddings: [Left padding: 0....

[~

[Lelt padding: 0.0 pt; Top padding: 0,0 pt; Right pa,..

0 pt
0 pt
0 pt
Opt
Border...

| Lett

w |

| none

w |

| Restors default settings ]

|. Ok l Cancel I
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Image

The Image properties are available in inspector window of Image. Refer Inspector Window

section in Image element, for more details.

| JGeneral options

| Wiew options

| JAadditional options

DPorFormanco options

| Jcompatibility options

[ 1451 output settings

Bxswom settings
CSY settings

Clpefault settings

[ JPage

| Jcall template

| Line

| )Chart

| Juist

|_JPivot table

| |Table

| Jcitation

| Jindex

| JPagination

| Jsauare

|_Joate/Time

ﬂtntarnet link.

Image

| IBarcade

| %S0 Text

| INumeric Field

[ Text

XSLiast preferences s
Categorized [ alphabetic l
: Property value
Width 113,080 pt
Melght 113,08 pt
Image base path |
Fitin Frame [v]
Keop aspoct ratio [v]
Image type; | Dynamic -

& Frame propertisg
a Bounds
Absolute position
& Paddings
Left padding
Top padding
Right padding
Bottom padding

Bor et
Hatlzantal alignmenit
Span

& #51-FO options

Suppress IF smpty

[Absolute position: true; Paddings: [Left padding: 0,,,,

vl

[Left padding: 0.0 pt; Top padding: 0.0 pt; Right pa.,,

0pt
0pt
0 pt
0pt
Border...

[Lett
| none

| Restors default settings l

L..E.'.‘J ,,cgnqe.l, l
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Barcode

The Barcode properties are available in inspector window of Barcode

section in Barcode element, for more details.

| JGeneral options

| Wiew options

[ JAdditional options

DPerFormanco options

| Jcompatibility options

[ 1451 output settings

BKSDJDTD settings
CSY settings

Clpefault settings

[ JPage

| Jcall tomplate

| uine

| Chart

| Juist

|_JPivot table

| Table

| Jcitation

| Jindex

| JPagination

| Jsaquare

|_Jpate/Time

| Jinternet link

_Jimage

| JBarcode

| J%sL Text

| INumeric Field

[ Text

Categorized lephabetlc

Background color

Width
Height

Generation type
Barcode kind

Barcode haight

Module
Foant

& 'rame properties

. Refer Inspector Window

|

XSLfast preferences 3
Property Value
113,08 pt
28.5 pt
| XML Bazed text, SVG graphics - |
=

& Dounds
Absolute position
4 Paddings
Left padding
Top padding
Right padding
Brottom padding
Bordar
Horlzaritasl alignrmmnt

Span

["EAN-E
18 pt

1 pt
Font,,,

[Absolute position; trus; Paddings: [Left padding; 0., .,

vl

[Left padding! 0.0 pt; Top padding! 30,0 pt; Right p...

0pt

30 pt

0 pt

30 pt
Border,,,

| Left

| none

| Restors default settings |

[Lok | concal |
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XSL Text

The XSL Text properties are available in inspector window of XSL code. Refer Inspector

Window section in XSL Code element, for more details.

XSLfast preferences

| )General options

| Wiew options

[ Jadditional options

DPerFormon:o options

| )compatibility options

[ 51 output settings

Bxswmo settings
CSY settings

Clpefault settings

[MPage

| Jcall tamplate

| Line

| JChart

| Juist

|_JPivat table

| Table

| Jcitation

| Jindex

| JPagination

| )square

_Jate/Time

| Jinternet link

| image

| Barcade

| J%SL Text

| INumeric Field

[ Text

Categorized Klpha'bgﬂ;
Property
I"ont ‘
Width
Height
Text color
Backaround coloy
Line halght
& Frame proportiss
a Hounds
Absolutes position
a Paddings
Left padding
Top padding
Right padding
Bottarm padding
Bor cler
Harizantal alignmmenit
Span
@ 25RO options
Gunerate xshapply-templates instead of et
Lscape comparison signs
Wrap text
Collapse spaces
Normallze spaces inside XML

Digsable output escaping

Eacd
Value
Font, .,
227.6 pt
17.1 pt
14,5 pt

[Absolute position: true; Paddings: [Left padding: 0,,,,
[¥]

[Left padding: 0.0 pt; Top padding: 0.0 pt; Right pa,,.,
0pt

0pt

0 pt

0 pt

Border ...

[Lett -
[ none hdl

OO00OROO

| Restore default settings I

[Lok || cancel |
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Numeric Field

The Numeric field properties are available in inspector window of Numeric field. Refer

Inspector Window section in Numeric field element, for more details.

XSLfast preferences 22
[ )General options Categorized | alphabetic
D'diew options ‘ o
Dndditiond options — Eroperty o — 2ue :
[Jperformance options Tipe Dynamictext (M) bl
[compatibility options Width 227.6pt
[sL output settings Height 17.1pt
[[)%sD{DTD settings Format #3#,##0.00
[Clcsy settings £
= Decimals separator :
dDefault settings
D Thousands separator
Page
DCaII template Text before
[tine Text after
Dchart Translate from MaN
DUSt Translate to 0
[CJpivot table :
Inner translate from H
[(Jrable
DCitation Innet translate to .
[index Replace zero values to
CPagination Test color I
[Csquare Background color g
%Dateﬁlmle K 4 Frame properties
Internet linl
Dlmage 4 Bounds [Absolute position: true; Paddings: [Left padding: ...
[arcode Absolute position
DXSL Text 4 Paddings [Left padding: 0.0 pt; Top padding: 0.0 pt; Right p...
[ Jnumeric field Left padding Opt
[(rext Top padding Opt
Right padding 0pt
Bottom padding 0pt
Border Border...
Horizontal alignment | Left |
Span |_none kd
4 XSL-FO options
Wrap text
Collapse spaces (|
Mormalize spaces inside XML (| -
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Text

The Text properties are available in inspector window of Text.

in Text element, for more details.

| )General aptions

|_Wiew options

[ Jadditional options

DPerFormence options

| Jcompatibility options

[ )45k output settings

BXSDIDTD setkings
CSY settings

Cpefault settings

[ JPage

| Jcall template

| ine

| Chart

st

|_Pivot table

|_|Table

| Icitation

| Jindex

| JPagination

| )square

JDatulTlme

| Jinternet link

| Jimage

| JBarcade

|_J¥sL Text

| INumeric Field

[ Text

Categorized 'Aiﬁlﬁabe't-lic

Background color
Width
Meight
Line helaht
a Frame proporties

4 Bounds

Abwalute position

a Paddings

Lesft padding
Top padding

XSLfast preferences

Property

Right padding

Bottom padding

Border

Horizontal alignment

Span

SLFO Options

IS

Loktar spacing

HTML markip conyersion

Wrap text

Collapse spaces

Normalize spaces inside XML

Dizable output escaping

Suppress i empty

Refer Inspector Window section

Vliul

2276 pt
17.1 pt
opt

i

[Absolute position: true; Paddings: [Left padding: 0.,.,

[¥]

[Left padding: 0,0 pt; Top padding: 0,0 pt; Right pa, .,

0 pt
0 pt
0pt
0pt
Border...

| Lett

v |

| none

0 pt
[Z]
(vl
[]
[
]
]

]

| Restore default settings I

Select the element you need from the tree on the left. Then set the parameters values for it in

the inspector window on the left.

The settings you make in the folder Default Settings itself refers to all elements you create

after you make these settings.

449 |Page



Other Features of XSLfast

This chapter explains about the special features of XSLfast. The following features are

explained in this chapter:
e View XSLT output
e XPath-Monitor
e Generate font metrics
e Transformation
e Convert XSL-FO to layout
¢ Convert HTML to layout

e Merge XML files
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XSLT Output

The menu View XSLT output opens an XSLT file, which was generated after you processed the

layout. To open XSLT output window, click Tools = View XSLT output, or press Ctr{+Shift+V.

The XSLT output window appears.

XSLT output =
- X B | v Oy [[] Case sensitive [] Whole words anly
1 <?xml wversion="1.0" encoding="UTF-8"2> =
2 =
3 <!-— File was generated by XSLfast 5.0, build 1§/01/2012 -->
4 <!-- Layout version: 0 ——>
3 <!-- Please leave unchanged; manage layouis instead ——>
3 <IDOCTYPE xsl:stylesheet [
7 <IENTITY XML "http://www.w3.0org/TR/REC—ml">
8 <IENTITY XMLHNames "http://www.w3.0xrg/TR/REC-xml-names">
=] <IENTITY XSLT.ns "http://www.w3.0rg/1999/XSL{Transform">
10  <IENTITY XSLTA.ns "http://www.w3.0rg/1999/XSL/TransformAlias">
11 <IENTITY XSLFO.ns "http://www.w3.0xrg/1999/XSL/Format">
12 <IENTITY copy "&#169;">
13 <IENTITY trade "&£#8482;">
14 <IENTITY deg "&#x00b0;">
15 <IENTITY gt "&#62;">

16  <IENTITY sup2 "&#x00bZ;">
17 <IERTITY fracld "g#x00bc;">
18 <IENTITY quot "&#34;">

10 < IRHTTTY Franl?2 tc#viNhd: i~
o]

»

Column: 1, line: 1

l Close |

This is a shortcut to the window, which opens if you click the “View” button of XSLT output in

the Layout settings window under Input/Output settings tab.
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Layout settings: version0

X4

_Additional templates I Layout description " Advanced options " Security.
Input/Output settings I Generation options.
~Input
RML-File: |..,u‘input,fTutoriaIIO3_TabIe,IXMLIexampIe.me ]| ™ I Edit |
["] Do not bind layout to top node
~Output
Output type:  Porkable Document v Open in viewer ~FO Processor:
l I m () FOP 0,20.5 {stable)
Output file: .. jinputTutorial/03_Table/Table.pdf
p | finputf /03 _Tablef p it ) FOP 1.00
¥SLT output: 'L Jinput/Tutorial/03_TablefXSL_FO/Table.xs | | e | L View ' () XEP
%SL-FO output: |..finput{Tutorial/a3_Table/x5L_FO/Table.xsl.fo | | view | © Btronnatte;

Encoding:  UTF-8
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XPath Monitor

The XPATH monitor allows you to apply XPATH code on your document if you have the
necessary knowledge. To open XPath preview window, click Tools = X-Path Monitor, or press

Ctrl+Q. The XPath preview window appears.

XPath preview = [E X
WML structure ¥Path expression Nods Set
4 Result: Sting
v::Report Boolean
Number
Date(Time
Math
Today
Templates
This field is helpful to check XPath expressions in general or for certain parts of the XML
structure, You can drag and drop tree nodes into this window to add them to the
expressions, The context menu also offers you a choice of ¥Path expressions,
1 | Evaluate l | Close l
V -t A
The result of XPath expression,
v I &, I & I 4 | | The result can be numbers, plain text or tree, depending on your request.
P(Path origin:

The user, who has knowledge of XPath, will know and appreciate the possibilities that this
monitor offers them. This section, explains the general function of this monitor, for the users
without the knowledge of XPath.

XPath is a language for addressing parts of an XML document.
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If you have already loaded an XML file, you will see the XML structure in the monitor. An XPath
expression is entered in the field XPath expression and the XML structure level from which the

expression is supposed to be applied is selected. It is also possible to drag nodes from the XML

file into the window.

The context menu also offers some XPath expressions to choose from.

Product ProductSh="203002
Product ProductSNe"203003
Product ProductSh="203004

XPath preview (=) (= =
MML structure HPath expression Node Set
# Result; String
4 Report Boolean
» ProductGroup Number
# ProductGroup Data)Time
ParentProductGrpld ;20" Insert >
" " Math
PraductGrouplD ¢ 2030 R L XPath » || Productin 3
ObjPropertyGrouplD : "EG1 IR ProductGroup{Product
HisrarchyCode : "002002" ¥ Linda SE | pegcshort
g“c;:nqg H "9\;1 : | x Cut il DefaultPrice/ValldFromQuantity
escShort + "Write Implemen) o | - ctiC DefaultPrice/NetPrice
Product Productshm"zaao01] | TS field is helpful ta check (%) copy f Dy icioske
structure, You can drag and |7 Paste CHlv -

expressions, The context M amu i s you e e uy-| /Report

v

-

-~

[evoluote | [_ciose |

Product ProductSh="203005|

Product ProductSNw"203006

Product ProductSh="203004
¥ Product Product SN="2030101

» ProductGroup

¥ ProductGroup

vy vy v eww

il

-
M AN

The result can be numbers, plain text or tree, depending on your request,

Path origin: /Report/ProductGroup

When you enter XPath expression, the syntax is checked and mistakes are highlighted if “Use

syntax verification” option is checked under XSLfast preferences - Performance option.

Refer Performance Options section for more details.

Enter the XPath expression and click "Evaluate” button, to view the result in The result of

XPath expression field. The “Close” button, closes the window.

454 | Page




Generate Font Metrics

When you first install XSLfast, you need to register the fonts that are supposed to be
supported; otherwise the output files may not be legible or cannot be generated. Use the menu
Generate font metrics that opens, when you first start XSLfast. You should also register the

fonts, when you install a new renderer.
To generate font metrics follow the steps below:

1. Click Tools 2> Generate font metrics to open Font metrics window.

Font metrics X3
-Font metrics
List of available fonts
Arial -~
Arial Black =
Comic Sans M3
Courier MNew
DejaVu Sans
Deja¥u Sans ExtraLight -

Select all [] Select system fonts only [] Unselect all

Detailed font metrics are required ko make accurate XSL-FO rendering possible. Please select the fonts that you would like to
work with in XSLFast so that they can be registered with the Renderer. This is only necessary on the first start of XSLFast, if
you choose another Renderer or if you want to add new fonts,

Please select the Renderer you are currently working with. XSLFast uses FOP by default:
| FOP 0,20.5 FOP1.00  [|XEP  []%SLFormatter

Log

11

L d

0% | Ok ‘ Cancel

2. XSLfast inspects the system fonts and displays the available fonts in List of available
fonts field. Select the fonts from the list, there are options available select and

unselect fonts:

455|Page



e Select all
e Select system fonts only
¢ Unselect all

Select the fonts that you want to support in XSLfast, from the list of available fonts. If you

are not sure, select all fonts. You can always add more fonts later.

3. Select the renderer you need to work with, so that all selected fonts are registered

with the renderer. The available renderers are:

FOP 0.20.5

FOP 0.95

e XEP

XSLFormatter

By default, XSLfast works with the Renderer FOP. You can also select all three Renderers
simultaneously and generate the corresponding font information, at once if you have
installed all three renderers. You need to register the fonts again if you install new fonts or

use another Renderer.

Note: PDF supports the following fonts:

TIMES_ROMAN

TIMES_BOLD

TIMES_ITALIC

TIMES_BOLD_ITALIC

HELVETICA
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HELVETICA_BOLD

HELVETICA_OBLIQUE

HELVETICA_BOLD_OBLIQUE

COURIER

COURIER_BOLD

COURIER_OBLIQUE

COURIER_BOLD_OBLIQUE </b></li>

SYMBOL

ZAPF_DINGBATS

All other fonts need to be embedded in the PDF document to make sure that everyone can view

the document correctly.

4. Click “Generate” button to generate the font metrics. The Progress can be seen in Log
field.
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Font metrics =

-Font metrics
List of available fonts

Arial -

Arial Black

Cornic Sans M3

Courier New

DejaYu Sans

DejaYu Sans ExtraLight -

|| Select all | | Select system Fonts only | Unselect all

Detailed Font metrics are required to make accurate XSL-FO rendering possible. Please select the Fonts that you would like to
work with in XSLFast so that they can be registered with the Renderer. This is only necessary on the first start of XSLfast, if
you choose another Renderer or if you want to add new fonts,

Please select the Renderer you are currently working with. XSLfFast uses FOP by default:

v|FOP0.20.5 ~ | FOP 1,00 | XEP || ®SLFormatter
-Log
Processing file Deja¥uSansCondensed-Bold. ttf... L2

Processing file Deja¥uSansCondensed-Bold.ttf. ..
Processing file Deja¥uSansCondensed-BoldOblique. ttf...
Processing file DejayuSansCondensed-BoldOblique. ttf...
Processing file Deja¥uSansCondensed-Oblique. ttf...
Processing file Deja¥uSansCondensed-Oblique.ttf...
Pracessing file DejaYuSansCondensed.ttf...

Processing file DejavuSansCondensed.ttf, .,
Processing font Deja¥u Sans Mono. ..
Processing file Deja¥uSansMono-Bold.ttf ... x
14% ok

Some fonts may not be compatible with the XSLfast conditions. They will be listed in a window,

which opens after the registration is completed:
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Thw fekowing Ponks suiry ok Do (perabionl  FOP.

Yont.¥amily: Bookshelf Sywbol 7, Font.Name: Bookshelf Symbol 7, Fonu.File; BSSYR7.TTF,
Yont.Pach: €1\ VINDOWS\Fonts\BSs5YA7,.TTY

Font.Family: Cambris, Font.Nane: Cambria, Font.File: CANBRIA.TTC,
Font.Path: C:\VINDOGS\Fonta\CANBRIA.TTC

Font.Family: Oucloock, Font.Nawe: ¥S Outlook, Font.File: OUTLOOK.TTF,
Font.Path: C:\WINDO@S\Fonta\OUTLOOK.TTF

Font.Family: NS Reference Specialicy, Font.Name: KS Reference Spacialcy, Fonc.File: REF3FCL.TTF,
Font.Pachk: C:\WINDOWS\Fonta\REFSPCL.TTF

Font.Family: Naglett, Font.Nape: Merletr, Fono.File: mariecc,tcf,
Font.Pach: C:\VINDOGS\Fonra)\mas lect,nee

Font.Femily: Symbol, Font.Neme: Symbol, Fone.File: agnbol.tuf,
Font.Path: C:\VINDOGZ\Fonts\symbol,tte

Yont.¥ewily: Vebdings, Font.Neme: Bebdings, Font.File:; sebdings.tvf,
Font,.Path: €:\VINDOUS\Fonts\webding=,tte

Yont.¥mmily: Vingding=, Yont.Name: ¥ingdaings, Font.¥ile:; wingding.tof,
Font.Pach: <:)\ VINDOUS\Fonts\wingding, tte

Font.Family: Wingding= 2, Font.Nawe: Vingding= 2, Font.File: WINGDNG2.TTF,
Font.Path: C:)\VINDOUS\Fontas) WINGDNGZ.TTF

Font.Family: Vingdings 3, Font.Name: Wingdings 3, Font.File: WINGDNGI.TTF,
Font.Path: C:\WINDO@S\Fonta) VINGDNG3.TTY

}Java Applet Window

The fact that they are listed here does not necessarily mean that they cannot be used in

XSLfast but they may not be displayed correctly. To exclude these fonts uncheck these fonts

from the selection box and make them unavailable for XSLfast, add the font name to the
document bad_fonts.txt in the XSLfast/bin directory. On the next start of XSLfast the fonts

contained in bad_fonts.txt will not be available in the font selection any more.
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Transformation

The menu Transformation offers you the option to convert HTML tags placed in CDATA blocks
into XSL-FO. XSL-FO Renderers cannot interpret HTML tags. Therefore almost any settings made
with HTML inside the XML file will not be evaluated.

XSLfast offers the possibility to use certain HTML tags in XML files without the need to

transform them. These are:

Tag Meaning

<b> Bold

<i> Italics

<u> Underlined

<s> Size (please do not forget to add the value and the unit of measure)

<sup>  Superscript

<sub>  Subscript

<UP> Superscript

<DN> Subscript

Note: XSLfast only evaluates these defined HTML tags if the attribute for the concerned frame
was set to 'Use apply'. This makes sense when you are aware which nodes of the XML file

contain HTML tags.

If you do not know the exact nodes where HTML or CDATA blocks (e.g. <![CDATA[<b>100</b>]]>
are in the XML file, it makes sense to convert them all (plain HTML tags or CDATA blocks) into

formatting information which the Renderer can interpret.
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To convert HTML tags in XML file, follow the steps below:

1. Click Tools = Transformation, the Convert HTML tags in XML file window appears.

Convert HTML tags in XML file 23
-Escape HTML tags in source XML data -

1t is not possible to use HTML tags inside XML, because XSL-FO renderers can not
evaluate them. Nevertheless a conversion can be done manually here. The converted
file can then be used as the XML source for the layout,

CDATA processing options-
) Convert HTML tags (also inside CDATA Blocks) into XSL-FO
(@) Convert HTML tags but leave CDATA Block contents unchanged

Specify source XML file:

‘ ..JinputTutorial/03_Table/xMLfexample.xml \ | I
Specify destination XML File: ‘
’..j'input)'TutoriaI!03_Table,(XMLIexampIeHTML.xml ‘ | ]

Use this XML file as XML source For the layout

| Transform H Cancel l

2. Select the source XML file you need to convert.
3. Select the destination XML file to store the transformed tags.

4. Click “Transform” button. Convert HTML tags inside CDATA blocks to XSL-FO will start
the transformation.

A simple example: In your XML file there is a CDATA block:

<ProductGroup>

<ProductGroupID><! [CDATA[<b>100</b>]]></ProductGroupID>

<Name>Chairs</Name>
The Renderer cannot read and interpret this information.

After the transformation it looks like this:

<ProductGroup>
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<ProductGroupID>&lt;fo:inline font-

weight="bold"&gt;100&1t;/fo:inline&gt;</ProductGroupID>

<Name>Chairs</Name>
This way, the Renderer is able to interpret this information correctly.

Leave CDATA content unchanged has the effect that HTML tags, which are outside CDATA
blocks, are transformed, but the CDATA blocks remain untouched.

If you do not specify a destination file name and a directory, XSLfast will add the string

“HTML” to the end of the original file name and save it in the directory ..\input.

For your convenience, the transformed file is automatically set as data source if you check
the check box Use this XML file as XML source for the layout.

462 |Page



Convert XSL-FO to Layout

The Convert XSL-FO to layout option converts the XSL-FO file to XSLfast layout. To convert
XSL-FO file to layout follow the steps below:

1. Click Tools = Convert XSL-FO to layout. The XSL-FO to XSLfast layout convertor 1.0

(beta) window appears.

XSL-FO to XSLfast layout converter 1,0 (beta) =1of x|

This tools converts XSL-FO files into XSLFast layouts.XSLFast is one of the leading graphical
editor for XSL-FO. Details can be found at our webside http: f{fwww, xslFast.com. For further
assistence or questions please send your email to support@xslfast.com.

Please, choose input ¥5L-FO file

Please, choose output XSF file

Convert ” Close ]

{c) 2006-2010 jCatalog Software AG

2. Choose an XSL-FO file that needs to be converted. Click button to select XSL-
FO file.

3. Choose an XSF file. Click button to select XSF file.

4. Click the “Convert” button. Once the conversion is complete an Info window appears.
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-
\4) Convertation is complete

The converted XSF files are now available in the path specified in Please, choose output XSF
file field.
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Convert HTML to Layout

The Convert HTML to layout option converts the HTML file to XSLfast layout. To convert HTML

file to layout follow the steps below:

1. Click Tools = Convert HTML to layout. The HTML to XSLfast layout convertor

window appears.

FA HTML to XSLfast layout converter . IEII)_(J

With help this converter vou can easy convert HTML documents to XSF ones.
Please, choose input HTML file

| =)

Please, choose output XSF file

l 15—
Convert

2. Choose the HTML file that needs to be converted. Click button to select HTML
file.

3. Choose an XSF file. Click button to select XSF file.

4. Click “Convert” button. Once the conversion is complete an Info window appears.
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The converted XSF files are now available in the path specified in Please, choose output XSF
file field.
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Merge XML Files

The Merge XML files option is used to merge multiple XML files and create a single XML file. To
merge XML files, follow the steps below:

1. Click Tools > Merge XML files. The Merge two or more XML files into one window

appears.

Merge two or more XML files into one =3
-XML merge parameters -

Please specify the list of XML files to be merged and
the path to the destination file.

| add |
[ Edit |
| Delete l

Specify output path:
{..}'outputiresult.xml l | J

[ Use this XML as a template source

[T | e

2. Click “Add” button to add XML files.

3. Specify the path, where the merged XML file has to be stored in Specify output path:
field.

4. Click “Merge” button. The Merging of XML files starts and it displays the progress.

If XSLfast cannot merge XML file, it displays error.
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i@ 1 of 2 file(s) were not processed

The following files were not processed:
1) ../input/Demodata_de.xmwl
Reason: Documents have different root elements.

———

The “Edit” button is used to edit the selected XML file.

The “Delete” button is used to delete the XML file.

Check Use this XML as a template source, to use the merged XML file as a template.
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Release Notes

This chapter lists all the enhancements of XSLfast 5.0, with respect to its usability,

functionality, and integration.

Usability

Completely redesigned user interface.

Code completions and highlighting.

Guides.

New Table wizard - you can create table and fill it with real data in few clicks.

MDI and office-style menus

Templates now can be used like functions

New view of page sequences and regions

Preview on the fly

Multi-monitor configurations support

New zooming makes comfortable editing for all zoom levels

Previews in file operations dialogs

Search everywhere

Support of sample XML files during layout creation

Comparison of layouts
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e More details available in workarea

¢ New dialogs

Functionality

e FOP 1.0 inside

e Images in internet links

e Supported XEP strict validation

e Many elements has IF clauses managing its’ contents and visibility in output PDF
e Custom attributes overrides the settings form XSLfast

e Removed dependencies of Acrobat Reader: now we have embedded PDF viewer
e Auto-simplification of expressions while converting elements

e Advanced features available in latest FOP, XEP and XSLFormatter engines, including

markers, n of N page numbering, bookmarks, rotation, and much more.

e Many new useful functions.
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Integration

Now XSLfast has basic support of conversions of HTML and XSL-FO documents into layouts. Of

course, it does not convert everything - just most important contents like tables, texts, and

images. No JavaScript, no CSS3, no tricks.

XSLfast supports

FOP 0.20.5 inside

FOP 1.0 inside

e XEP

XSLFormatter

It can produce XSL with embedded functions for

e Saxoné (XSLT 1.1)

e Saxon9 (XSLT 2.0)

¢ Xalan

e MS XML/XSLT

XSLfast supports images directly

e JPEG/JPG
e PNG
e TIFF
e SVG
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e More formats are available if JAl installed.

XSLfast supports the following elements:

o Text (multi-style, variables and conditions inside, date/time, choose, internet links,

and more)

e XSL text

e Squares (including rounded boxes)

e Lists

e Tables

¢ Pivot tables

e Slave tables

e Chooses

e Charts

o Template calls

e Bar codes

¢ Images

e Specific text types: date/time, internet links, formatted numbers, and more

e Lines

o All elements (except template calls) can be used as templates.

XSLfast has the ability to manage for unlimited set of page sequences, with separate regions

for every layout.
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XSLfast has official support for the following platforms:

¢ MS Windows 32bit and 64bit, from Windows XP to Windows 7

e MacOS5X10.5-10.7

e Linux

473 |Page



Appendix

Unicode

These are the most common Unicode signs and their codes which may be used in XSLfast.

Sign Description

Unicode HTML

No break space

&#160;

i Inverted exclamation mark &#161;
¢ Cent sign &#162;
£ Pound sign &#163;
o Currency sign &#164;
Y Yen sign &#165;
€ Euro sign*® &euro;
! Broken bar &#166;
§ Section sign &#167;

Diaeresis &#168;
© Copyright sign &#169;
2 Feminine ordinal indicator &#170;
« Left pointing double angle quotation mark  &#171;
- Not sign &#172;

Soft hyphen &#173;
® Registered trade mark sign &#174;
B Macron &#175;

Degree sign &#176;
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* Plus-minus sign &#177;
2 Superscript two &#178;
3 Superscript three &#179;

Acute accent &#180;
d Micro sign &#181;
1 Pilcrow sign &#182;

Middle dot &#183;

Cedilla &#184;
1 Superscript one &#185;
° Masculine ordinal indicator &#186;
» Right-pointing double angle quotation mark &#187;
Ya Vulgar fraction one quarter &#188;
Va Vulgar fraction one half &#189;
Y4 Vulgar fraction three quarters &#190;
i Inverted question mark &#191;
A Latin capital letter A with grave &#192;
A Latin capital letter A with acute &#193;
A Latin capital letter A with circumflex &#194;
A Latin capital letter A with tilde &#195;
A Latin capital letter A with diaeresis &#196;
A Latin capital letter A with ring above &#197;
£ Latin capital letter AE &#198;
C Latin capital letter C with cedilla &#199;
E Latin capital letter E with grave &#200;
E Latin capital letter E with acute &#201;
E Latin capital letter E with circumflex &#202;
E Latin capital letter E with diaeresis &#203;
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i Latin capital letter | with grave &#204;
i Latin capital letter | with acute &#205;
i Latin capital letter | with circumflex &#206;
T Latin capital letter | with diaeresis &#207;
b Latin capital letter ETH &#208;
N Latin capital letter N with tilde &#209;
0 Latin capital letter O with grave &#210;
o] Latin capital letter O with acute &#211;
0 Latin capital letter O with circumflex &#212;
0 Latin capital letter O with tilde &#213;
0 Latin capital letter O with diaeresis &#214;
x Multiplication sign &#215;
0] Latin capital letter O with stroke &#216;
U Latin capital letter U with grave &#217;
0 Latin capital letter U with acute &#218;
0 Latin capital letter U with circumflex &#219;
1] Latin capital letter U with diaeresis &#220;
Y Latin capital letter Y with acute &#221;
P Latin capital letter thorn &#222;
B Latin small letter sharp s &#223;
a Latin small letter a with acute &#224;
a Latin small letter a with grave &#225;
a Latin small letter a with circumflex &#226;
a Latin small letter a with tilde &#227;
a Latin small letter a with diaeresis &#228;
a Latin small letter a with ring above &#229;
® Latin small letter ae &#230;
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C Latin small letter c with cedilla &#231;

e Latin small letter e with grave &#232;
é Latin small letter e with acute &#233;
é Latin small letter e with circumflex &#234;
e Latin small letter e with diaeresis &#235;
i Latin small letter i with grave &#236;
i Latin small letter i with acute &#237;
i Latin small letter i with circumflex &#238;
T Latin small letter i with diaeresis &#239;
o] Latin small letter eth &#240;
n Latin small letter n with tilde &#241;
0 Latin small letter o with grave &#242;
o Latin small letter o with acute &#243;
0 Latin small letter o with circumflex &#244;
0 Latin small letter o with tilde &#245;
0 Latin small letter o with diaeresis &#246;
+ Division sign &#247;
o Latin small letter o with stroke &#248;
u Latin small letter u with grave &#249;
U Latin small letter u with acute &#250;
{ Latin small letter u with circumflex &#251;
U Latin small letter u with diaeresis &#252;
y Latin small letter y with acute &#253;
b Latin small letter thorn &#254;
y Latin small letter y with diaeresis &#255;

*For the Euro sign not the number but the character string is entered. The whole expression for

the euro sign is entered without the pound key.
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Common Keyboard Shortcuts for XSLfast

Shortcut Meaning
Ctrl+N New

Ctrl+0 Open

Ctrl+S Save

Ctrl+ Shift +S Save as
Ctrl+F4 Close
Ctri+G Load structure from XML/DTD file
Alt+O Preferences
Ctrl+Z Undo
Ctrl+X Cut

Ctri+C Copy
Ctrl+Vv Paste
Delete Delete
Ctrl+A Select all
Ctrl-F Find
Ctrl+NumPad + Zoom in
Ctrl+NumPad - Zoom out
Ctrl+NumPad * Reset zoom

Alt+Shift+T Insert Text frame (XSL-Code)
Ctrl+l Insert Image frame
Ctrl+Shift+L Insert Internet link
Ctrl+Shift+D Insert Date/Time
Ctrl+Shift+P Insert Pagination

Ctrl+L Insert Line

Ctrl+Alt+Shift+T

Insert Table
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Alt+Shift+P

Grouping

Alt+P Page properties
Ctrl+P Process layout
Ctrl+Shift+M Process multilayout
Ctrl+Shift+A Layout settings
Ctr+Shift+V View XSLT output
Ctrl+M Multi Layout Manager
Ctrl+Q XPath Monitor

Alt+L Properties (Line only)
Alt+P Properties (Page only)
Ctrl+P Process layout

F1 Help
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Installation

This chapter explains the hardware and software requirements of XSLfast, how to install

XSLfast and renderers, and uninstall XSLfast.

Requirements

This section provides details of hardware and software requirements on different platforms

like:

e Windows

e Linux

¢ MacOS X
Windows

This section lists the required operating systems, software and hardware requirements of

XSLfast, on windows platform.

Operating System

e Windows XP (recommended)
e Windows 2003

e Windows Vista (all editions) 32bit and 64bit
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e Windows 7 32bit and 64bit

e  Windows 2008 32bit and 64bit

Software Requirements

Sun JRE / JDK 1.5.x or 1.6.x;

We recommend Sun JRE 1.6.x.

Our version (containing JRE inside) ships Sun JRE 1.6.

Adobe Acrobat Reader 5.x or later or Foxit PDF Reader.

Hardware Requirements

Minimum:

Intel Pentium IV 3GHz

1GB RAM

500 MB free space on hard disk

High-color resolution 1024x768

Recommended:

Intel Core2Duo 2GHz+

2 GB RAM

500 MB free space on hard disk

High-color resolution 1280x1024 or better
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Linux

This section lists the required operating systems, software and hardware requirements of

XSLfast, on linux platform.

Operating System

e SuSE Linux professional, Intel 32bit architecture

e SuSE SLES, Intel 32bit architecture

e RedHat Linux 8.x and 9.x, Intel 32bit architecture

¢ RedHat RHEL all versions, Intel 32bit architecture

¢ RedHat RHEL all versions, AMD64 64bit architecture
e SUSE Linux professional AMD64 64bit architecture

e  SuSE SLES, AMD64 64bit architecture

¢ RedHat RHAS all versions, Intel 32bit architecture

¢ RedHat RHAS all versions, AMD64 64bit architecture
¢ RedHat Fedora Core, AMD64 64bit architecture

¢ RedHat Fedora Core, Intel 32bit architecture

¢ Ubuntu 10.04+, Intel 32bit architecture

e Ubuntu 10.04+, AMD64 64bit architecture
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Software Requirements

Sun JRE / JDK 1.6.x;
We recommend Sun JRE 1.6.x.

We can ship XSLfast for other versions of Unix/Linux on request.

Hardware Requirements

Minimum:

Intel Pentium IV 2GHz

1GB RAM

500 MB free space on hard disk

High-color resolution 1024x768

Recommended:

Intel Core2Duo 2GHz

2 GB RAM

500 MB free space on hard disk

High-color resolution 1280x1024 or better
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MacOS X

This section lists the software and hardware requirements of XSLfast, on MacQS X platform.

Hardware Requirements

Minimum:

Intel Core

1GB RAM

500 MB free space on hard disk

High-color resolution 1024x768

Recommended:

Intel 2GHz+

2GB RAM

500 MB free space on hard disk

High-color resolution 1280x960

Software Requirements

MacOS X 10.5 or later

Java Runtime Environment 1.5.x or 1.6.x
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XSLfast Installation

XSLfast can be installed on Windows, Java, and Linux platforms. This section explains how to

install on different platforms.

Installation on Windows

After you download or purchase XSLfast, you will receive an .exe file. This is an executable file
for the Windows platform.

Note: It is also possible to purchase an XSLfast Windows version, which includes JVM (Java
Virtual Machine) if you have not already installed it. JVM is necessary for the use of XSLfast on

your system.

Follow the steps below, to install XSLfast on windows:

1. Double-click on XSLfast .exe file. The Open File window appears.

Open File - Security Warning

The publisher could not be verified. Are you sure you want to
fun this software?

Mame: xslfast-4[1].0-JRE-1.6.0-2009,08.20-setup.exe
ﬁ Publisher: Unknown Publisher

Type: Application

From: 10.0.0.81

[ Bun ]L Cancel |

Always ask before opening this file

publisher. You should only run software from publishers you trust.

@ This file does not have a valid digital signature that verifies its
How can | decide what software to run?
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2. Click “Run” button. The Select Setup Language window appears.

Select Setup Language
,E‘E! Select the languaae to use during the installation:

—

feraish R4

[ 0K ][ Cancel ]

3. Select the language from the drop-down and click “OK” button. The Setup wizard

appears.

12 Setup - XSLfast 4.0 =13

Welcome to the XSLfast 4.0 Setup
Wizard
This will install XSLfast 4.0 on your computer.

It is recommended that you close all other applications before
continuing.

Click Next ta continue, or Cancel to exit Setup.

uexw I[ Cancel

4. Click “Next” button to continue, else click “Cancel”.

5. Select | accept the agreement option to agree the License Agreement.
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5! Setup - XSLfast 4.0

License Agreement H
Please read the following important information before continuing. @

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

2

XSLfast® SOFTWARE End User
License Agreement

IMPORTANT: This software End User Licence Agreement
("EULA" 15 a legal agreement between you and jCatalog
Software AG. Read it carefully before completing the installation
process and using the software. It provides a license to use the ¥/

l@l accept the agreemenEl

(| do not accept the agreement

[ < Back ]uexb ] [ Cancel

6. Click “Next” button.

7. Click “Browse” button to select the path, where you need to install XSLfast.

Note: By default, XSLfast is installed in the Program files directory (C:\Program
Files\XSLfast\XSLfast 4.0).
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i Setup - XSLfast 4.0

Select Destination Location ‘
Where should XSLfast 4.0 be installed? @

,/] Setup will install XSLfast 4.0 into the following folder.

To continue, click Next. If you would like to select a different folder, click Browse.

I:Z:"-,Pn:-qr-am Filesh<SLfast'<SLiast 4.0 ’ [ Browse... ]

At least 51.3 ME of free disk space is required.

[ < Back ]uexb ] [ Cancel ]

8. Click “Next” button.

Note: If the folder already exist, where you install XSLfast. The Folder Exist window

appears.

Folder Exists p

c:) The folder:
-
C:\Program Files\XSLFast\XSLFast 4.0

already exists, Would you like to install to that folder anyway?

b ves ][ mo

Click “Yes” to install in the same folder. If you click “No” the Folder Exists window closes.

You are still on the screen where you should enter the correct path for the installation.
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9. Click “Next”. The next screen will offer you a choice of XSLfast components to be

installed.

5! Setup - XSLfast 4.0

Select Components
Which components should be installed?

Select the components you want to install; clear the components you do not want to
install. Click Next when you are ready to continue.

< Back I Nexst > I Cancel |

XSLfast offers three installation options:

¢ Full installation - Installs the system files, documentation, and the examples

¢ Custom installation - Offers to skip the documentation and/or the example files.

e Minimal installation - Installs only the system files.

Note: If you choose the second or third option and you already have the documentation and
example files on your machine from an earlier installation, you will see a message window

informing you that XSLfast has detected files on your system:
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Components Exist E l

@ Setup has detected that the following components are already installed on your computer:

Documentation
Examples

Deselecting these components will not uninstall them.

Would vou like to continue anyway?

e I w ]

The existing files are not deleted during the installation. You can see the total disk space

required for the chosen components above the “Back” button.

10. If you confirm with “Next”, the next screen appears.

5! Setup - XSLfast 4.0

Select Start Menu Folder
Where should Setup place the program's shortcuts?

Setup will create the program's shortcuts in the following Start Menu folder.

To continue, click Next. If you would like to select a different folder, click Browse.

’ [ Browse... ]

[ < Back ]uexb ] [ Cancel ]

11. Choose the start menu folder that you want to add the shortcut and click “Next”
button.
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5! Setup - XSLfast 4.0

Select Additional Tasks
Which additional tasks should be performed?

then click MNest.

Additional icons:
Create a desktop icon
Create a Quick Launch icors

Select the additional tasks you would like Setup to perform while installing XSLfast 4.0,

[ < Back ]t_ﬂexb ] [ Cancel

If you activate the check box Create a desktop icon, an icon with a shortcut to XSLfast appears

on your desktop.

The check box Create a Quick Launch icon creates an entry in the Windows Start menu.

12. Confirm your settings with the button “Next”. The next screen shows you an overview

of the installation information.
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5 Setup - XSLfast 4.0

Ready to Install
Setup is now ready to begin installing XSLfast 4.0 on your computer. @ /
\

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location: Radl
C:\Program Files\XSLfast\¥5Lfast 4.0 =

|

Setup type: |
Full Installation = ‘
[

Selected components:
Main Files
Documentation
Examples
Java Runtime Environment

Start Menu folder:

€3

[ < Back H‘ Install I [ Cancel ]

13. Click “Install” button, to start installation.
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5 Setup - XSLfast 4.0

Installing
Please wait while Setup installs XSLfast 4.0 on your computer. @ /
\ o

Extracting files...
C:A\Program Filesh<SLfast\XSLfast 4. 0hdocshuslast. pdf

(T[] ]

Now you see the files, which are currently installed, and the status bar, which shows the
progress of the installation. It is still possible to abort the installation with the button

“Cancel”.

14. When the installation is finished, the last screen opens:
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{5 Setup - XSLfast 4.0

Completing the XSLfast 4.0 Setup
Wizard

Setup has finished installing XSLfast 4.0 on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

15. Click “Finish” button to finish the installation routine.

XSLfast is now installed and ready to run. Start it with a double click on the icon on your

desktop if you had it created or use the link in the Windows start menu:

¥

S

LFast 4,0

i Documentation v [?2 %SLFast 4,0 User Guide (CHM)
v '@5‘ Uninstall XSLFast 4.0 .’gj %SLFast 4.0 Licensing Information
¢ XSLfast 4.0 [Z] xSLfast 4.0 Release Notes
&) wsLfast 4.0 Online @] xsLfast 4.0 User Guide (HTML)
=) ¥SLfast 4.0 User Guide (PDF)
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Installation on JAVA

After you purchase XSLfast, you will receive a file with the extension *.jar. This is an

executable file, which runs platform independently.
Follow the steps below, to install XSLfast on Java:
1. Double-click on *.jar file. The Open File window appears.

2. Click “Run” button, to start installation. The Language selection window appears.

B Language selection P |

Please select your language
for install instructions:

English el

Ok

3. Select the language from the drop-down and click “Ok” button. The License

agreement window appears.
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Iz|{IzPack - Installation of XSLfast

Please read the following license agreement carefully:

XSLfast® SOFTWARE End User License
Agreement

IMPORTANT: This software End User Licence Agreement ("EULA") is a legal
agreement between you and jCatalog Software AG. Read it carefully before
completing the installation process and using the software. It provides a license to
use the software and contains warranty infortnation and liability disclaitners. By
installing and using the software, you are confirming your acceptance of this
software and agreeing to become bound by the terms of this agreement. If you do
not agree to be bound by these terms, then select the “Cancel” button, do not install o=

ade 2, d A a1 o, A 1 F 1, £z, L1 B

I accept the terms of this license agreement.

@Yes O No

(Made with IzPack - http:/www.izforge.com/)

> Next || E qut

4. Click “Yes” radio button, to accept the license and click “Next” button.

Note: Click “Quit” button to quit installation. The “Quit” button prompts a warning

window.

Are you sure you want to quit 2
This will cancel the installation !

ves || No

Please read the agreement carefully. Click “Yes” if you agree and proceed with the

installation. Click “No” to abort the installation and close the window.

5. Click “Browse” button to select the path, where you need to install XSLfast.
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Note: By default, XSLfast is installed in the Program files directory (C:\Program

Files\XSLfast).

Iz|{IzPack - Installation of XSLfast

£t Select the installation path :

|C:1Program Files{SLfast | | = Browse ...

(Made with IzPack - http:/www.izforge.com/)
4l Previous H 1) Next || Quit

6. Click “Next” button. The directory will be created in the specified path and a

confirmation window appears.

The target directory will be created :
C:'Program Files'XSLfast

OK

If the directory already exists, a Warning window appears.
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YWarning !

£

The directory already exists ! Are you sure you want to install here and possibly overwrite existing files?

[es | [ o |

Click “Yes” to overwrite the existing directory. The next window appears. Else, click “No” to

enter another path.

7. Select the Components from the list.

Iz|IzPack - Installation of XSLfast ..I g[;cj
2= Select the packs you want to install :
@ Note: greyed packs are required.
XSLfast 38,24 MB
[v] Documentation 20,48 MB
[Vl Samples 90,67 MB
Description
Total space Required: 150 MB
(Made with IzPack - http:/www.izforge.com/)
4l Previous I | 1) Next I | Quit I

You can see the total disk space required for the chosen components above the “Quit” button.

8. Click “Next” button to navigate to next window.
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Iz|{IzPack - Installation of XSLfast R ;Jg.lﬁ]

Select a Program Group for the Shortcuts:

ABBYY Lingvo 12
Accessories crg?te shoﬂcyt for:
Administrative Tools @ ?“}'sﬁ?f,s, |

Altova XMLSpy 2007 Enterprise Edition
Antenna XSL Formatter V3

O S Py

[SLiast | | Reset

) current user

[v] Create shortcut on the desktop

[ Create Shortcuts

(Made with IzPack - http:/www.izforge.com/)

4l Previous ‘ { b Next ‘ | Quit

In this screen the button “Next” is inactive, because now you need to create the shortcuts in
your menu. Check Create shortcut on the desktop, an icon with a shortcut is created on your
desktop. Check all users to create shortcuts for all user, who has access to your system, or
check current user to create shortcut only to you. Choose the start menu folder that you want
to add the shortcut to. If you do not want to use the default settings, enter a new name for
your directory. The button “Reset” sets the name back to XSLfast. Now click the button
“Create shortcuts”. This operation may take some time. After it is finished, the button “Next”

is active again.

9. Click “Next” button to start installation.
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Iz|1zPack - Installation of XSLfast

@ Installation progress :
C:\Program Files\XSLfast_new\iblJimiProClasses.zip

(Made with IzPack - http:/www.izforge.com/)

H quit

Now you see the files, which are currently installed, and the status bar, which shows the
progress of the installation. It is still possible to abort the installation with the button “Quit”.

After the installation is finished, the status bar also says “Finished”. Confirm the installation

with the button “Quit”.

Iz|1zPack - Installation of XSLfast i (of

@ Installation progress :

(Made with IzPack - http:/www.izforge.com/)

=

B quit
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XSLfast is now installed and ready to run. Start it with a double click on the icon on your

desktop if you had had it created or use the link in the Windows start menu.
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Installation on Linux

To install XSLfast on a Linux system, you need an RPM file:
XSLfast-4.0.i386.rpm

Use linuxconf or YaST to install this package. For YaST, you need to start YaST2 from
KDE/Gnome shortcut (type your root password if prompted), add the installation path to the
XSLfast files being stored, choose software/installation/custom packages from menu and just

specify the RPM files mentioned above.

If no graphical administration is available, or if you prefer installing manually, login as a user
that has administrator rights, usually “root”, open a command window and change to the
directory where you saved the XSLfast files. Now enter the following command lines to start
the installation:

. rpm -1 XSLfast-5.0.1i386.rpm
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XSLfast Un-Installation

This section explains how to un-install XSLfast on different platforms like:

¢  Windows
e Java
e Linux

Un-Install on Windows

To un-install XSLfast on windows, follow the below steps:

1. Click Un-install XSLfast 4.0 from the menu option.

& xSiFast 4.0

l@ Documentation

iy Uninstall X5LFast 4.0
"¢ XSLfast 4.0
@] xsLfast 4.0 Online

2. Click “Yes” button to un-install XSLfast.

XSl fast 4.0 Uninstall

\ ? ) Are you sure you want to completely remove XSLFast 4.0 and all of its components?

The Un-installation of XSLfast begins.
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XSl fast 4.0 Uninstall

Uninstall Status
Flease wait while XSLfast 4.0 is removed from your computer.

Uninstalling XSLfast 4.0...

(TIITIIT

Cancel

3. Once XSLfast is completely un-installed a message window appears. Click “OK” button.

XSl fast 4.0 Uninstall
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Un-Install on Java

To un-install XSLfast on java, follow the below steps:

1. Click Un-install XSLfast from the menu option. The Uninstaller window appears.

8 5% Lisensing Information
@ Release Notes
E] Uninstall X5LFast
%5LFast Online
B xSLfast User Guide (HTML)
[3] xsLfast User Guide
Y ¥Sifast

B5 Sifastlavaversion

2. Click “Uninstall” button to start un-installation, else click “Quit”.

Iz{1zPack - Uninstaller = |D| x|

@ This will remove the installed application(s) |

[Z] Force the deletion of C:\Program FilesixSLFast

| [Mothing] |

Uninstall Quit
: :

Note: If you need to remove the folder, which was created during the installation, check Force

the deletion of ... checkbox to remove XSLfast completely from your system.
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Un-Install on Linux

To uninstall XSLfast via the administration user interface start Linuxconf/YaST, select the

XSLfast package named 'XSLfast' and remove it from the system.
To do the same via the xcommand line interface, just type the following command:

rpm -e XSLfast.

Refer Frequently Asked Questions, if any error occurs.
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Upgrade

This section explains how to upgrade XSLfast.

Upgrade XSLfast Linux Version

Make sure that XSLfast is already installed. Look for installed software through Linuxconf/YaST,
or type the command

. rpm —-ga | grep XSLfast

If there are no lines produced by this command, XSLfast is not installed on your computer, so

refer to the Installation on Linux section.

To upgrade XSLfast via the command line interface, use the following command:
. rpm -U XSLfast.

Refer Frequently Asked Questions if any error occurs.

Note: You can only upgrade XSLfast with a later version. If XSLfast is already installed, you

cannot upgrade it with the same version you are currently using.
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Installed File Structure

XSLfast installs the following directory structure on your system, all contained in the directory

XSLfast (or depending on the name that you gave the directory during the installation):
e backup - Stores backup files, which can occur during working with XSLfast.
e bin - Contains the startup files.
e docs - Contains the help files and the documentation.

e fonts - This directory will take the font information, when you generate the font

metrics.

e input - Contains the tutorial directory with some examples for layouts and you can save

your own layouts and image directories.
e [ib - Contains system data of XSLfast.
e log - If any errors occur, they are logged here and can be reviewed.

e output - XSLfast saves your output files in this directory by default unless you enter

another path.
e tmp - This is the directory, where files are temporarily stored during the generation.

e Uninstaller - This is the uninstalling mechanism, which you use if you want to remove
XSLfast from your system. You access this directory with the command Uninstall

XSLfast in the Windows start menu.
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Installation of Renderers

This section explains the process of installing renderers.

Installing Other Renderers

FOP and Raster Images Quality

Install JAI from java.sun.com to achieve a better quality of images as the FOP manual
describes. We recommend installing JAI to your JDK/JRE directory. Our version contains no JAI,

because JAl is platform specific.

XSLfast supports RenderX XEP software and Antenna House XSL Formatter. If you want to install

e.g. XEP you need to take the following steps:

1. Download XEP from www.renderx.com; if you already did this, simply move to step 2 or

3.

2. Install XEP to any directory you prefer; in all cases XSLfast will not use this folder in
future. XSLfast just needs an unpacked copy of XEP to get particular files to the XSLfast

directory.

3. Copy these files to the following layout (target directory is {XSLfast}/lib/XEP):
{XEP}/lib/xt.jar to {XSLfast}/lib/XEP/lib/xt.jar
{XEP}/lib/xep.jar to {XSLfast}/lib/XEP/xep32_trial.jar

All other files from {XEP}/lib/ are unnecessary because XSLfast already contains them. You can

also copy these files into your current XSLfast folder but it is not required.
o {XEP}/license.xml to {XSLfast}/lib/XEP/license.xml

o {XEP}/xep.xml to {XSLfast}/lib/XEP/xep.xml

509 |Page


http://www.renderx.com/

{XEP}/fonts/*. to {XSLfast}/lib/XEP/fonts/
{XEP}/hyphen/*.* to {XSLfast}/lib/XEP/hyphen/
{XEP}/images/*.* to {XSLfast}/lib/XEP/images/

Launch XSLfast and set the FO Processor to XEP in the Layout Settings (under Layout >

Layout settings). Open the Layout, which you want to execute to see the changes.
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FAQs

Q: | see a "package already installed" error message.
A: Upgrade XSLfast rather than installing it.
A:  Try removing the existing version before the new installation if needed.
| see the message ‘XSLfast-4.0.i386.rpm is not installed’, when | try to remove the
& package.
A: Use 'XSLfast' rather than ‘XSLfast-4.0.i386.rpm’ for removal.
Q: | tried typing rpm -i XSLfast', but got the message ‘package not found'
A:  Use fully qualified file names for install/update commands.
Q: | got the message "package XXX is required by XSLfast" during the manual installation.
A: Install package XXX first, or use Linuxconf/YaST to solve dependencies automatically.
Q: Which programs do XSLfast requires?
A:  XSLfast requires Sun JRE / JDK 1.6.x. Sun JRE 1.6.x is recommended.
Q: May | use IBM JDK rather Sun JDK?
A:  Yes, but only at your own risk. XSLfast is only tested with Sun JDK.
Q: Can XSLfast be used for several users at the same host?
A:  Yes.

Note: Every user will need its own license.
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Q: Is XSLfast available remotely via X117

A:  Yes.

Q: XSLfast works with only a few fonts. How should | solve this?

A: Install more fonts both for screen and for printer.

Q: I've installed windows TTF files; XSLfast cannot insert it into PDF.

A: Don't forget to install these fonts for Ghostscript, not for X11 only.

Q: XSLfast told me it couldn’t connect to the display.

A: XSLfast is a graphical program so it works only with X11.

Q: I've got the message “access denied” while connecting to the remote display.

A: Configure your permissions for display using xpath.

Note: Except for the points listed below the Linux version of XSLfast shows the same behavior

as the Windows or Java version.

The first point concerning XSLfast differences is related to fonts.

Linux operates with the following types of fonts directly:

Raster fonts

TTF/OpenType fonts

Type1 fonts.

Windows has no direct support for Type1 fonts (you need a 3rd party solution for that), so

XSLfast under Windows works with TTF/OpenType fonts only. Under Linux the Type1 fonts are

most preferable so XSLfast provides limited support of Type1 fonts as well as TTF fonts.
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Yet another point concerning Linux is also related to fonts. Windows uses exactly the same
fonts for printing and for screen; Linux does not. So XSLfast operates with fonts available both

for screen and for printing (by default, the font list is small due to licensing limitations).

Of course, the different file names (/' path separator rather than '\', case sensitive file names,
common mount point, etc) are supported differently, but this point is important only if you will

be moving layout files with related components from Windows to Linux.

Linux is really a multi-user system rather than Windows, and XSLfast provides the ability to
have multiple users with one host. All your data, including layout files, samples, and

registration information, is collected at your home directory with your usual access rights
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